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General

General

The Schaeffler SmartWeb software offers you a user interface with which you can manage the Schaeffler
SmartCheck or ProLink device. For example, you can configure inputs and outputs, use a wizard to create
measurement jobs for monitoring your machine, or verify the functions of the SmartCheck or ProLink device. To be
able to use the SmartWeb software, the device must be connected to a computer.

About the vibration monitoring systems

SmartCheck and ProLink are vibration monitoring systems for permanent frequency-selective monitoring. They offer
you the following functionality:

The Schaeffler SmartCheck system can capture, record and analyse measurement values using two integrated
signals and up to three connected signals. After the analysis, the system can switch outputs and display the status
using LEDs depending on user-defined alarm limits. Inputs are available, which record additional signals, to allow the
device to be integrated into a superordinate system. These signals can be used as command variables for a
dependent signal analysis, e.g. to initiate time or event-controlled measurement jobs.

The Schaeffler ProLink system consists of a processor module and at least one vibration module. The system can
be extended to a maximum of 4 vibration modules. Up to 4 analogue and 2 digital signals can be connected per
vibration module and measured values can be logged, recorded and analysed. After the analysis, the system can
switch up to 4 digital outputs per vibration module depending on user-defined alarm limits, and report the state to
an external control system, for example. In addition, up to eight analogue or digital inputs or outputs can be
created completely flexibly per connected I/O module.

The Schaeffler vibration monitoring system can be used to cover a wide range of applications; the system can be
configured to meet your own requirements using the integrated SmartWeb web application. You can combine
multiple SmartCheck or ProLink devices in a network. All devices are administered centrally on a PC via the
SmartUtility Light software. With the full version of SmartUtility, you can also open the devices directly in the
SmartWeb software, analyse measurement data in the SmartUtility Viewer and download configurations and install
them on other devices.

With the SmartCheck and ProLink system, Schaeffler offers status monitoring that is optimised to suit your
requirements.
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1.1 About this guide

This guide describes how to use the Schaeffler SmartWeb software. Read this guide carefully before using the
software, and store it in a safe place.

Make sure that

e This guide is available to all users

¢ If the product is passed on to other users, that this guide is also passed on with it.

e Additions and amendments provided by the manufacturer are always attached to this guide.

System-specific instructions and illustrations

g You can use the software described here with both the Schaeffler SmartCheck system and
the Schaeffler ProLink system. The usage is largely the same for both systems. The text in
this manual always highlights any differences.

Ilustrations provide examples to clarify the information and instructions contained in the text.
For instances where there is hardly any difference between the systems, we have omitted
the illustration of the other system to improve readability and clarity.

Further information

This software is an integral part of the Schaeffler SmartCheck or ProLink vibration monitoring system. These systems
also include the Schaeffler SmartUtility Light software. The individual systems and the SmartUtility Light software are

described in a separate manual.

Optionally, instead of the Schaeffler SmartUtility Light software, you can purchase the Schaeffler SmartUtility
software with enhanced functionality. This is also described in a separate manual.

Definitions
e Product: the Schaeffler SmartWeb software described in this manual.
e User: person or organisation capable of putting the product into operation and using it.

Symbols used

This symbol indicates
2 ¢ Helpful additional information and
e device settings or practical tips that will help you to perform activities more efficiently.

CAUTION The damage that can occur is described here

@ Actions to prevent the damage are explained here.

Cross-reference symboll 6™: This symbol refers to a page in the manual that provides further information. If you are
reading the manual in PDF format on a screen, clicking the word to the left of the cross-reference symbol will take
you straight to the section in question.



Starting the software

Starting the software

Perform a firmware update before commissioning. You can download the latest version via
g the SmartUtility software or from the microsite for the following systems:

¢ SmartCheck: www.schaeffler.de/condition-
monitoring/smartcheckwww .schaeffler.de/en/condition-monitoring/smartcheck

e ProlLink: www.schaeffler.de/condition-monitoring/prolinkwww .schaeffler.de/en/condition-
monitoring/prolink

Only start the SmartWeb software after ensuring the following:

e The system is connected to the Ethernet network or to your computer via the Ethernet cable.
e The system is supplied with power.

¢ The system has finished loading and starting and is in measuring mode.

Details on how to connect and start your Schaeffler SmartCheck or ProLink device can be found in the user
documentation for the relevant vibration monitoring system.

The Schaeffler SmartWeb software can be started in two different ways:
e Start with IP address in the browser

The Schaeffler SmartCheck or ProLink device is delivered with the default IP address 192.168.1.100. Enter this IP
address in the address field of your browser:

192.168.1.100 -

Press the Enter key to start the SmartWeb software.

e Start-up via the Schaeffler SmartUtility Light or Schaeffler SmartUtility software

With this software, you can search for and open Schaeffler SmartCheck or ProLink devices with the help of a wizard.
In doing so, the SmartWeb software opens in a separate tab of your browser for each device. For more details,
refer to the manual for the software SmartUtility Light or SmartUtility.

This option also requires the system to be connected to the Ethermnet network or to your computer via the
Ethernet cable and supplied with power.

¢ If you cannot adapt the IP address field on your computer to the default IP address of
g the Schaeffler SmartCheck or ProLink device, you will need to change the IP address of
the Schaeffler SmartCheck or ProLink device. This is possible both with the Schaeffler
SmartUtility Light software included in the scope of delivery and with the optional
Schaeffler SmartUtility software. Details on this can be found in the respective user
documentation.

e If you are using a proxy server between the browser and the internet in your company
network, you will need to adjust your browser's internet settings accordingly. To do so,
go to Internet Explorer and enter the address and port number of the proxy server under
Tools > Internet options. Please contact your system administrator for more detailed
information about proxy settings.

e Once the SmartWeb software is started, the system time of the Schaeffler SmartCheck or
ProLink device is compared with the computer time. The system time can be adjusted[ish
if required.

e The SmartWeb software checks on a regular basis whether SmartUtility or SmartUtility
Light has new configurations. If so, the page is reloaded.

o If a Schaeffler SmartCheck or ProLink device cannot be opened in the browser, clear the
browser cache and try again.

¢ If you receive the message stating that cookies are not accepted, please allow the use of
cookies or enter the IP address of the Schaeffler SmartCheck or ProLink device as an
exception.

e If you are working on a computer with several Schaeffler SmartCheck or ProLink devices,

these devices should have identical firmware versions installed. If different firmware
versions are installed, this can have undesired effects within the browser.


http://www.schaeffler.de/condition-monitoring/smartcheckwww.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/condition-monitoring/smartcheckwww.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/condition-monitoring/prolinkwww.schaeffler.de/en/condition-monitoring/prolink
http://www.schaeffler.de/condition-monitoring/prolinkwww.schaeffler.de/en/condition-monitoring/prolink

3 The userinterface at a glance

¢ If the browser window is closed by mistake or the connection to the Schaeffler
!ﬂ SmartCheck or ProLink device is interrupted, any settings that you have not yet confirmed
with OK will be lost. Consequently, always check whether the last change you made via
the user interface of the software has actually been adopted.
¢ If you do not make any changes for more than an hour in the SmartWeb software, you
are automatically logged out. You can edit the automatic log-off time[ o™.

The user interface of the Schaeffler SmartWeb software can be divided as follows:

Title bar

Menu bar

ltems of the
selected area

Detailed information and editing functions
for the selected items

Actions

Areas

Status bar

The user interface offers you these options:

Title bar
The following information can be found in the right-hand corner or the title bar:
Connected to: Here you will find the name of the SmartCheck or ProLink device.
Logged in as: Here you will find the user name under which you are currently logged in.

C.: (SmartCheck only): This symbol indicates which status the "Machine is running" measurement
condition has identified for the machine. Under Measurement conditions[:02), you can set the criteria
for the "Machine is running" measurement condition for your machine. Depending on the status
determined, the following symbol is displayed:

= C-:: the "Machine is running" measurement condition is fulfiled: the machine is in operation.
. @: the "Machine is running" measurement condition is not fulffiled: the machine is not in operation.

Q.

=" : If this symbol is visible, at least one characteristic value is in learning mode.



The user interface at a glance

M The square symbol shows you the alarm status of the SmartCheck or ProLink device; the symbol is
displayed in different colours according to the status:

» Grey: No characteristic value has yet been measured.

= Green: No alarm exists.

» Yellow: One or several characteristic values have triggered a pre-alarm.

*= Red: One or several characteristic values have triggered a main alarm.

* Alternating between grey and green: Learning mode is active for one of your measurement

jobs.

If a pre-alarm or main alarm is triggered during learning, the alarm symbol indicates the respective
alarm status without flashing, i.e. it lights up continuously yellow or red.

Menu bar

The following options can be found in the menus:

File

Edit

¢ Print page: This command prints the current view of the SmartWeb software.

Ensure that you have selected the option for page setup in your browser such
that the page is reduced to fit the page size when printing.

Find the corresponding option e.g. in Mozilla Firefox (Shrink to fit Page Width)
and also in Windows Internet Explorer (Enable Shrink-to-Fit) under File >
Page Setup.

Save device configuration/Upload device configuration: These options
allow you to save the entire device configuration (except for the network
settings), including all device settings and measurement configurations, or to
upload a saved device configuration back to a device. This is useful, for example,
when replacing a defective device[ 7. The number of modules in the old and
new device must match.

Uploading the device configuration to a new SmartCheck
2 or ProLink device will cause the network settings and all

existing measurement data to be lost.

Back up the measurement datal 511 before uploading the

device configuration. After uploading, you must adjust

the network settings[sA,

¢ Log out: Use this command to log out of the SmartCheck or ProLink device.

The connection to the device is closed.

The functions available in the Edit menu depend on your user rights. Under certain
circumstances, some functions are deactivated because you do not have the
authorisations for them.

« Change password: This command opens the corresponding areali6d) in the

SmartWeb software. You can then change your password or the password of
the logged-in user.

User management: With each of the commands in this submenu, the
corresponding areal1s3 in the SmartWeb software opens. You can then make
your changes.

Device settings: With each of the commands in this sub-menu, the
corresponding areal1sh in the SmartWeb software opens. You can then make
your changes.

You can also specify the following:

= Edit security settings: You can enter a password for data encryption here.
This password is required when an encrypted device configuration is
uploaded[ 17 to an SmartCheck or ProLink device or when the measurement
data downloaded[s1\ with the SmartWeb software is to be opened in
SmartUtility.

= Edit automatic log-off time: Here you can define that the current user is
automatically logged off in the SmartWeb software after a certain period of
inactivity. The automatic log-off function is activated by default and is set to
one hour. You can only configure the log-off function if the "Edit system
settings" user right is activated.
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Measurement
data

Go to

Help

¢ No other user can access the software as long as you are
E# logged into the SmartWeb software.

e There is a potential security risk if you deactivate the log-
off function or set the time frame for logging out as too
long, because unauthorised third parties could access the
SmartWeb software.

¢ Create new measurement job: This command starts a wizard that guides you
through creating a new measurement job[7s".

o Edit program settings: Here you can specify the following:

» Units: Determine the system of units that the SmartWeb software should
use. Among other things, this setting affects the dialogues in which you must
select a unit.

- With ISO, international units are displayed, e.g. mm/s.

- With US, American units are displayed, e.g. mil/s.

- With All, both international and American units are displayed, e.g. mm/s and
mil/s.

* Language: When possible, the SmartWeb software is automatically launched
in the language that you have set for your browser. Here you can manually
set the language in which the interface of the SmartWeb software is to be
displayed.

¢ Open measurement data display: Use this command to go to the
Measurement datal " area.

¢ Download measurement data: Use this command to open a dialogue in which
you can select measurement data for download[s".

¢ Delete measurement data: Use this command to open a dialogue in which you
can select measurement data for deletion[ sz,

With the commands in this menu, you can switch to those areas that you can also
control via the buttons under Areas, i.e. to Status[se", Measurement datal 4", Live
view [ s, Configuration[s™ and User Management [163).

e Open Help: Use this command to open a link to the website of the SmartCheck
or ProLink device. You can open the SmartWebHelp from there under
Downloads.

« Update firmware[13": Use this command to open a dialogue in which you can
update the firmware.

« Select device restart[ 142 Use this command to open a dialogue in which you
can reset or restart the device. Using this dialogue you can also open the
Maintenance System of the device or reset the data partition.

« Install Schaeffler Cloud Onboarding[16": this command opens a dialogue box
that allows you to connect the device to Schaeffler Cloud services.

¢ View Open Source Licences- this command opens a window with detailed
information about the third-party libraries used by the SmartCheck or ProLink
software.

 Open licence manager| 15 Use this command to open the licence manager
window. In this window, you can view your existing licences or licence group
names and add licences or licence groups. You will not be able to use or see
functions in the SmartWeb software for which you do not have a licence.

¢ Version information: Use this command to open a window with detailed
information about the version of the SmartCheck or ProLink device, including
factory firmware, device ID and serial number. You can copy the information to
the clipboard using the Copy as text button and paste it into a word processor
or email..
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The settings for units, language, and messages are stored as cookies. When you delete

= cookies, these settings are also deleted in the SmartWeb software. Next time the
SmartWeb software starts, it will be using the pre-set units and the language set for your
browser again. Automatic messages are displayed again by default.

The language setting is also influenced by the Schaeffler SmartUtility Light or Schaeffler
SmartUtility software: If you open the SmartWeb software via the SmartUtility Light or
SmartUtility software, the language setting of the software is used.

Areas

These buttons take you to the different areas of the SmartWeb software. You can also log out of the
SmartCheck or ProLink device here:

& Status:[ 201 Detailed information on the system and on the status of the measurement jobs
and their characteristic values can be found here. You can see at a glance which
measurement jobs are active or scheduled and which characteristic values have triggered an
alarm. You can also track the activity of the SmartCheck or ProLink device using the entries
in the logbook.

Measurement data:[ 2" The measurement data for specific characteristic values can be
displayed in this area. The display includes trends, time signals and spectral data.

Live view:[ s\ The signals of the configured inputs can be displayed here in real time.

¥ R

@ Configuration:[s" This area is particularly significant when setting up a new SmartCheck or
ProLink device: This is where you create measurement jobs, configure inputs and outputs,
make basic device settings, and edit the databases for bearings and bearing manufacturers.
You will also find details about the modules of the ProLink system.

L User management:[1s3) Here you can create, delete and manage users and user groups, as
well as change your password or the password of the user currently logged in. In addition,
you will find in this area the functions for activating and deactivating user management.

'LI.} Log out: Click on this button to log out of the SmartCheck or ProLink device and close the
SmartWeb software.

Actions

Here you will find the selected important actions, which are either possible in the current area or lead to
another area as a link. For example, if you have opened the Measurement data area, you will find the
following commands here: Show measurement jobs, Download measurement data and Delete
measurement data.

Items of the selected area

What you see here depends on the current area. For example, if you have opened the Configuration
area, you can select individual configuration items - such as Measurement Jobs or Measurement
Conditions - here and then view information about them in the main panel of the SmartWeb software
and make further edits.

Detailed information and editing functions for the selected items

If you have selected an item on the left, you will see detailed information on it in the main panel of the
SmartWeb software and can make further edits. What exactly is possible depends on your particular
selection.

Status bar
The status bar informs you e.g. whether your browser has already finished loading the selected new area.

11



12

You can use the separator between the overview columns on the left and the main panel
on the right to adapt the interface of the SmartWeb software to suit your requirements:

e Holding down the left mouse button, drag the separator to the left or the right to alter
the size of the respective surface.

¢ Click on the separator to hide the overview columns on the left. This enlarges the main
panel to fill the full screen width. Click again on the separator to restore the view.

At many points in the interface, items are displayed in a tree structure. To see subordinate
items, click on +; to hide them again, click on —.

In some areas of the SmartWeb software, the information is presented in tables. You can
structure tables using the following functions:

¢ Columns as sort criteria: Set any column of a table as a sort criterion by clicking in the
column title. Click a second time to change the sort order, i.e. from ascending to
descending or vice-versa. The current sort order is displayed by the symbols & for
ascending and = for descending.

¢ Move columns: Move any column to another position in the table. To do this, click with
the left mouse button in the column title and hold down the mouse button. Then drag
the cursor to the position in the table you want the column to appear in future.
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3.1 Update firmware

How to update the firmware
1. From the Help menu, select the Update firmware option in order to open the corresponding window:

Updating the firmware

Schaeffler SmartWeb

Warning!
WWhen updating the firmware, all measurement data saved on the device may be lest! Download the measurement
data if necessary before updating the firmware.

The update may fake a few minuies. During this time, the status LED will flash yellow and red aliernately. The
following is extremely important in this regard:

« The power supply to the device must not be disrupted.

= The Ethemnet connection to the device must not be interrupted

= The update must be fully completed.

If these requirements are not met, the device will no longer be fully functional

Firmware file : ~ Browse...

smartcheck-at31-SCHAEFFLER-1.16.0.20191203_142241-670129 512
Cancel

2. Click Browse to locate and select the firmware file.

3. Click OK to update the SmartCheck or ProLink device with the selected firmware. Click Cancel to close the
window without applying any changes.

e When the firmware is updated, all measurement data and configurations on the device
g may be lost. Before updating, save everything by downloading measurement data and, if
applicable, configurations with the SmartUtility software. The taught-in alarm limits are part
of the configuration and are downloaded at the same time.

e The update can take several minutes. The status LED on your SmartCheck or ProLink
device will flash yellow and red alternately during this time. The following is very important
in this process:

o The power supply to the SmartCheck or ProLink device must not be interrupted.

o The Ethernet connection to the SmartCheck or ProLink device must not be
interrupted.

o The update must be fully completed.
The device is no longer functional if these conditions are not met!

¢ If a serious error occurs during a firmware update, the device is reset to the factory
firmware. You can find the version of your factory firmware under Help > Version
information.

e After you have performed the firmware update, empty the browser cache. This is
necessary to ensure that the latest version of the Schaeffler SmartWeb software is loaded
in your browser.
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3.2 Select device restart

To select the device restart, proceed as follows
1. From the Help menu, select the Select device restart option to open the corresponding window:

Select device restart

Schaeffler SmartWeb

Select device restart :
Restart device A

Warning: When restarting, all
measurements are interrupted. However, the
firmware, configurafions and measurement
data are refained.

CK Cance

2. Select the required option from the list box:

Restart device This option restarts the SmartCheck or ProLink device:
e Current measurements are interrupted.
e Existing measurement data, configurations and the firmware are retained.

Start the device's You use this option to start the Maintenance System of the device. Here you will

Maintenance System find extensive maintenance functions, including for firmware update, device
configuration and system back-up. The Maintenance System also contains further
options for restarting the device.

FAG SmartChedk: -» Maintensnce System

Maintenance System

@ Update firmware % Reset data partition Reset firmware

:—:E Adjust system settings L& ﬁ:\;mload debuglag 3} Open expert menu
Iil Backup system |L Restore system ® Reboot system
Version: 1.0 20 (Build: 384380-201680815221038) Firmware 1.12.0 will start automaticslly in 958 minutes
When User management is activated[is4), a logon dialogue
g appears first. You can only log on to the Maintenance
System as an administrator and using the administrator
password.
Reset This option resets the data range:
o existing measurement data is lost.
data partition All t t dat lost

e Firmware and configurations, including taught-in alarm limits, are retained.
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Restore factory This option restores the SmartCheck or ProLink device to the factory default
default setting setting:

¢ All existing measurement data is lost.

All taught-in alarm limits are deleted.

¢ All configurations are lost.

e The firmware is reset to the factory default firmware.

To save measurement data, taught-in alarm limits and configurations, download the
measurement data and configurations with the SmartUtility software before you
restore the factory default setting. The taught-in alarm limits are part of the
configuration and are downloaded at the same time. After restoring the factory
settings, the Schaeffler SmartCheck or ProLink device can be reached at the IP
address defined by you. Click Cancel to close the window without applying any
changes.

3. Click OK to reset the SmartCheck or ProLink device with the selected option.

Ensure that the device is accessible and then install the latest firmware.

o

3.3 Add licences or licence groups

Some features of the SmartWeb software require additional licences or licence groups. You will receive an additional
licence or licence group by email and can be added via the licence manager. Open the licence manager in the
Help menu using the Open licence manager option:

Licence manager x

Licence name Valid from Valid until
Channel Monitoring

Email

OPC/UA

PROFINET

Add Close

You can find a list of licences that are installed on your SmartCheck or ProLink device here, including the following
information:

Licence name Here you can find the name of the licence. The name refers to the function that is
enabled by the licence.

Valid from/valid until This data indicates the period of time for which the licences are valid.

How to add licences or licence groups

1. From the Help menu, select the Open licence manager option to open the corresponding window:
Click on the Add button. The Add licences or licence groups window opens.

Open the TXT licence document that you received by email in a text editor.

Copy the content of the document to the clipboard.

Click in the text area of the Add licences or licence groups window and paste the document content from
the clipboard.

A message informing you about the valid licences and licence groups contained in the pasted document appears
below the text area:

u b~ W N
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Add licences or licence groups

Schaeffler SmartWeb

ou have received an licence document via email. Please open the document in a text editor and copy and paste the content of the file here :
=Sy LICENSEs>
=gyn:License>
=syn:Properties=
=syn:ld=A515FF31-B993-4510-A000-000000 000005 </syn:ld=
=syn:Mame=Channel Monitoring=</syn:Name=
<=syn:Scope>
=gyn:SerialMumber=F4:30:80:00:1C:9%=/syn-SerialMumber>
</synScopes
syn:ValidUntil=2020-12-31T00:00:00Z </syn-ValidUnfil=
<isyn:Properties>
=gyn:Key=LEFVPJOKNXUC6hmCwn fedCsiCgtWep/uwRIOTRIGwDeQnd 2l dMMEuXxmSY GjglGdreRY Wi dSFwV+i2 PR21drC pHZ kh 1 HZemg Lzuzn
tDGmV54n&g+gP+jAfKvQgrallg 0Qj2oMZ1j6 g Umzpw dglUkLJ2z AMIDIVP PriKmQLd Ay SbddX Go 4K2Cj8lj3g KFhZWiggsmU UknUIX O G+MZssATHp)
YIvGEMsXNiIdiGrZidkZ+Puw\VadpilPYIKDbHvxoBoCQLALThKssCRLWZJbr/8J 212 NdF 78 CzcOmS 0 GDbmiclsls abbkar2 aWkWaN Sh8G vk DxCo3nx WTX

GZC==</synKey>
</zyn:Licenses
=syn:License=
<syn:Properties>
Jd=A515FF31-B993-451D-A000-000000000007 <fsyn:ld=
‘Hame=Email</syn:Name=
“Scope=
n-SeralMumber=F4:30:80:00:1C:98=/syn-SeralNumber>
n:Scope>
MalidUntil=2020-12-31T00:00:00Z </syn:ValidUnfil=
yn:Properfies=

=gyn Key=0Mbp5Ct{5zJ5RadmVRo3BaX0aYm1s/D5F 0/8145Kc4 FOgI0IFCnAMbulK\WAONGK3 Tq421dkGSwRTD/8KpggbZRKPoedGpY JgFzHew2 +e
dNFVFLhjsqik3BKREMWC aTPRrTSQ0gF QO HWPwISsGEFEHKY QY +cNERapdMxOSqWDjuiwi TqgZd DRyHnbDav3iSaUeny297t+r1F GellkCOvww)
CrwSVoSRWVoRk2g3r3jNDeSHGIQFcA122IP3NIGpFvi3BbC 1 KICIFsNdGaysApelMUrotTFe3Ljws 5 SEGV OJZswlmbou 1HOT GCuZ GMVCD+

S5DuUZEMoGSDA==<fzynKey>
</zyn:License>
=syn:Licenses
<syn: Properties= -

=

0 valid licence greupis) and & valid licence(s) have been Add Close

found

6. Click on Add. The licence or licence group you added appears in the overview of the licence manager window.

How to delete licences
Select the corresponding licence in the licence manager, click on Delete© and confirm with OK. The Channel

monitor, OPCUA and Email licences cannot be deleted.

3.4 Connect Schaeffler Cloud services
If you want to connect the SmartCheck device or ProLink device to the Schaeffler Cloud services, you need a
configuration file. Further information on this can be found here.

This is how you create a connection to the Schaeffler Cloud services
1. From the Help menu, select the Install Schaeffler cloud onboarding option to open the appropriate
window:

Insfall Schaeffler cloud onbeoarding

“You need a configuration file fo use the Schaeffler Cloud. You can find further information on the Intemnet at
www schaeffler com

Q - Browse

Cancel

2. Click on Browse to locate and select the configuration file.
3. Click on OK to save the new input. Click on Cancel to close the window without applying any changes.

This step automatically creates the Communication channel for the Schaeffler Cloud 158 and makes all necessary
settings for data transmission. If necessary, you must adjust the proxy settingsl1sd.
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3.5 Replace a defective device

If you need to replace a defective SmartCheck or ProLink device, you can use the Save device configuration and

Upload device configuration features to quickly restore the device settings:

¢ Save device configuration saves all measurement configurations and all device settings for the device, except
the network settings.

¢ Use Upload device configuration to load these settings onto to a new device.

¢ Uploading the device configuration to a new SmartCheck or ProLink device will cause the
2 network settings and all existing measurement data to be lost.

Back up the measurement datals1") before uploading the device configuration. After
uploading, you may need to adjust the network settings|sa\.

e You can replace individual vibration modules or I/O modules, as well as the entire unit with
the processor module.
If you replace only an individual module, existing measurement jobs will be adjusted to use
the new module.
If you replace multiple modules of a single type, i.e. multiple vibration modules or mutltiple
I/0 modules, they are assigned to a configuration based on the alphabetical order of the
module serial numbers.

Proceed as follows:

1. In the SmartWeb software for the defective SmartCheck or ProLink device, open the File menu and select the
Save device configuration option. The Save device configuration dialogue opens:

Save device configuration

Download the device configuration and save it as an SC4 file.
The saving process depends on your browser seffings

File name : | 20230723_180745_f4_3d_50_10_01_18.sc4

CK Cance

Click OK to start the preset save process in your browser and save the device configuration.
If necessary, back up the measurement datalsi.

Remove the defective SmartCheck or ProLink device from your system.

Insert the new SmartCheck or ProLink device into your system.

In the SmartWeb software for the new SmartCheck or ProLink device, open the File menu and select the
Upload device configuration option. The Upload device configuration dialogue opens:

ou kA wN

Upload device configuration

Warning!
If you upload the device configuration, all measurement data stored on the device may be lostl Back up the
measurement data before uploading the device configuration.

Uploading takes a few minutes.
File : 20230717_151803_14_3d_s0_10_01_16.sc4 Browse ..

Password ;| s an
Show password
CK Cance

7. Click Browse and select the file with the extension .SC4 that you downloaded from the defective SmartCheck
or ProLink device.

You have the following options:
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Password You can specify the data encryption password here if the configuration file was
encrypted on the original device. Select Show password to make the
password visible while you enter it.

Do not configure the If the configuration file contains outputs for controllers, you can determine
outputs of the Mitsubishi here whether they are also configured. All devices to which you send these
controller outputs will write to the same registers of the controller. For this reason, the

option is enabled by default. The communication channel, i.e. the settings for
the controller, is always transmitted.

8. Click OKto transfer the saved device settings to the new SmartCheck or ProLink device.

9. If necessary, adjust the network settings/isa.

10.The new device is integrated into your network and all measurement jobs are adopted.



Maintenance system of the device

Maintenance system of the device

The maintenance system of the Schaeffler SmartCheck or ProLink device provides you with comprehensive
maintenance functions. You can use this system, for example, to update the firmware, configure the SmartCheck or
ProLink device, to back up a system, or to restore a system from back-up. You can also use the latter function to
duplicate devices. The Maintenance System also offers securely protected expert functions for updating the
Maintenance System or for deleting the entire system on a SmartCheck or ProLink device among other things.

The Maintenance System is only available in English. It is independent of the actual firmware on the device and can
also be accessed via the browser, for example, if a firmware update has not run correctly.

To open the Maintenance System of the SmartCheck or ProLink device, proceed as follows:
1. From the Help menu, select the Select device restart option to open the corresponding window:

Select device restart

Schaeffler SmartWeb

Select device restart :
Restart device -

Warning: When restarting, all
measuraments are interrupted. However, the
firmware, configurations and measurement
data are retained.

OK Cance

2. From the drop-down list, choose the option Start the device's Maintenance System.
3. Click on OK. The log-in page for the Maintenance System is displayed:

FAG SmartChedc -» Login Page

Maintenance System

Versicn: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 9:57 minutes.

4. Click on the Login' button to open the start page of the Maintenance System. Use the Expert Menu&
button to directly access the Expert menulao".

If user management is activated in the SmartCheck or ProLink firmware, a log-in dialogue appears in which you
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are required to log in as an administrator using the administrator password. If user management is deactivated,
the start page opens directly:

FAG SmartChed: -» Maintenance System

Maintenance System

@ Update firmware % Reset data parition Reset firmware

— . ] 5 Download debug log il
—
Adjust system settings Lo fles k Open expert menu
‘ Backup syster | Restore systerr @ Reboot syster
— b sy — ¥ ¥
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:58 minutes.

5. On the start page, click on an icon to select the relevant function. Depending on the function you choose, you
will then need to perform further steps or select sub-functions in a submenu. For information on the individual
functions of the Maintenance System, see the following sections.

¢ If the Maintenance System is started, the SmartCheck or ProLink device interrupts all
g measurements.

¢ If you have opened a function of the Maintenance System, the Homepageﬁbutton is
displayed at the top right. Click on this button to return to the start page of the
Maintenance System.

e The Maintenance System has a timer function: if you do not make any changes for a
certain period of time, the device is automatically restarted. The length of time depends
on where you are in the Maintenance System:

= Login page of the Maintenance System: restart after 2 minutes

= Start page of the Maintenance System and all function pages: restart after 10 minutes
= Login page of the expert menu Expert Menu: 60 minutes

The remaining time until the device restarts is always displayed at the bottom right.

4.1 Update firmware

Click on the button Update firmware @to start this function. You can update your system with a new firmware
version here. This does not delete the measurement data.
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Depending on the version of your firmware, you can also use this function to downgrade to
g a previous firmware version. In this case, the measurement data is also deleted.

The option to downgrade is available as follows:

e Up to the release of SmartCheck version 1.10.0 or ProLink version 1.18.0: Downgrading to
previous versions is possible

e From the release of SmartCheck version 1.10.0 or ProLink version 1.18.0: Downgrading is
possible only up to version 1.10.0 or 1.18.0

How to update the firmware

1. Click on the Select file v button and search for the SF2 file containing the required firmware.

2. Open the SF2 file. The system analyses the file and informs you whether the update is possible, and if yes,
which firmware will be installed:

FAG SmartChed: -» Update Firmware -» Select File

()
Update Firmware
Firmware file: i smartcheck-at91-FAG-1.12.2.20170502_164020-395886.512
I The selected file contains the firmware 1.12.2 (Build: 20170502_164020-395886). I
ATCR U IO LRI TN T OT Caltel 0 aoort
v X
“ersion: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:45 minutes.

If the selected file is not a valid firmware file, you will be informed of this too.

3. Click on the OK Jbutton to start the update.
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¢ When the firmware is updated, all measurement data and, in some cases, also the
g configurations on the device are lost. Before updating, save everything by downloading
measurement data and, if applicable, configurations with the SmartUtility software. The
taught-in alarm limits are part of the configuration and are downloaded at the same time.

e The update can take several minutes. The status LED on your SmartCheck or ProLink
device will flash yellow and red alternately during this time. The following is very important
in this process:

o The power supply to the SmartCheck or ProLink device must not be interrupted.

o The Ethernet connection to the SmartCheck or ProLink device must not be
interrupted.

o The update must be fully completed.
The device is no longer functional if these conditions are not met!

¢ If a serious error occurs during a firmware update, the device is reset to the factory
firmware. You can find the version of your factory firmware under Help > Version
information.

e After you have performed the firmware update, empty the browser cache. This is
necessary to ensure that the latest version of the Schaeffler SmartWeb software is loaded
in your browser.

4.2 Reset data partition

Click on the button Reset data partition %to start this function. Here you can reset the data partition. This
deletes all measurement data from the system. The measurement configurations are retained.

Click on OK Jto reset the data partition.

4.3 Reset firmware

Click on the Reset firmware button to start this function. Here you can format the data partition. In this
process, all measurement configurations and measurement data of the system are deleted and the default
measurement configuration is restored.

Click on OK " to reset the firmware.
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4.4 Adjust system settings

o] m—
Click on the Adjust system settings S=button to open the menu containing the system setting functions:

FAG SmartChed: -» Adjust System Settings

é

Adjust System Settings

ﬂ] Edit system name Inp:.:4 Configure IPv4 settings
@ Configure NTP server ::P‘Té-& Configure IPvG settings
@ Change administrator password E Replace server cerificate (PEM)

Wession: 1.0.20 (Build: 294980-20180815221038)

Click on one of the buttons to open the corresponding function. The following sections contain more information
about the individual functions.

4.4.1 Edit system name

Click on the Edit system namem] button to start this function. Here you can define a new name for your
SmartCheck or ProLink device.

To edit the system name, proceed as follows:
1. In the input field, enter the new name for your SmartCheck or ProLink device:
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FAG SmartChed: -» Adjust System Settings - Edit System Mame

>»

Edit System Name

System name: FAG SmartCheck 36

Enter system name and click OK to save or Cancel to abort.

Version: 1.0.20 (Build: 294580-20180515221028)

2. Click on OK J to confirm the name.

4.4.2 Configure NTP server

Click on the Configure NTP server@' button to start this function. Here you can define an NTP server from which
the SmartCheck or ProLink device can obtain the system time.

To configure the NTP server, proceed as follows:
1. Enter the IP address of the NTP server or the NTP server name in the input field:
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FAG SmartChed: -» Adjust System Settings -> Configure NTF Server

>»

Configure NTP Server

NTP server: ntp.rhrk.uni-kl.de

Here you can configure an NTP server from which the system can load the
system time.

Enter the NTP server address and click OK to proceed or Cancel to abort.

v X

Version: 1.0.20 (Build: 384580-20180815221038)
2. Click on OK Jto confirm the IP address or the NTP server name.

e If you use the NTP server name, you must enter a DNS server or set it using DHCP.

g ¢ If the system time is based on an NTP server, synchronization runs constantly. For this
method, therefore, the SmartCheck or ProLink device must have a permanent connection
to the network, and the NTP server must always be accessible.

4.4.3 Change administrator password

Click on the Change administrator passwordiFB] button to start this function. Here you can change the
administrator password for user management.

To change the administrator password, proceed as follows:
1. Enter the new password in the field Administrator password.
2. Repeat this password in the field Reenter password:
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FAG SmartChed: -» Adjust System Settings -> Change Administrator Password

>»

Change Administrator Password

1. ————» Administrator password: sses
2, =P Reenter password: sene

Here you can change the administrator password.
Nete: Leaving the password empty will disable the user management.

Click OK to proceed or Cancel to abort.

Version: 1.0.20 (Build: 384580-20180815221038)
3. Click on OK Jto confirm the new password.

If you enter an administrator password here, user management 163\ is activated automatically
l; on the SmartCheck or ProLink device.

If you do not enter an administrator password here, user management is deactivated on the
SmartCheck or ProLink device.

4.4.4 Configure IPv4 settings

-
Click on the Configure IPv4 settingsﬁ‘mI button to start this function. Here you can edit the IPv4 network
settings.

To edit the IPv4 network settings, proceed as follows:
1. Select the required DHCP mode from the list DHCP mode:



Maintenance system of the device

FAG SmartChed: -» Adjust System Settings -» Configure |IPv4 Settings

(2)
Configure IPv4 Settings
DHCP mode: DHCP: Send host name to serve «
Hest name: FAGSmartCheck
IP address: 10.179.7.241
Netmask: 255.255.255.0
Gateway: 10.179.7.254
Name server:
Select the DHCP mode and configure the network settings for IPv4.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038)
You have the following options:
No DHCP With this option, you can specify the IPv4 address or continue to use the

default IP address of the SmartCheck or ProLink device.

If No DHCP is activated, you must also specify the other settings in this step,
e.g. IP address, Netmask or Gateway.

DHCP: Send host name to With this option, the SmartCheck or ProLink device automatically receives an IP
server address within your network. The host name is registered by the SmartCheck
or ProLink device in the network's DNS server.

DHCP: Load host name from With this option, the SmartCheck or ProLink device automatically receives an IP
server address within your network. The host name is specified via the network's DNS
server.

2. Depending on the selection for DHCP mode, you will need to make further entries under Host name, IP
address, Netmask, Gateway or Name server.

3. Click on OK Jto confirm the changes and return to the system settings menu.

¢ If you change the IP address of the SmartCheck or ProLink device, you no longer have
g access to the SmartWeb software at the previous address. You must then enter the new
address of the device in the browser in order to load the software and the Maintenance
System again.
e If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink device can
only be accessed via the automatically allocated IP address or using the host name (DNS).
You can no longer use the default IP address.

4.4.5 Configure IPv6 settings

Click on the Configure IPv6 settings::':'ﬁla1 button to start this function. Here you can edit the IPv6 network
settings.

To edit the IPv6 network settings, proceed as follows:
1. Select the required DHCP mode from the list DHCP mode:
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FAG SmartChed: -» Adjust System Settings -» Configure |IPvE Settings

(2)
Configure IPv6 Settings

DHCP mode: DHCP: Load host name from sert|

IP address: fed0::fe3d:80ff.fe00:1336

Netmask: 64

Gateway: 10.179.20.254

Name server:

Select the DHCP mode and configure the network seftings for IPVG.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:57 minutes.

You have the following options:
No DHCP With this option, you can specify the IPv4 address or continue to use the

default IP address of the SmartCheck or ProLink device.

If No DHCP is activated, you must also specify the other settings in this step,
e.g. IP address, Netmask or Gateway.

DHCP: Load host name from With this option, the SmartCheck or ProLink device automatically receives an IP
server address within your network. The host name is specified via the network's DNS
server.

2. Depending on the selection for DHCP mode you will need to make further entries under IP address,
Netmask, Gateway or Name server.

3. Click on OK "to confirm the changes and return to the system settings menu.

¢ If you change the IP address of the SmartCheck or ProLink device, you no longer have
g access to the SmartWeb software at the previous address. You must then enter the new
address of the device in the browser in order to load the software and the Maintenance
System again.
¢ If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink device can
only be accessed via the automatically allocated IP address or using the host name (DNS).
You can no longer use the default IP address.

4.4.6 Replace server certificate (PEM)

Click on the Replace server certificate (PEM)E' button to start this function. Server certificates are used for
authentication of the server by the client. Here you can replace the server certificate that is defined on the
SmartCheck or ProLink device with your own server certificate.

To replace the server certificate of the SmartCheck or ProLink device, proceed as follows:

1. Click on the button Server certificate file v and search for the PEM file containing the required server
certificate.

2. Open the PEM file and, if necessary, enter the password for the PEM file in the field Passphrase:
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FAG SmartChed: -» Adjust System Settings -» Replace Server Certificate -= Seled File

>»

Replace Server Certificate

Server certificate file: i server2 pem
Passphrase: sene

Click OK to upload the server certificate or Cancel to abort.

v X

Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:52 minutes.

3. Click on OK Jto upload the certificate. The system analyses the file and informs you if can install the file:

FAG SmartChedk - Adjust System Settings -» Replace Server Certificate - Install
()

Replace Server Certificate

cert. versiom : 1
=erial number : B8:C5:€3:FA:28:A3:52:8€
iz=uer name= : C=DE, 3T=EY¥, L=3chweinfurt, {—3chasffler Technologiss GmkH & Ce. EE, OU=,

m

CH=www. fag—=smartcheck.com, emailiddress=industrial-services@schaeffler.com

C=0E, 3T=BY, L=3chweinfurt, {=3chaeffler Technologies GmbH & Co. EE, OU=—,

=ubject name :
CH=www.fag—=martcheck.com, emailiddress=industrial-services@schaeffler.com

ismsued on : 201E6-07-14 08:27:02
o
2 - 9n9E-nn-1= A@-39-87

The server certificate is ready to be installed.

Click OK to install or Cancel to abort.

v X

“ersion: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:48 minutes.

If the file does not contain a valid server certificate, you will be informed of this too.

4. Click on OK Jto install the server certificate.

4.5 Download debug log files

Click on the button Download debug log files to start this function. Here you can create and download an
error log file. You cannot view this file yourself. You need to send it to our Support team where it can be analysed.
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To download the log files, proceed as follows:

1. Click on OK Jto start the action.
2. The error log file is downloaded. A progress bar informs you of the progress.

3. Your browser prompts you to save the file. Confirm this prompt. You can then find the error log file *.SCLG in
the standard download folder.

4.6 Open expert menu

Click on the Open expert menu&l button to start the secure log-in process for the expert menu.

The expert menu contains functions that you can use to change the basic settings of the Schaeffler SmartCheck or
ProLink device. Because these are system-critical settings, the expert menu can only be opened via the secure log-
in process with a single-use password. The following section contains information about the secure log-in process.

To perform the secure log-in process, proceed as follows:

1. On the start page of the log-in process, you will find an ID. Share this ID with our Support team, e.g. by email or
telephone.

FAG SmartChedc -» Open Expert Menu -> Login

>»

Open Expert Menu - Access Verification

This section is password protected. Please call the customer support to generate
a one-time password from this ID:

—- fadbbcB7

Click the button below to log into the restricted area. Enter the user and the
generated password for authentication. The password is valid until next system
reboot.

1

Version: 1.0.20 (Build: 394580-20180515221038)

2. Our support team will use this ID to generate a single-use password and will forward this to you.

3. Click on the Login' button to open the authentication page; enter the user name in the User Name field and
the single-use password in the Password field:

Authentication Required @
9 A username and password are being requested by http://192.168.178.50.
The site says: "Web Server Authentication”
User Name:
Password:

[ QK l| Cancel |

4. Click the OK v button. The expert menu home page is displayed:
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FAG SmartChed: -» Open Expert Menu

>»

Open Expert Menu

ELET= Reset administrator password D Start remote access senvice

} Replace cryptographic keys % Update Maintenance System

Clear entire system @ Reboot system

=\

Version: 1.0.20 (Build: 294580-20180515221028)

Click on one of the buttons to open the corresponding function. The following sections contain more information
about the individual functions in the expert menu.

e The ID and the single-use password are only valid while you remain in the maintenance
g system. As soon as you restart the SmartCheck or ProLink device, the ID and password
are no longer valid. When you restart the maintenance system, a new ID then becomes
valid, and you can use this to request a new password from support.

e On the homepage for the log-in process, you have 60 minutes to obtain the single-use
password from support. During this time, if you use the (4 button to switch to the

maintenance system and from there back to the home page of the log-in process, the
timer is reset to 60 minutes.

4.6.1 Reset administrator password

Click on the button Reset administrator password E=8 to start this function. Here you can reset the
administrator password to the factory default setting. All users can then log on without a password and have
administrator rights. This deactivates user management.

Click on OK "to reset the administrator password.

Use the Change administrator password[ 25 function to change the administrator
g password. To find this function, choose Adjust system settings in the main menu of the
Maintenance System.

4.6.2 Replace cryptographic keys

Click on the button Replace cryptographic keys i‘to start this function. The cryptographic keys are used to
decode firmware files (*. SF2) and back-up files (*.SCBK) and for encoding back-up and protocol files. If they have
become known due to a cyber attack, they must be replaced. This ensures that no harmful software can be
installed on the system.
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To replace the cryptographic keys, proceed as follows:

1. Click on the button Keystore e and search for the file containing the cryptographic keys.
2. Open the file:

FAG SmartChed: - Open Expert Menu -> Replace Cryptographic Keys - Select File

A
Replace Cryptographic Keys
Keystore: [ smc-bkbin
Click OK to upload the cryptc-graphic KEYS or Cancel to abort.
v X
Versicn: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 9:52 minutes.

3. Click on OK v to upload the cryptographic keys. The system analyses the file and informs you if can install the
file:

FAG SmartChedk -> Open Expert Menu -= Replace Cryptographic Keys -= Install

()
Replace Cryptographic Keys
The cryptographic keys are ready to be installed.
Click OK to proceed or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:45 minutes.

If the file does not contain any valid cryptographic keys, you will be informed of this too.

4. Click on OK Jto install the new cryptographic keys.
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4.6.3 Clear entire system

Click on the button Clear entire system mto start this function. Here you can delete the entire system including
firmware, configurations and measurement data. The Maintenance System remains unaffected by this function.

1. Click on OK v to delete the entire system. The system is deleted and you then receive the following
message:

FAG SmartChedc -» Open Expert Menu -= Clear Entire Sytem

>

Clear Entire System

The system has been cleared successfully. You need to install a
new firmware.

Mote: Please configure the IP address, otherwise the system will

be reset to the default IP address "192.168.1.100" after reboot.

Version: 1.0.20 (Build: 294580-20180815221038)

2. You must now install new firmware. You also need to reconfigure the IP address of the SmartCheck or ProLink
device, because it has been reset to the standard IP address by this action.

After you have used the action Clear entire system, no firmware is available on the
g SmartCheck or ProLink device. You have the following options to continue working with the
device:

e Load a new firmware file onto the device using Update firmware[20".

 Choose Restore systeml 361 to load a previously created back-up file containing the entire
system onto the device.

If you have enabled additional functions through licences, you will need to add the licences
again[=.

4.6.4 Start remote access service

Click on the button Start remote access service I;lto start this function. Using this function, our Support team
can assist you via an FTP/Telnet server in the Maintenance System. As soon as you restart the SmartCheck or
ProLink device, the Remote Access Service (RAS) is terminated.

To start remote access via RAS, proceed as follows:

1. Click on OK v to start remote access via RAS.
2. The system reports that RAS has started successfully:

e
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FAG SmartChed: -» Open Expert Menu-> Start Remote Access Senvice

>»

Start Remote Access Service

Here you can start the remote access service (RAS). This function will enable
the support team to assist you via FTP/Telnet.
Click OK to proceed or Cancel to abort.

Version: 1.0.20 (Build: 294580-20180515221028)

4.6.5 Update Maintenance System

Click on the button Update Maintenance System Xﬂto start this function. Here you can upload an SM1 file to
update the Maintenance System.

To update the Maintenance System, proceed as follows:

1. Click on the Maintenance system file i button and search for the SM1 file containing the required
Maintenance System.

2. Open the SMifile. The system analyses the file and informs you which version of the Maintenance System it
contains:



Maintenance system of the device

FAG SmartChed: -» Update Maintenance System - Select File
(2)
Update Maintenance System
Maintenance System file: i smc_rescue FAG_1.0.22 sm1
The selected file contains the Maintenance System 1.0.22 (Build: 20170502_164020-395886).
Click OK to upload the file or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:50 minutes.

If the selected file does not contain a Maintenance System, you will be informed of this too.

3. Click on OK v to update the Maintenance System.

For this function, ensure a functioning power supply and an uninterrupted connection to the
g SmartCheck or ProLink device. If problems occur during the update, send the device to our
Support team.

4.7 Backup system

Click on the button Backup system I-Lto start this function. Here you can create a back-up file of your system in
order to save firmware, configurations and data. You can then use the Restore system| s function to select and
load a back-up file to restore a system, or to duplicate devices, e.g. to load configurations on multiple SmartCheck or

ProLink devices.

To back up your system, proceed as follows:
1. Select the required back-up type from the selection list:
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FAG SmartChed: -» Badp System

(2)
Backup System
You can create a backup copy of your system, for archiving purposes or for
safeguarding firmware, configurations and data.
Select a backup type and click OK to start the backup or Cancel to abort.
Firmware with configurations and data -
v X
Version: 1.0.20 (Build: 384580-20180815221038)

You have the following options:
Firmware with You can use this option to save the firmware and the configurations of the
configurations system. The measurement data is not saved.
(without data)
Firmware with You can use this option to save the firmware, configurations and measurement

configurations and data data of the system.

2. Click on OK Jto confirm the selected type of back-up and start the action.
The back-up file is downloaded. A progress bar informs you of the progress.

4. Your browser prompts you to save the file. Confirm this prompt. You can then find the back-up file *.SCBK in
the standard download folder.

w

Depending on the data volume, if you use the option Firmware with configurations and

l; data the file can become very large and the download therefore may take a long time.
During the download, the timer function is repeatedly reset to 10 minutes and does not
expire.

4.8 Restore system

Click on the button Restore system ILtO start this function. Here you can select a previously created back-up
file[ 3N to restore a system. The back-up file either contains only the firmware and configurations, or it contains the
entire system (firmware, configurations, and data). A back-up file can, for example, be loaded to a new SmartCheck
or ProLink device that will replace a previous device. In addition, you can also use a back-up file to copy a particular
system to multiple devices.

To restore the system, proceed as follows:

1. Click on the Select file i button and search for the SCBK file containing the required system.
2. Open the SCBK file. The system analyses the file and informs you which firmware the selected file contains:
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FAG SmartChed: -» Restore System -» Seledt File

()
Restore System
Backup file: [ f4_3d_80_00_0d_ce_Backup.scbk
The selected file contains the firmware 1.9.17 (Build: 392442-20160212111841).
Click OK to restore the system or Cancel to abort.
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 8:45 minutes.

If the selected file is not a valid back-up file, you will be informed of this too.

3. Click the OK v button. You will then be prompted to enter more precise details for restoring the system:

FAG SmartChedk -» Restore Systemn > Restore Configuration

()
Restore System
Do you want to restore the backup to a replacement unit or an additional unit?
@ Replacement unit ) Additional unit
The selected file contains the firmware, the configurations and also measurement data.
Do you want to restore the measurement data too?
[[IRestore measurement data too
v X
Version: 1.0.20 (Build: 384580-20180815221038) Firmware 1.12.0 will start automatically in 2:41 minutes.
You have the following options:
Replacement unit Select this option if you want to use the back-up file to load the system to a

replacement unit. If the selected back-up file also contains measurement data,
the option Restore measurement data too also appears (see below).

Additional unit Select this option if you want to use the back-up file to copy the firmware and
the configurations to other SmartCheck or ProLink devices.
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Restore measurement This option is only displayed
data too « if the selected back-up file also contains measurement data (in addition to the
firmware and configurations) and
¢ if you have selected the option Replacement unit.
Select this option to also restore the measurement data of the back-up file. By

default, this option is deactivated and the system is restored without
measurement data.

4. Click on OK v to confirm your selection and to start restoration of the system.

o If the Restore System function is cancelled after it has been started, there will no longer
g be any firmware on the SmartCheck or ProLink device. When you start the SmartCheck or
ProLink device, the Maintenance System opens. You must then load new firmware onto
the device, for example, using the functions Update firmware or Restore system.

e When you create a back-up file, not all content is copied. A back-up file for instance does
not contain a network address. If you use Restore system to load a back-up file onto a
new device, the network address of the new device is retained.

4.9 Reboot system

Click on the button Reboot system @to start this function. This function enables you to shut down and restart
the system. This shortens the time until the automatic restart specified by the timer function of the Maintenance
System[ 201,

Click on OK v to confirm the restart.

This function is available both on the start page of the Maintenance System and in the
g expert menu.
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Status

Click on the Status &3 button to open the corresponding area. Here you will find a general overview of the status
of the SmartCheck or ProLink device:

Connected to ; ProLink 38
Schaeffler SmartWeb A .
Logged in as : admin
File w Edit ¥ Measurementdata ¥ Goto ¥ Help v
Status 4& Characteristic value status ™=
Name Base configuration G Measurement jobs
Name : (F4:3D:80:12:01:61) -
— @ Device alarm slatus (Vibration sensor 3) Name Fnl;l_r:]llﬂﬂ
Current alarm status - Mo alarm :
+ @ Base configuration (F43 K 2023-07-20 2023.07-22 _ .
@ 7 ’ Last measurement : 2023-07-23 18:26:39 N N @ Active
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You can find the following information here:
Status and context menu

Your measurement jobs and the corresponding characteristic values are listed here.
show you at a glance:

The alarm symbols

¢ Non-critical measurement job @

e Measurement job with pre-alarm

e Measurement job with main alarm F':\

« Non-critical characteristic value &

e Characteristic value with pre-alarm

e Characteristic value with main alarm 4k

« Characteristic value without measured values®
e Sensor fault

o Active measurement job[ 41, indicated with a blue dot 4

To see the status of a characteristic value in the main panel of the area, click on the desired characteristic
value.

For each item in this list, you can right-click to open a context menu, where you will find the following
commands:
¢ Reset alarm

For individual characteristic values: Switch off the alarm for this characteristic value manually here. This

option is required if alarms for this measurement job are not automatically reset as soon as the
measured value drops below the alarm limit.

¢ Reset all alarms
For individual measurement jobs: Manually switch off the alarms of all subordinate items here.
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You can only reset alarms manually, e.g. via this context menu, if you made the
iy corresponding setting when creating or editing a measurement job in the Set Alarms[7s"
l:i step: under Reset Alarms, you must activate the Manual option.

o Alarm settings[ s
For individual characteristic values: Here you open a dialogue in which you can view and edit the alarm
settings for this characteristic value.

o Edit hour meter
for measurement conditions: Edit the value for the hour meter here. Details on the hour meter and
how it works can be found here[so.

e Start learning mode
For individual characteristic values: Start the learning mode for the selected characteristic value again
here. Details on the learning mode and how it works can be found here[s?".

¢ Start learning mode for all
For individual measurement jobs: Start the learning mode again for all subordinate items for which the
learning mode is authorised. Details on the learning mode and how it works can be found herels".

¢ Activate learning mode for all
For the whole device, for individual measurement jobs or characteristic values: Activate this option to
switch on the learning mode for all subordinate elements. Details on the learning mode and how it
works can be found here[s7.

¢ Live view
For individual characteristic values: Switch here to the Live view[ s area. There you will see in real
time the signal used for the calculation of this characteristic value.

e Measurement data

Switch here to the Measurement datal s area. There you can display the trends and time signals of
these measurement jobs/this characteristic value and carry out an initial analysis.

The commands available depend on which level in the tree structure the selected item is located and
whether you have the user rights for the desired action.

In this area, you wil find the menu items Create new measurement job[7" and Show measurement
jobs[ 7. They allow you to create a new measurement job and to go straight to the detailed overview
of your measurement jobs via the corresponding wizards.

If you use one of these menu items, you will then be taken automatically to the Configuration area.

Here you will also find the menu item Edit the "Machine is running" measurement condition[i3¥or
theSmartCheck device. This measurement condition is preconfigured when the device is shipped and
should be adapted to the requirements of your machine.

Characteristic value status

For the selected measurement job/characteristic value, the name, alarm status, time of last measurement
and an illustration showing the development of the measurement job/characteristic value are displayed
here in one view. The button in the Characteristic value status title bar and the two buttons before
the illustration provide direct access to important functions:

E] Click on this button to display the status indicator for the entire system.

Click on this button to open a dialogue for editing the alarm settings.

-tlvn-

R

Click on this button to view the measurement data and carry out an initial analysis of trends and
time signals.

0 e If the Device alarm status is selected:
Click this button to switch to the Characteristic value status display for this measurement
job.
A blue dot on the button ® indicates that the measurement job is currently active, i.e. that
measurement is being carried out.

o If a measurement job is selected:

Click this button to switch to the Characteristic value status display for this characteristic
value.

An additional illustration shows you how the characteristic values of the measurement job or an individual
characteristic value behave in terms of the pre-alarm and main alarm:
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The grey column symbolises the current value of the characteristic value. Depending on where
it is positioned, it indicates the following:

e Green area: The measured value is unproblematic.
¢ Yellow area: The measured value has exceeded the threshold of the pre-alarm.
¢ Red area: The measured value has exceeded the threshold of the main alarm.

If the measured value significantly exceeds the main alarm limit, a small black triangle is displayed
above the bar:
i

If the measured value is below the lower pre-alarm limit Signal always greater than, the small
black triangle is displayed below the bar. The characteristic value then has a pre-alarm:

v

In symmetrical signals, for example in the case of torques in different directions, negative values
are also possible. In this case, a yellow area for the lower pre-alarm and a red area for the lower
main alarm are also displayed below the green area:

If no measured values have yet been measured, a white area is displayed.

& + A Click the alarm symbol next to the column to view details of that characteristic value.

Measurement jobs

You can

find information here about which measurement jobs are currently being carried out by the

device and which measurement jobs are in the queue. You will find the Name of each measurement job.
The time in minutes and seconds appears under Duration [m:s] as soon as the measurement job has
been carried out.

The measurement jobs are divided into the following areas:

@ Active This area contains the currently active measurement jobs, i.e. the measurement
jobs that are currently being carried out by the device.

=1 scheduled This area contains the scheduled measurement jobs.

% Waiting for This area contains the measurement jobs waiting for a trigger.

trigger As soon as the trigger occurs, these measurement jobs become active.

«#" Waiting for This area contains the measurement jobs waiting for a measurement condition.
measurement As soon as the measurement condition occurs, these measurement jobs move
condition to the Scheduled area.
Click + or — to expand or collapse an area.

Active measurement jobs are indicated with a blue dot both on the left-hand side
g of the tree under Status and under Characteristic value status .

System information
General information about the system is displayed here, e.g. when the system was started, when the
configuration was last changed, when a measurement was last performed. You will also find the current
values for the individual inputs here.
For the Schaeffler ProLink device, the information about the processor module and all connected modules
are shown in illustrations:
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Schaeffler ProLink ProLink 'O module (F4:30:80:16:00:0F) ProLink vibration module
(F4:3D:80:12:01:61)

The illustrations provide access to the following information and features:

The illustration furthest left provides information and functions for the
L] processor module of the ProLink device:

2021-04-13 14:09:13 ¢ Here you wil find the start time of the device, time of the last

measurement and the last configuration change as well as the

available and remainingdisk space.

2021-04-13 20:21:11 « Move the mouse over the illustration to read additional information
about the device temperature and the operating hours.

« Click on the illustration to open the device configuration[s"

CPU overview. Here you can define basic settings for your ProLink
device and specify measurement jobs.

2021-04-13 20:35:14

SoQeo

5938 MB/1.0GB

1776°C_ I3 The illustrations to the right of the processor module provide
0221? g . (] information about the modules connected to your processor module:
g';;i;g E e The modules are displayed in ascending alphanumeric order from
' left to right. The combination of module name - for example
- ProLink I/O module or ProLink vibration module - and serial number
" o determines the sequence. You should take this into account at
0.0 Hz " on installation of the modules. To change the sort order and map your
ooHz 1 I on physical system configuration, you can edit the names of the
—e = modules[ so".
viB e For each module, you will find the current values for the four

analogue and two digital inputs here, as well as the current values
for the four digital switching outputs.

e You will find here the current values of the eight inputs or outputs
for each I/O module.

e Move the mouse over the illustration to read additional information
about the firmware version, hardware version, device
temperature and operating hours.

o Click on the illustration to open the module configuration|ss".
Here you can view details for the respective module and edit its
name.

« M Status and module identification: The colour of the symbol
indicates the status of the device:
Green: The device is connected.
Grey: The device is not connected.
Flashing green and grey: The device is being identified.
You can identify the associated physical module by clicking on the
symbol. The LEDs of the physical module in question flash
alternately. Click again to exit identification mode.

To calculate the characteristic values, the measurement triggers and the measurement conditions, the
root mean square (RMS) value is calculated from a specified number of measurement values. The squaring
process means that this value is always positive, even if the measurement values are smaller than zero:

Example for measurement trigger: At a measurement range of -3000 rpm to +3000 rpm, if you
set a threshold of 1500 rpm with a rising edge, this threshold is triggered both when the value
exceeds +1500 rpm and when it falls below -1500 rpm.

Example for measurement condition: At a measurement range of -3000 rpm to +3000 rpm, if
you set a lower threshold of 1500 rpm and an upper threshold of 2000 rpm, this condition is met
both when the value is between +1500 rpm and +2000 rpm and when it is between -1500 rpm

and -2000 rpm.

Logbook
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Status

This table contains all messages created by the system or by users of the system, including dates on
which the system was created or changed and the level of the message. You have the following options:

 Browse messages

If your messages are spread over several pages, you can use the navigation elements 14 < and * #I
of the logbook to skip forward and back a page or jump to the start or end of the logbook.

e Show warnings only

The SmartWeb software displays all logbook entries, i.e. errors, warnings and information, by default.
You can filter the results to display only errors and warnings by removing the checkmark from
Information. If you also deactivate Warnings, only errors are displayed.

¢ Add message

Click on B to create a new message. You can find details on this in the Create Message in the
Logbook/ s section.

¢ Edit messages

You can edit messages you created yourself. To do so, click on 7" in the Edit column. A window
opens, in which you can change the text in the Message field. Confirm your change by clicking on OK.

The categories of the messages created automatically by the system have the following meaning:

) Information refers to events in the system; this includes e.g. a user having logged on or a
configuration having been changed.

Warnings are mostly references to misconfigurations, e.g. when a machine exceeds the
maximum rotational speed specified in the measurement job.

€3  Errors report system-critical problems. In this case, contact our Support team.

5.1 Creating/editing a message in the logbook

How to create a message in the logbook

1.

w

Click on B to open the Add message window:

Add message

Schaeffler SmartWeb

Category :
© Information v

Message :
Maintenance services on machine §

oK Cance

Select the Category for your message.
Enter the text of your message in the Message field.
Click on OK to save your message. The Logbook will now include the message.

How to edit a message in the logbook

1. In the line of the message you want to edit, click on Edit 7
2. Make the desired specifications for Category and under Message.
3. Click on OK to accept your changes.
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6 Measurement data

Click on the Measurement data ¥~ button to open the corresponding area. Here you can view the trends and
time signals of characteristic values and the trends for measurement triggers and conditions, and you can carry out
an initial analysis. On the left, you will find your measurement triggers and conditions, and also the measurement
jobs and their characteristic values. If you select an item, you will see the associated trends and saved time signals in

the main panel. As soon as you select a saved signal, the corresponding curve appears:

Schaeffler SmartWeb

File w Edit ¥ Measuremenidata ¥ Golo ¥

Help w
Measurement data Trend
N .
ame Name : L <« | ¢ || Dale:2019-12-13 06.09:43 Value: 0.0012 g > | » Q| ] L
RMS Z#E - niE (&=
— & Device alarm status _
F—HAZ) 5
! .25
— (& Base measurement job Template :
@ 1S010818-1 (2Hz RMS broad band 10
Range from :
2019-12-13 05:40:00 ors
Range to :
2019-12-13 13:05:30 = g
- Date: 2019-12-13 06:09:43
25 Value: 0.0012 g
+ . .
<+ Alarm seffings 0.0
@ Ex 2018-12-13 20181213 2018-12-13 2018-12-13 2018-12-13 20181213
@ am.7=— 06:00:00 07:00:00 08:00:00 08:00:00 10:00:00 12:00:00
— i Basiskonfig Saved time signals
4. Digital input (spe Alarm Date Value Area: | Time and spectrum w | Unit:| g
@ 15010816-1 (2Hz... A
@& 2013-12-13 06:48:55 0.0011 g T
@ PeakZpeak - Acc... g9 | | Fixed @, g Fixed Log. | 1 @,
& 2019-12-13 06:15:45 0.0009 g .
& RMS broad band... 0.0003
& 2019-12-13 06:09:43 0.0012¢g
RMS broad band
& 2013-12-13 060619 0001g 0.0002
& Actions
@ 2013-12-13 05:50:49 0.0011g
Show measurement jobs o
o @ 20191213 05:44:38 0.0009g 0.0002
Download measurement data
. §
Delete mezsurement data & Details
& Areas Date : 2019-12-13
Time : 06:09:43
R Status Value : 0.0012 g
Main alarm : 1.0 g
" Measurement data Pre-alarm: 0.7 g
‘\N‘ Lower pre-alarm : 0.0 g
Live view . .
Type : Raw signal 00 20000 40000 60000 E0000 10,000
E X Number of values : 4,096
|& Configuration FFT lines : 1,600 Hz o~
. Sampling rate : 25,600 Hz
o User management Low-pass : 10 kHz
(l) Log out 0.0 20000 40000 60000 80000 10,000
Complete

Connected to : SmartCheck 36
Logged in as : admin

N

As soon as you have selected a characteristic value and a saved time signal, you will find the following information

and functions here:

Trend

Under Trend, you will find a graph of the trend values for the selected characteristic value. On the left,
you will find precise information on the characteristic value and the save period under Name, Template

and Range.

As well as the trend (blue) and the saved time signals, the pre-alarm limits (yellow) and the main alarm
limits (red) are also depicted in the graph:

144 < Date:

.

Walue: 3 3% ®\ Q &

How to work with the graph:
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Measurement data

Highlighted in colour The section highlighted in colour tells you about the alarm status at a
glance:

e White: no alarm

e Yellow: pre-alarm

e Red: alarm

If the background is grey, a characteristic value error has occurred.

Blue line The blue line represents the trend.

Red line The red line represents the main alarm limit. Changes in the line occur
¢ If you have changed the value for the limit
o If the system has learned a new alarm limit via Learning mode[s
« If a new status area was reached in relation to Alarm mapslss.

The yellow line represents the pre-alarm limit. Changes in the line occur
¢ If you have changed the value for the limit

o If the system has learned a new alarm limit via Learning mode (s

« If a new status area was reached in relation to Alarm maps[so.

If you place the cursor at certain places in the graph, a mark appears and
N} you can then read the corresponding values in the Date and Value fields.
You have this option:

At the starting points of the trend and of the alarm limits

At the end points of the trend and of the alarm limits

At the changing points of the alarm limits

At all measurement points of the trend (blue and green symbols).

oo™, On the blue trend line, you will find the following symbols:
¢ Blue: trend value
¢ Green with white centre: trend value with saved time signal; click on
the symbol to display the time signal.
 Red with white centre: time signal currently displayed

Additional options

& and Use this button to activate/deactivate the update mode.
N If the update mode is activated, the trend is reloaded every 60 seconds
and new measurement values appear automatically in the trend window.

If you select in the trend window a trend range in which the last measured
value no longer appears, the update mode automatically deactivates.

Click this button to open a dialogue in which you can view and edit the

Alarm setiings alarm settings for the relevant characteristic value[ 4.

e The trend display for measurement triggers and measurement conditions enables you to
g check if and when the value that you have defined as the trigger or condition has been

encountered.

e If you select a time segment with very many time signals, it is possible that not all of them
will be displayed. In this case, you will only see a selection; if you zoom in on the area, the
"hidden" time signals will also appear.

e You can find detailed explanations on the learning mode and on alarm maps in the
Learning mode and alarm maps/ 7 section.

Saved time signals

Here you will find on the left a list of all saved time signals of the trend segment currently displayed,
each with details on the alarm status, date and value.
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¢ Click on a time signal in the list to see details about it below the list and in the graph on the right.

¢ When you have selected a time signal, you can use the arrow keys to navigate up and down through
the list.

e To sort the list, click on a column header.

e If you have zoomed in on a saved time signal as described below, the zoom range also remains in
place if you select a different time signal from the list.

By default, the graphical display on the right shows an overview of the saved time signal as a time
signal and as a spectrum. Here you can also perform an initial analysis:

Area:| Time and spectrum * Unit: | g -

g Fixed ®\ q Fixed Leg. | 1 ®\

You have the following options:

e Select the range . This determines whether the signal is displayed only as a time signal, only as a
spectrum or whether both graphics are visible.

e Activate the Fixed option to display the signal with fixed scaling. You can then zoom both horizontally
and vertically.

e You can view the exact values for each peak; move the cursor over the peak until a blue circle appears.
The values of this peak are then displayed in a small box:

0,003 x0045s
y. 0,0022 g

0,002

0,001

0.0

0,001
00445 00448 0,045 00452 00455 0,0458 0,048

e Activate a measurement tool by clicking on any point: when you click, a red cross appears on the
point. You can then drag a red line over the graphic. The values of the points and their distance to
each other can now be seen in a box next to the line:
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Measurement data

0,005

0.0

<0,005

-0.01

®

%

0,081 s

0,0031 g

01011 5

10,0077 g

1 o0
“|100,4 Hz

0.0

10,0108 g

0,022 TS

o0

0.1 0,125 0.15

¢ If you zoom into a sub-area, as described below, the narrow strip beneath the main graph acts as an
overview: The full area is always shown here and the zoomed area is highlighted in colour.

Additional functions in the spectrum

For the spectrum view, the following additional functions are available:
¢ Activate the Log. option above the graphic to display the signal with a logarithmic scaling.
e Select the required unit from the selection list below the graphic.

« The button' above the graphic opens the Edit speed/frequency band display dialogue. Here you
can edit the display of speed, harmonics and frequency bands:

Edit speed/frequency band display

Speed source : | User-defined

2.0 Harmonics : | 10

i)

Rotational frequency [Hz] : :

Frequency bands : | Do not display frequency bands

You have the following options:

Speed source: Choose between Do not display speed, Fixed speed, and User-defined. The
speed is displayed in dark red.

Rotational frequency (RPM): If you have selected the User-defined option for speed source,
enter the required rotational frequency here. You can also enter the speed automatically: To do this,
move the cursor over a peak and double click when the blue circle appears. The corresponding speed is
then copied to the dialogue.

Harmonics: Here you determine how many harmonics are displayed in the graphic. Harmonics are
displayed in light red.

Frequency bands: Choose between Do not display frequency bands and the frequency bands
relevant for the selected characteristic value. Frequency bands are displayed in green

When you have set the speed, harmonics, and frequency bands, the spectrum might look as follows, for
example:

g [CFix

0,0002

[ Log.

0.0002

0,0002

0,0002

0,0001

1,00005

0.0
0.0

20.000 40.000 80.000 80.000

RPK | »
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In confidential measurement jobsl 77 only users with special rights can edit the frequency
g band display.

Zoom functions in all graphs

It is possible to zoom in on all graphs: To zoom, click in the graph and draw the cursor over the area on
which you want to zoom in while holding down the left mouse button; this highlights the zoomed area in
colour. You can also find details on this function here[ss.

The following buttons are then available for you to work with zoomed areas:

@\ Switches back to the original display
Jumps back a step in your zoom editing

Enlarges the selected time range

) O )

Jumps forward a step in your zoom editing

Actions
On the left under Actions, you will find the following menu items:

o Show measurement jobs[7a": Use this link to jump directly to the Measurement jobs area. There
you will find an overview of all measurement jobs, their characteristic values and the corresponding
details.

» Download measurement data:[ =" Use this command to open a dialogue in which you can select
measurement data for download.

« Delete measurement data:[ 52 Use this command to open a dialogue in which you can select
measurement data for deletion.

¢ The Measurement data area is only designed for an initial analysis. For a detailed analysis,
g you must download the data of the SmartCheck or ProLink device[s:". You can then use

the built-in SmartUtility Viewer software to perform a more detailed analysis.

¢ The details in the Saved time signals section also contain information on the number of
measurement values. However, the actual number of measured values displayed depends
on the limitations of your browser.
If you are using Internet Explorer, the whole time signal cannot be displayed for
performance reasons. You can identify the actual number of measured values displayed
under Number of values. Two values are displayed:

Lower pre-alarm : 0.0 -

| Humber of values : 2048/4095 |
Sampling rate : 5120 Hz
In this example, only 2048 of 4096 measured values are displayed.

6.1 Edit alarm settings

The alarm settings for a characteristic value are initially set as part of a measurement job[78". You have access to a
dialogue in which you can edit the alarm settings at a later point.

How to edit the alarm settings
1. In the Measurement data area, click Alarm sefiings |
2. In the Alarm settings window, enter the desired specifications:



Measurement data

Alarm settings: Peak2peak - Acceleration (High vibration values)

Schaeffler SmartWeb

=5

I

X

Q@

Date: - Walue: - ¥ ¥

Main alarm : | 1.0 g Pre-alarm: | 0.7 g 9

Lower pre-alarm : | 0.0 g " Use learning mode

OK Cancel

You have the following options:

Buttons and graphic

Main alarm

Lower main alarm

Pre-alarm

e You can use the buttons above the graphic to navigate the trend and use zoom
functions. More details can be found in the Measurement datal 2" section.

e The graphic shows you the trend of the selected characteristic value. The
graphic provides the same information and functions as the graphic in the
Measurement data area. You can find details on this in the Measurement
datal . section.

e You can also adjust the alarm limits manually from here:

= Main alarm: Click the red main alarm limit, hold down the mouse button and
drag the limit to the required position. The pre-alarm limit is automatically
dragged with it as soon as you go below the pre-alarm limit.

= Pre-alarm: Click the yellow pre-alarm limit, hold down the mouse button and
drag the limit to the required position. This does not change the main alarm
limit and the pre-alarm limit cannot be dragged over the main alarm limit.

This is where you determine the limit at which the main alarm is triggered.

Symmetrical signals, for example for rotational movements in different directions,
also have negative values. Enter the main alarm limit for the negative value range.

This is where you determine the limit at which the pre-alarm is triggered. Next to
the absolute value is the percentage value calculated from the pre-alarm limit and
main alarm limit.
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Lower pre-alarm

Signal always larger
than

Use learning mode

W

Enter the pre-alarm threshold for the negative value range of a symmetrical signal.

Enter a value for an additional pre-alarm limit. This pre-alarm is triggered when the
signal value is below the value determined here.

Activate this option to use the learning mode for this characteristic value. The
system can then automatically learn the alarm limits depending on the current
status of the machine. Learning mode can only commence if there is a tick here,
e.g. entered via the context menu of the characteristic value in the Status[z"

area.

You can find details on the learning mode in the Learning mode and alarm

maps| &7 section.

Move the mouse over the question mark @ to read additional information.

3. Click OK to save the new alarm settings.

You can also edit the alarm settings for an alarm map here. In this case, you must edit the
g alarm settings of the individual alarm maps.

6.2 Edit hour meter

When you create a measurement condition, an hour meter is automatically created which indicates the active
operating time of a measurement condition. This allows you to determine how long a measurement condition has
been satisfied and for example to track the running time of a pump.

The hour meter starts as soon as the corresponding measurement condition[ o4 is fulfilled.

Schaeffler SmartWeb

File w Edit ¥ Measurementdata v Gote W

Measurement data

Name
— @ Device alarm status
— @& Base measurement job
@ 150 10816-1 (10 Hz to 1 kHz) - velocity
& Peak-peak - Acceleration (high vibrat. .
& RMS broad band - Acceleration (over. ..
& RMS brozd band - Demodulation (ov...
& Temperature
— @ Measurement triggers and conditions
— & Machine is running

& Machine is running - Hour meter

Trend

Name :
Maching is running - Hour
meter

Template :
Range from :
2021-04-03 10:40:00

Range to :
2021-04-12 13:30:00

Saved time signals

Alarm Date

Value

Date: 2021-04-08 22:44-07

Connected to : Schaeffler SmartCheck
Logged in as : admin

¢: M

Help w

Valug: 11:38 h 3 @, Q, W

Date: 2021-04-08 22:44.07

Value: 11:33 h

Area:| Time and spectrum

1]
55
"

I=¥=1

= | Unit: o

Here you can view the trend of the hour meter and carry out an initial analysis.

How to edit an hour meter

1. Click on the Measurement condition under Measurement triggers and conditions in the Measurement

data area.

2. Click on Hour meter and make a selection from the shortcut menu

3. Set the desired specifications in the Hour meter window:

£2) Edit hour meter



Measurement data

Edit hour meter

Values [hours] : | 0
OK Cancel
The following options are available:
Values [hours] Here you can specify the hour value from which the hour meter should run. The

default setting is 0.

Adjust the hour meter if the component has been in operation for a long time and
you installed the monitoring at a later time. If you exchanged the component,
reset the hour meter back to 0.

3. Click OK to save the hour meter settings.

You can view the trend of the hour meter in the Measurement data area below the associated measurement
condition.

6.3 Download measurement data

The Measurement data area is only designed for an initial analysis. For a detailed analysis, you must download the
data of the SmartCheck or ProLink device. You can execute this using the Schaeffler SmartUtility software and
analyse the data directly using the integrated SmartUtility Viewer software. Alternatively, you can download the
measurement data using the corresponding function of the SmartWeb software and open it later in the
SmartUtility Viewer software for analysis.

How to download the measurement data
1. In the Measurement data area, select the Download measurement data action.
2. In the Download measurement data window, enter the desired specifications:

Download measurement data

Schaeffler SmartWeb

This iz where you zelect the time range, for which
measurement data is downloaded :

# Complete time range Specify time range:

OK Cancel

You have the following options:
Entire measuring period Activate this option to download all saved measurement data.

Selected measuring If you activate this option, the calendar functions become active:
period

51



Download measurement data

Schaeffler SmartWeb

This is where you select the time range, for which
measurement data is downloaded :

Complete fime range @ Specify time range:

from: | Dec 11 20189
to:| Dec 11 20189
Ok Cance

You can then use the list boxes or the calendar selection to determine the time
range for which the measurement data is to be downloaded.

3. Click on OK. You must then confirm the download of the *.scd1 or *.scd?2 file to your downloads directory.

4. Once the *.scd1 or *.scd2 file has been downloaded, you must convert the data directory in the SmartUtility
software. You can then analyse the data in the Viewer software.

You can save downloaded files with a password for data encryption. The Edit > Device

g settings > Edit security settings menu option opens a dialogue box in which you can
enter the password. This password is required if the measurement data downloaded with
the SmartWeb software should be opened in SmartUtility.

6.4 Delete measurement data

You can delete measurement data from your SmartCheck or ProLink device. In doing so, you can define both the
time range of the data to be deleted and the affected measurement jobs, measurement triggers and measurement

conditions.

How to delete measurement data from the SmartCheck or ProLink device
1. In the Measurement data area, select the Delete measurement data action.
2. In the Delete measurement data window, enter the desired specifications:



Measurement data

Delete measurement data

Schaeffler SmartWeb

This is where you select the time range for which
measurement data is deleted :

Complete time range  (® Specify time range:

from: Dec |11 = 2018 -

to:| Dec |1 = 2018 -

Thig iz where you select which measuring data from the
specified time range iz deleted :

# All measurement data Diefine measurement data
oK Cancel
You have the following options:
Complete time range Activate this option to use the entire measuring period as the basis for deleting

measurement data.

Selected time range If you activate this option, the calendar functions become active: You can then use
the list boxes or the calendar selection to determine the time range for which the
measurement data is to be deleted.

All measurement data Activate this option to delete all measurement data within the time range selected

above.
Define measurement Activate this option to select specific measurement jobs, measurement triggers or
data measurement conditions from the list. Only the measurement data in this selection

is then deleted for the time range selected above.

How to select items from the list:

e Left-click: selects the item.

e CTRL + left-click: Adds the item to an existing selection.

e SHIFT + left-click: Selects all items between the first and last selected items.

3. Click on OK. The measurement data corresponding to your selection is deleted.

53



7 Liveview

Click on the Live view W button to open the corresponding area. Here you can view the relevant signal for each
input and the scaling factorsl &7 created for them. This allows you to check whether a valid signal is coming in,
whether you have connected and configured the inputs correctly and whether the SmartCheck or ProLink device is
working properly. You can also try out different filter settings for vibration sensors here. You create the basis for this
when creating the base configuration: If you activate the expert settings[ "\ in the configuration wizard, you can
set filters in the corresponding step in some measurement jobs.

Connected fo ; ProLink 36
i

Schaeffler SmartWeb Logged in a5 : admin .

File w Edit ¥ Measurementdata v Goto w Help =
Live view & Live view settings
Input Signal type Filter settings Order analysis Measurement values Signal unit

= Spactrum Low-pass Number of values Signal unit group
+ B3 Controller s 20kH= - 500 - Acceleration
— B3 ProLink 110 module (F4:3... Demodulation
Signal unit
»| Analogeingang 5 (F4: Order analysis g -

»| Analogue input 1 {F4.

| Analogue input 2 {F4.

Live view
| Analogue input 3 {F4-
i s ysi 2
51 Analogue inpul 4 (F4 Input signal: Demodulation: | Spectrum: Order analysis LP: 20kHz Integration
Vibration sensor 1 (F4:3D:80:12:01:61) Off Off Off HP: - Mone

3 Analogue input 6 {F4

31 Analogue input 7 {F4 g Fixed @,

¥ Analogue input 8 {F4 0.35
— B3 ProLink vibration module

=3 Vibration sensor 1 (F. 0.2

¥ Vibration sensor 2 (F.

¥ Vibration sensor 3 (F. i 0.25

¥ Vibration sensor 4 (F.

# Eingang 2

- < Backwards

31 Snead innut 1 (F4-30
& Actions 015
Open input configuration

0.1
-
Areas » Start
& Status a.08
W Stop
" Measurement data
A= Live view
0.0 0 0.002 0.002 0.004 005 0.008 0.007 0.002 0.009

E Configuration s
a2 User management |
(1) Logout 0.0 0.001 oz ) 004 08 006 00z nog
Complete

As soon as you have selected an input or scaling factor on the left, you will find the following information and
functions here:

Live view settings
Various options here enable you to influence the display in the live view:
e Signal type: Here you can select which signal type should be displayed. If no selection is made, the
raw signal is displayed.
¢ Filter settings: Here you can modify the filters that are used.

« Order analysis: If you have selected the Order Analysis signal type, you can specify details here[es",
i.e. the digital input for the order analysis, the underlying pulses per revolution, the maximum rotational
frequency of the component and the maximum number of orders contained in the signal.

¢ Measurement values: You can determine how many measurement values are displayed here. With
the Number of values, you can specify the area in which you can work with the navigation elements
and the zoom function.

o Signal unit: You have the abilty to change the signal unit here. In our example above, you can
change from acceleration and m/s2 to speed and mm/s or to displacement and mm.

If you select the Order analysis option under Signal type, the x-axis displays the
g number of revolutions in the live view.

Live view and navigation elements

To use the functions above and in the graphical display of the live view, proceed as follows:
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Live view

Fixed Activate this option to display the signal with fixed scaling. You can then
zoom both horizontally and vertically.

Log. Spectrum only:
Activate this option to display the signal with logarithmic scaling.

n Use this button to open the Edit speed/frequency band display[ s

dialogue. Here, you can edit the display of speed, harmonics, and
frequency bands.

Click on the graphic Clicking on the graphic activates a measuring tooll 4" that you can use
to determine the distance between two points on the display.

Use the navigation elements to further analyse the live view as follows:

. As soon as you move the slider, the live view is stopped; you can then
navigate with the slider through the last 50 measurements.

As soon as you click on Back, the live view is stopped and the display

¢ Backwards jumps backwards in individual steps.

If you have stopped the live view and rewound, you can jump forwards

> Fonwards in individual steps by pressing the Forward button.

B Stop Use the Stop and Start buttons to stop or resume the live view.

¢ Start

In confidential measurement jobsl 771 only users with special rights can edit the frequency

g band display.

Zooming in on the live view
You can have a closer look at areas of the live view by zooming in on them:

¢ Click in the area you want to look at and move over the area whilst holding down the left mouse
button. This highlights the zoomed area in colour:

W N llh'l')\‘UhM‘{,l“

rﬂ?m;.-.\'m'h T L T

e As soon as you release the mouse button, only the zoomed area appears in the live view. The thin strip
below shows an overview of the original display area, indicating the area that has been zoomed in on:
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Actions

[“"i*'l"""'li.‘l‘"'w'l""-'.l.w.‘\*‘w:"“'~-'\k*""‘""I‘I"J'-'fr-'-'-"'wl"'lkuh”wm'ﬂ.'ﬂ"w A
e Further zoom functions/ss" are available using the buttons above the graphic.

On the left under Actions, you wil find the Open input configuration menu item, with which you can
jump directly to the Input configurations[e area to edit the selected input.



Configuration

Configuration

Click on the Configuration liE button to open the corresponding area. In this area of the SmartWeb software,
you can make basic settings for your SmartCheck or ProLink device and specify measurement jobs. The
Configuration is thus the core of your SmartCheck or ProLink device: How reliably the machine monitoring is
executed depends on the settings in this area.

When you use the Schaeffler SmartCheck or ProLink device for the first time, the configuration overview opens

automatically when you click on the Configuration B button:

Connected fo ; SmariCheck 36
Schaeffler SmartWeb onnected to : SmariCheck 38 ® .

Legged in as : admin

Hame

File ¥ Edit ¥ Measurementdata ¥ Goto W Help w
Configuration Configuration
= B Gorfiguraton Please perform the following steps to configure your device:

+ =31 Input cenfigurations

+ (2 Measurement jobs

+ «1 Output configurations
. 3 : : For example :

& Measurement frigger 1. AdJUSt device setti ngs E Name, System time, NTP server, Key/LED seftings, Network seftings
+ & Measurement condit
+ = Communication chan
+ [®] Device

(©) Bearings

. _ - N _ Or edit :
wal Bearing manufacturer 2. Edit input configurations %I Vioration sensor, System temperature sensor, Digital input (speed). Voltage, Load, Fixed speed (3000

BPWM), Rotational speed

3. Create measurement iObS G Or edit existing measurement jobs :

Base measurement job

Actions

Create new measurement job

Areas

. Or edit existing output configurations :
&, status 4. Create output configurations EI

Cverall alarm status

" Measurement data

Al Live view

lE Configuration

2 User management

LU Leg out

Complete

This overview depicts what a logical work flow looks like once you have installed the SmartCheck or ProLink device
and established a connection to the SmartWeb software:

1.

First you should set System parameters[is8) such as device name and system time. These settings are not
relevant as regards measurement.

This step relates to the Signal inputsle. The system inputs are already available with a base configuration.
However, if you would like to connect additional inputs, for example, a speed sensor, you should configure it
now. The system must know the additional inputs in order to correctly interpret the incoming signal. Moreover,
you can only use existing input configurations for measurement jobs (see below).

In the third step, create measurement jobsl 74", Characteristic values are calculated via measurement jobs, which
give you information about the condition of the machine. A measurement job is already present for each
analogue input in the factory default setting of the SmartCheck or ProLink device, the Base configuration.
You can also edit and adapt this measurement job to your own needs. A configuration wizard is available both
for the creation and editing of measurement jobs.

For the SmartCheck device, in this step, you should also change the preconfigured "Machine is running”
measurement condition/103 to the requirements of your machine.

If you want to connect the outputsl e of the SmartCheck or ProLink device to your controller, you must define
here for the SmartCheck device whether a characteristic value or an alarm status is to be output at the output.
For the ProLink device, you must define which alarm status is to be output at the output.
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You can open the configuration overview from every configuration area. To do so, click on
g the Configuration overview = symbol in the top right.

In the expanded overview on the left, you will find all areas in which you can make settings:

¥

@

Input configurations/ e Here you can configure the analogue and digital inputs of the SmartCheck or
ProLink device and additionally create scaling factors.

Measurement jobs[7:": Here you can find an overview of your measurement jobs and the associated
characteristic value configurations. You can also create, edit or delete new measurement jobs here.
Different measurements are bundled in each measurement job, which are performed respectively at a
certain time or in a certain order.

Output configurations[e:™: Here you configure the analogue and the digital outputs of the system.

Measurement trigger(.of): Here you specify when measurements should be started. If a measurement
trigger is fuffiled, the current measurement is immediately interrupted and the measurement initiated by
this particular measurement trigger is started.

Measurement conditions[10d: Here you specify the conditions under which measurements are started.

Communication channels[103: Here you can create an email communication channell10, integrate
external controllers[118), configure the SmartCheck or ProLink device as an OPC UA server| 1) or configure
the PROFINET module[1s8) for connecting the ProLink device to a controller. The email communication
channel enables emails to be sent from the SmartCheck or ProLink device. Data from the integrated
controllers can be used in the SmartCheck or ProLink device or alarm statuses for characteristic values can
be transferred from the SmartCheck or ProLink device to these controllers. Other controllers can read out
process parameters of the SmartCheck or ProLink device via the OPC UA server communication channel or
provide the SmartCheck or ProLink device with additional process parameters via the OPC UA server inputs.
A controller can read data from the ProLink device connected to it and send process data to the ProLink
device via the PROFINET module.

Device[153: In this area, you can view and partly change the main settings of the SmartCheck or ProLink
device. This includes e.g. the device name and the system time.

Bearings( 158 Here you will find the bearing database, which you can expand yourself.

Bearing manufacturer[is1): Here you wil find a list of bearing manufacturers. You can add further
manufacturers to this list.

In each of these areas, under the Actions menu, you will find the item Create new

g measurement jobl%'ﬁ. This menu item starts a wizard, with which you create a
measurement job step by step. This task is also facilitated by virtue of measurement
templatesl &", which are already available in the SmartCheck or ProLink device. They are
automatically incorporated by the wizard and support the creation of specific measurements.

8.1 Module configuration (ProLink only)

Schaeffler ProLinkYou can connect a maximum of four vibration modules and a maximum of four I/O modules to the
processor module. Once you have properly put the system into operation, the modules are automatically created in

the SmartWeb software and displayed in the individual areas as separate levels. In the tree, select a module to view

details, change its name and identify its physical module. For I/O modules, you can also define the inputs and
outputs here:
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If you select a vibration module in the expanded overview, you will find the following in the main panel:
e Name: Here you will find the full name of the module.

In the SmartWeb software, the modules are sorted alphanumerically in ascending order. The module name
determines the sort order. This affects details such as the system information| 4 1in the Status area. To

change the sort order and map your physical system configuration, you must edit the module name using 7

« B Module identification: Click the symbol to identify the associated physical module. The LEDs of the physical
module in question flash alternately. Click again to exit identification mode.

e Below the name you will find more details about the module, such as the serial number, IP address or
temperature of the module.

e On the right, in the area highlighted in grey, you will find details on creating and changing the module.

o Click on #" to edit the name of the module[so".
You can also define the inputs and outputs of the I/O module[" via the same button.

« Click on B to open the configuration overview [

Here is how to edit the name of a module

1. Click on # to open the Edit module window:
Edit module ...

Schaeffler SmartWeb

MName :
Vibration module 1 (F4:30:80:12:00.4B)

OK Cancel

You can make the following changes here:

Name The module is listed under this name in the SmartWeb software. Due to the alphanumeric
sorting sequence, the name determines where a module is placed in the respective list. You
can change the display of details such as the system information[+in the Status area to
map your physical system configuration.
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2. Click on OK to save your changes.

This is how you define the inputs and outputs of an I/0 module

1. Clickon # to open the Edit module window:

Edit module ...

Name :
ProLink WO module (F4:30:80:16:00:0F)

Channel 1

* Analogue input -
Channel 2

* Analogue input -
Channel 3

* Analogue input -
Channel 4

* Analogue input -
Channel 5

* Analogue input -
Channel &

* Analogue input -
Channel 7

* Analogue input -
Channel &

* Analogue input -

CK Cancel

You can make the following changes here:

Name

Channel 1-8

The module is listed under this name in the SmartWeb software. Due to the alphanumeric
sorting sequence, the name determines where a module is placed in the respective list. You
can change the display of details such as the system information[x"in the Status area to
map your physical system configuration.

Select the required analogue or digital input or output for each channel of the I/O module.

You can then configure the inputs in the input configurations area and the outputs in the
output configurations area.

2. Click on OK to save your changes.

8.2 Input configurations

Depending on the system, you have the following options:

Schaeffler SmartCheck device: The device has a vibration and temperature sensorl &1, which supplies input
signals directly after commissioning. In addition, you can connect a total of three further external sensors via the
two analogue inputs[e2 and the digital input[es to the SmartCheck device and configure them here.

Schaeffler ProLink device: Once you have started the Schaeffler ProLink device, the inputs for the connected
vibration modules| ss" are automatically created and assigned to the modules. Four analogue inputsfe2" and two
digital inputsles are possible per vibration module. You can configure these inputs here.

In addition, eight analogue inputs are automatically created for each of the connected I/O modules. You can
configure these inputs here. Use the module configurationl e to switch these analogue inputs to digital inputs,
analogue outputs or digital outputs.

You can find details on how to connect the SmartCheck or ProLink device properly in the respective user
documentation.
Moreover, the SmartCheck or ProLink device is capable of creating fixed values[72". Here, for example, you can
specify a constant speed in order to ensure the correct calculation of the characteristic values.

In the expanded overview on the left, you will find all inputs of the SmartCheck device. For the ProLink device you
will find all connected modules and associated inputs here. You can see details on the input currently selected along
with possible editing functions in the main panel under Input configurations:
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Input configurations

Input channel : Vibratien sensor
Name : Vibration sensor
Input channel type : Vibration Source

Signal/sensor unit : g (Acceleration)
Sampling rate : 25,600 Hz

# Edit

Configuration

Connecied {o : SmariCheck 38 ® .
Legged in as : admin

Help v

=]

Changed : 2019-11-25 08:35:48

Created : 2019-11-25 08:35:48
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The information and functions you can access here depend on the selected input. Relevant details can be found in
the following sections.

8.2.1 Internal sensors (SmartCheck only)

In the factory default setting, the Schaeffler SmartCheck device has two internal sensors: a temperature sensor and
a vibration sensor. As soon as the system is properly commissioned, these two sensors supply signals and can be
incorporated into a Measurement job[ 74", In the Input configurations area, you can view and partly edit the
details on the corresponding inputs:

Schaeffler SmartWeb

File w Edit ¥ Measurementdata v Goto v

Configuration

Hame
— |8 Configuration
— =31 Input cenfigurations
¥l Vibration sensor
=3 System temperat
¥l Valtage - Analog
¥l Load - Analogue

3| Digital input {spe

31 Input with fixed v...

+ (2 Measurement jobs

+ #1 Output configurations
& Measurement trigger

+ & Measurement conditi
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Input configurations
Input channel : Temperature sensor
Name : System temperature sensor
Input channel type : Temperature Source

Signal/sensor unit : *C (Temperature)
Sampling rate : 1.0 Hz

' Edit

Connected to : SmartCheck 36 ® .
Logged in as : admin

Help »

B

Changed : 2019-11-25 08:35:48

Created : 2019-11-25 08:35:48
Changed by : admin

If you select the input of an internal sensor in the expanded overview, you will find the following in the main panel:

e The details on the selected input are shown on the left: Next to Input channel, you wil find the name of the
physical connection: next to Name, you will find the name you yourself gave this specific configuration.

e On the right, in the area highlighted in grey, you will find details on creating and changing the input.

o Ciickon # to edit the input configuration of the internal sensor.
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o Click on B to open the configuration overview 57

How to edit the input configuration of an internal sensor

1. Clickon # to open the Edit input configuration window:

Edit input configuration

Input channel :
Temperature sensor

MName :
Temperature sensor - Machine &
Unit :
c .
oK Cance
You can make the following changes here:
Name The input is listed under this name in the Input configurations area. Therefore, you should

choose a practical name which will enable you to distinguish between several inputs.

Unit Here you can change the unit of measurement for the sensor signal. By default, the unit of
the corresponding input configuration is selected here.

2. Click on OK to save your changes.

8.2.2 Analogue inputs

The SmartCheck device has two analogue inputs. Each vibration module of the ProLink device has four analogue
inputs, which you can use either as a vibration input or as an analogue input with other signal sources, such as
torque or temperature sensors. Each I/0 module of the ProLink device has up to eight analogue inputs that you can
configure flexibly

In the factory default settings, these are configured as follows:
SmartCheck device:
e Analogue 1 = Unit group: voltage

= Signal unit: V

= Input range: 0-10 V

e Analogue 2 = Unit group: load
= Signal unit: %
= Input range: 0-20 mA
= Scaling factor: 5

Vibration module of the ProLink device:
e Analogue 1-4 = Input type: Vibration input
= Unit group: acceleration
= Signal unit: g
= Sensor type: AC
= Sensor sensitivity [mV/g]: 100

I/0 module of the ProLink device:

e Analogue 1-8 = Unit group: voltage
= Signal unit: V
= Sample rate: 500 Hz
= Input type: 0-10 V

In the Input configurations area, you can view and partly edit the details on the corresponding inputs:
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If you select an analogue input in the expanded overview, you will find the following in the main panel:

The details on the selected input are shown on the left: next to Input channel you will find the name of the
physical connection; next to Name you will find the name that the system has automatically assigned (the ProLink
device only) or that you yourself gave this specific configuration.

Beside the details, you will find a diagram illustrating the details. The diagram is automatically adjusted when you
edit the input configuration.

The diagram does not appear for vibration inputs.

On the right, in the area highlighted in grey, you will find details on creating and changing the input.
Click on # to edit the input configuration of the analogue input/[es".

Click on to add additional scaling factors[e7" to the input; you can also access scaling factors e.g. when
creating measurement jobs[ 7M.

Click on = to open the configuration overview [s7".

How to edit an analogue input configuration

1.

2

In the expanded overview on the left, select the analogue input you would like to edit.

. Click on Edit # in the main panel to open the Edit input configuration window.

For the SmartCheck device, you wil see the following dialogue box:
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Edit input configuration

Schaeffler SmartWeb

Name :
Rotational speed - Revé

Unit group : Signal/sensor unit :
Frequency/speed - RPM -

Sampling rate :
1,280.0 Hz

Input type :
Oto 10V A

Max : RPM
10.0 125

Scaling : .
1.0

Min : 25
0.0

OK Cance

You have the following options:

Name

Unit group

Signal unit

Input type

Max, Scaling, Min

Here, specify the name that the input is to appear under in the SmartWeb
software.

Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Here, select the appropriate unit of measurement for your sensor.

Here, select the range of the voltage/current that applies for this input
configuration. The SmartCheck device supports the following ranges for the
analogue inputs:

e 0-10V

e 0-24V

e 4-20 mA

e 0-20 mA

Use these settings to determine the range within which the measurement values
should lie. First enter @ minimum value Min. Then enter a maximum value Max or
define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.
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For the vibration module you will see the following dialogue depending on the input type:

Edit input configuration

Name :
Temperature sensor 1 (F4:30:30:12:00:10)

Input type :
Analogue input

Unit group : Signal unit :
Temperature v C
Edit input configuration Voltage input :
Ofo 10V
Mame - Low-pass :
Vibration sensor 1 (F4:30:80:12:00:1D) 30Hz
Input type : Max [°C] : C
Vibration input 1000 1E3
Signal unit :
9 ;
Scaling [Vi°C] :
0.01
Sensor type :
\EFE « Invert
Sensor sensitivity [mvig] :
100.0 Min [*C] :
Min. bias voltage [V] : Max. bias voltage [V] : 0 :
5 15 v
0K Cancel OK Cancel

Input type: Vibration input Input type: Analogue input

You have the following options:

Name

Input type

Unit group

Signal unit

Sensor type
(vibration input only)

Sensor sensitivity
(vibration input only)

Min./max. Bias voltage
(vibration input only)

Voltage input
(analogue input only)

Low-pass
(analogue input only)

Here, specify the name that the input is to appear under in the SmartWeb
software.

Select the appropriate input type for the connected vibration sensor:

¢ Vibration input

¢ Analogue input

Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Here, select the appropriate unit of measurement for your sensor.

Select the appropriate sensor type for the connected vibration sensor:
L] Ac

e DC

o IEPE: Select this option for IEPE acceleration sensors.

Select the value specified on the calibration data sheet for the sensor.

Adjust this value for the IEPE acceleration sensor if necessary.

Here, select the range of the voltage/current that applies for this input
configuration. The ProLink device supports the following ranges for the analogue
inputs:

e OVtol0V
e -10Vtol10V

Select the value of the low-pass here.

on
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A 50 Hz low-pass is automatically applied, with which only relatively slow signals
g can be measured. If you use the analogue input for a measurement trigger or a

measurement condition, this low-pass is also connected in between. When

selecting the measurement length, you must therefore expect 128 samples per

second.
Max, Scaling, Min Use these settings to determine the range within which the measurement values
(analogue input only) should lie. First enter a minimum value Min. Then enter a maximum value Max or

define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.

Invert Activate this option to invert the scaling factor.

(analogue input only) Example: A combined vibration and temperature sensor delivers a value of 10 mv/°C. With

a voltage range from 0 V to 10 V, this yields a measuring range from 0 °C to 1000 °C. By
default, the scaling factor is set to °C/V. With Invert you can automatically change the
scaling factor to V/°C.

The following dialogue is displayed for the I/O0 module:

Edit module ...

Name :
ProLink WO module (F4:30:80:16:00:0F)

Channel 1:

* Analogue input -
Channel 2 :

* Analogue input -
Channel 3 -

* Analogue input -
Channel 4 :

* Analogue input -
Channel 5 -

* Analogue input -
Channel 6 :

* Analogue input -
Channel 7 :

* Analogue input -
Channel & :

* Analogue input -

CK Cancel

You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Unit group Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Signal unit Here, select the appropriate unit of measurement for your sensor.

Input type Here, select the range of the voltage/current that applies for this input
configuration. The I/O module supports the following ranges for the analogue
inputs:

e 0-10V
e 0-20 mA

e 4-20 mA



Configuration

Max, Scaling, Min Use these settings to determine the range within which the measurement values
should lie. First enter @ minimum value Min. Then enter a maximum value Max or
define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.

3. Click on OK to save your changes.

e If you want to edit an input that is already used by a measurement job, measurement
g condition or measurement trigger, you must first delete this associated configuration.

¢ You can also enter negative values for the Min and Max for an analogue speed input.
This enables you to distinguish between different directions of rotation.

¢ Analogue inputs that you create on the ProLink device can be added as an additional
characteristic value to a measurement job or used as an input for a measurement trigger,
a measurement condition or for channel monitoring. You cannot use these analogue
inputs directly for a vibration measurement job.

How to add a scaling factor to the input

You can add scaling factors to the analogue input, which you can access e.g. when creating a measurement job[ 767
. Using scaling factors, you can calculate logical values for other areas from the physical value measured at one area
of the component.

Example: With the analogue input, you measure the speed in front of the gear. The speed behind the gear
is 5 times smaller. You can create a scaling factor for this:

1. Speed in front of the gear

2. Speed behind the gear with a factor of 0.2 (1/5)

1. Click on ™ to open the Add scaling factor window:
Edit scaling factor

Schaeffler SmartWeb

Input channel :
Analogue input 1

Name :
Valtage
Scaling factor :
2.0

Unit :
RPM -
oK Cance

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the

unit of the corresponding input configuration is selected here.

2. Click on OK to save your changes. The new scaling factor appears in the diagram and in the list of scaling factors:
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3. To delete or edit the scaling factor, right-click to open the context menu and select the corresponding

command here:
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If you delete a scaling factor which is being used by a measurement job, the system gives

g

8.2.3 Digital input

you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

The digital input of the SmartCheck device or the two digital inputs of each Schaeffler ProLink vibration module are
configured as follows in the factory default setting:

Unit group: frequency/speed

Pulses per revolution: 1
Signal threshold: 7 V
Hysteresis: 2 V

g

SmartCheck device:

Signal unit: rpm (SmartCheck) or Hz (ProLink)

When selecting the dropping resistor, please note the impedance of the input signal of your
digital input. Note the maximum switching current of the digital switching output of the

Schaeffler SmartCheck device (1 A/30 V) and the power of the dropping resistor.
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With the Schaeffler ProLink I/O module you can create up to eight digital inputslss. They are created with the
following values, which cannot be changed:

e Unit group: no unit

¢ Signal unit: -

e Sample rate: 500 Hz

e Pulses per revolution: 1

e Signal threshold: 3 V

e Hysteresis: 0.5 V

In the Input configurations area, you can view and partly edit the details for the digital input:

N Connected to : SmartCheck 36
Schaeffler SmartWeb : 36 ®
Logged in as : admin

File ¥ Edit ¥ Measurementdaia ¥ Goto W Help ¥

Configuration
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— =l Input configurations
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3| Voltage - Analeqg...

21 Vitesse de rotatio
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4+ &=l Output configurations
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& Actions
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Input configurations

Input channel : Digital input

Name : Digital input (speed)

Input channel type : Speed Source

Signal/sensor unit - RP
Sampling rate
Signal limit [V]
Hysteresis [V]

Pulses per revolution :
Inverted : No

# Edit

Additional scaling factors

Speed x 3 [kHz]

3.0x

=]

Changed : 2019-11-25 08:35:48
Created : 2019-11-25 08:35:48
Changed by : admin

If you select the digital input in the expanded overview, you will find the following in the main panel:

The details on the selected input are shown on the left: next to Input channel, you will find the name of the
physical connection; next to Name, you will find the name that the ProLink device has automatically assigned or
that you yourself gave this specific configuration.

Beside the details, you will find a diagram illustrating the details.
On the right, in the area highlighted in grey, you will find details on creating and changing the input.

Click on #" to edit the input configuration of the digital input[eo.

Click on to add additional scaling factors[71" to the input; you can also access scaling factors e.g. when
creating measurement jobs[ 76",

click on B to open the configuration overview 57

How to edit a digital input configuration

1.
2.

:For the digital inputs of the ProLink device, you can only change the name and the setting
g for Inverted. If you need adjustable switching thresholds, you must use the speed input of
the Schaeffler ProLink vibration module.

Select the digital input in the expanded overview on the left.

In the main panel, click on Edit 7 to open the Edit input configuration window:
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Edit input configuration

Name :
Digital input (speed)

Unit group : Signal/sensor unit :
Frequency/speed - RPM -
Sampling rate :
1,280.0 Hz
Inverted

Pulses per revolution @
1

Signal limit [V] :
7.0

Hysteresis [V] :
20

5]

8]
[
[

CK Cancel

You have the following options:

Name

Unit group

Signal unit

Inverted
Signal type
(ProLink only)

Pulses per
revolution

Signal threshold

Hysteresis

Diagram

70

Here, specify the name that the input is to appear under in the SmartWeb software.

Here you have the choice between No unit and Frequency/speed. Select the option
No unit if you want the input to display a status such as "Machine on" or "Machine off".

Here you will only find a list box if you have selected Frequency/speed as the Unit
group.

Activate this option to invert the digital input signal.

Here you have the following options:
e Speed signal (excl. direction of rotation)
e A/B encoder (incl. direction of rotation)

This option is only available when Frequency/speed is selected as the Unit group.

Specify in volts the average input level, above or below which the digital input switches; in
the diagram, the Signal threshold is drawn in blue.

The specified value is rounded up/down to the nearest . 0 or . 5.

With Hysteresis, you specify in volts the range within which the input level is permitted
to drop below or rise above the Signal threshold without the digital input switching; in
the diagram, the Hysteresis is drawn in red.

The hysteresis should be set in every case, as otherwise the signal could generate
spurious pulses at the signal threshold. The poorer the signal, the higher you should set
the hysteresis.

The specified value is rounded up/down to the nearest . 0 or . 5.

Example: With a Signal threshold of 5 V and a Hysteresis of 2 V, the status of the digital input
remains unchanged between 4 Vand 6 V.

The diagram illustrates how the input reacts to your settings, in other words how the
system converts real input pulses e.g. between 0 V and 12 V into digital 0 and 1; with
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each change, the diagram is immediately updated. The diagram in the example is
interpreted as follows:

The input signal (orange) passes the hysteresis line (red) above the signal threshold
(blue). The signal output (black) reacts to this and jumps from 0 to 1. As soon as the
input signal undercuts the hysteresis line below the signal limit, the signal output reacts
again and jumps from 1 to 0.

Example: Your sensor delivers pulses between 0 Vand 12 V. In this case, set the signal threshold to
6 V and the hysteresis e.g. to 2 V.

3. Click on OK to save your changes.

How to add a scaling factor

You can add scaling factors to the digital input, which you can access e.g. when creating a measurement job/[ 6.
Using scaling factors, you can calculate logical values for other areas from the physical value measured at one area of
the component.

Example: With the digital input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:

1. Speed in front of the gear

2. Speed behind the gear with a factor of 0.2 (1/5)

1. Click on ™ to open the Add scaling factor window:
Add scaling factor

Schaeffler SmartWeb

Input channel :
Digital input
Name :

Scaling factor :
1.0

Unit :
kHz -
CK Cance

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default,

the unit of the corresponding input configuration is selected here.

2. Click on OK to save your changes. The new scaling factor appears in the list of scaling factors:
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Connected to : SmartCheck 36
Schaefller Smartweb : ®

Logged in as : admin

File ¥ Edit ¥ Measurementdata ¥ Goto v

Help v
Configuration Input configurations E
Name Input channel : Analogue input 2 Changed : 2019-12-19 00:35:17
— |B Configuration ~ Name : Vitesse de rotation RPM

Created : 2019-12-19 00:35:17
Changed by : admin

= =¥ Input configurations
P 9 Input channel type - Speed Source

Signal/sensor unit : RPM (Frequency/speed)
= System temperat... Sampling rate - 1,230.0 Hz =
Scaling factor : 5.0 RPM / mA

=¥ Vibratien sensor ...

=1 Voliage - Analog. .. Ofiset - 0.0 REM 50
= Vitesse de rotalio Input range : 0.0 mA - 20.0 mA 25 —
31 Digital input (spe Signal range : 0.0 RPM - 100.0 RPM ohem— —_—
o 5 10 15 20
= Input with fixed v. ma
+ (@ Measurement jobs # Edit
+ ¢ Oulput configuraions ) Additional scaling factors +
L taccocmon R | |o Vitesse de rofatio [kHz) 02x |
& Actions

Creale new measurement job

& Areas

& Stalus

3. To delete or edit the scaling factor, right-click to open the context menu and select the corresponding
command here:

Connected to : SmartCheck 36
Schaeffler Smartweb N ®

Logged in as : admin
File ¥ Edit ¥ Measurementdata ¥ Goto ¥

Help w
Configuration Input configurations [:=]
Name Input channel : Analogue input 2 Changed : 2019-12-19 00:35:17
- @ Configuration ~ Name : Vitesse de rotation RPM Created : 2019-12-19 00:35:17
125 Changed by : admin
= =3| Input configurations — ation
P 9 Input channel type : Speed Source - Il imss= de otation J
=l Vibralion sensor ... Signalisensor unit - RPM (Frequency/speed) M| Vit=sse de rotstio
=31 System temperal.... Sampling rate : 1,250.0 Hz =
Scaling factor : 5.0 RPM / mA =
= Voltage - Analog... Offset - 0.0 RPM
— Vitesse de rotatio Input range : 0.0 mA - 20.0 mA 25 —
o : o
31 Digital input (spe... Signal range : 0.0 RPM - 100.0 RPM ol
1] 5 10 15 20
= Input with fixed v.. ma
+ (& Measurement jobs # Edit
+ ¢ Dutput configurations Additional scaling factors +
PEE TN, f i e o \Vilesse dej /et
’ i
& Actions
Create new measurement job —  Delete
& Areas

&3 Status

If you delete a scaling factor which is being used by a measurement job, the system gives

s’ you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

8.2.4 Input with fixed value

In the SmartWeb software, you can create inputs with a fixed value, which you can access when creating
measurement jobs. An input with a fixed value can be useful, for example, if the machine to be monitored runs at a
constant speed. In this case, you do not have to connect a sensor; rather you can specify the speed via the fixed

value. In the factory default setting, the SmartCheck or ProLink device has one input with a fixed value, which is
configured as follows:

e Name: Fixed speed
e Value: 3000
e Unit: RPM

In the Input configurations area, you can view and edit the details for the fixed values:
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Connected fo | SmartCheck 38
Schaeffler SmartWeb - ® .

Legged in as : admin

File ¥ Edit ¥ Measurementdata ¥ Gato W

Help ¥

Configuration Input configurations =]

Name Input with fixed value :
— |B Configuration
— =l Input configurations Name Value Unit
31 Vibration sensor . Fixed speed (3000 RPM) 3,000.0 [RPM]
»| System temperat..
#| Rotational speed ... N
# Edit Delete + Add
*| Load - Analogue
| Digital input (spe...
=31 Input with fixed v...
+ (8 Measurement jobs
4«1 Quiput configurations
& Measurement trigger
+ .« Measurement conditi....
4 «* Communicafion chan
You have the following options:
e Click on Edit # to edit the selected input with a fixed value.
¢ Click on Delete to delete the selected input with a fixed value.
e Click on Add ™ to add another input with a fixed value.
e Click on M to open the configuration overview [s7".
How to add a new input with a fixed value
1. Click on ™ to open the window Add fixed value:
Add fixed value
Input channel :
Input with fixed valus
MName :
Continuous velocity
Value :
25.0
Unit group : Unit :
Belt spead - m's -
oK Cance

You have the following options:

Name The input with a fixed value is listed under this name, along with the other inputs.
Therefore, you should choose a practical name that will enable you to distinguish between
the inputs.

Value Here you specify the fixed value.

Unit group Here you specify which unit group the fixed value belongs to, e.g. Torque, Pressure,
Speed or Force.

Unit Here you can specify the unit of measurement for the fixed value. The selection options

correspond to the selected unit group.

2. Click on OK to save your changes. The new input with a fixed value appears in the table:
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Connected to : SmartCheck 36
g g WV
Schaeffler Smartieb e ©

File w Edit ¥ Measurementdata ¥ Goto W Help v
Configuration Input configurations =]

Name Input with fixed value :
— |8 Cenfiguration ~

— —3| Input configurations Name Value Unit

#| Vibration sensor ... I Constant velocity 25.0 [mfs] ’\I
»| System temperat... Fixed speed (3000 RPM) 3,000.0 [RPM] v

»| Voltage - Analog...
# Edit Delste + Add
»l Vitesse de rotatio

# Digital input (spe
# Input with fixed v.
+ (¥ Measurement jobs

4 ¢ Output configurafions
Mannimnmsan frinmor

& Actions
Creale new measurement job

& Areas

& Status

3. To Delete or Edit # the input with a fixed value, select the entry in the table and then choose the
corresponding command.

8.3 Measurement jobs

To enable the Schaeffler SmartCheck or ProLink vibration monitoring system to monitor your machine and trigger
alarms if appropriate, the incoming signals must be measured and characteristic values calculated. The corresponding
instructions are located in what are known as measurement jobs, which you can create using the SmartWeb
software.

The SmartCheck or ProLink device is distinguished by the support the system gives you in the creation of these
measurement jobs and especially in the calculation rules for characteristic values: You create measurement jobs
exclusively with the aid of the Configuration wizard[ 76", In the very first step of the wizard, you select a
template[ s that is suitable for your machine. According to the template you selected, e.g. the Gear stage
template for the monitoring of two gears, the SmartCheck or ProLink device then automatically generates the
appropriate characteristic values. In addition, a superordinate alarm characteristic value is generated for each
measurement job, which summarises the alarm status of all characteristic values.

You cannot edit the characteristic values the SmartCheck or ProLink device generates; you can only view them in
the corresponding overview in the SmartWeb software. However, you specify a series of framework conditions for
the measurement job in the configuration wizard, e.g. triggers or conditions[s", the dependency of an alarm on
additional signals, or the activation of the learning mode.

Selection of the right template and correct entries in the configuration wizard is a key factor in enabling your system
to perform the monitoring as required. Consequently, the following sections are to support you in these work steps.
You will find here:

e The detailed description of the Measurement jobs[ 72 area.

« An overview of the Steps in the configuration wizard[ 761 that you follow to create a measurement job. This
section contains a summary of each step and any additional information further to the info texts in the
configuration wizard.

« An Overview of the templates[ s available to you when creating a measurement job.

« Detailed explanations of the Learning mode[s/ and Alarm mapsles®, two special functionalities that the
SmartCheck or ProLink device provides you for monitoring. Both are activated from the configuration wizard.

8.3.1 Measurement jobs area

In the Measurement jobs area, you will find an overview of all measurement jobs you have created for the

SmartCheck or ProLink device. Each measurement job includes the following components:

¢ Measurement configurations: These determine the inputs at which measurements are made and how these
measurements are performed.

¢ Characteristic value configurations: These values are calculated automatically from measurement signals
according to internal templates.

 Optional component: Triggers or conditions[s" can be added to the measurement job in order to control the
execution of measurements.
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You can view and partly edit all of these components and their details in the Measurement jobs area. In the
factory default setting of the SmartCheck device or for each ProLink vibration sensor, the base configuration is
created:

Connected to | SmartCheck 38
Schaeffler Smartweb - ® .

Legged in as : admin

File ¥ Edit ¥ Measurementdata ¥ Goto w7 Help w
Configuration Measurement job (=]
Name Mame : Base measurement job Changed : 2019-11-25 05:36:24
— B Configuration Created ; 2019-11-25 08:36:24
Measurement condition : Machine is running Changed by : admin
4 =31 Input cenfigurations
— (8 Measurement jobs
(& Base measurem... 7 Eat Delete 1 Create
4 4= Qutput configurations
& Measurement trigger & Characteristic value configuration

+ & Measurement conditi...
& Mea - Base measur Name: -

System temperature

=% Communication chan..

150 10816-1 (:
+ [=] Device . Unit: Measurement template used:
— Peak2peak - *C (Temperature) Base configuration
(2) Bearings =S A
) w st h Save settings: Characteristic value type:
wel Bearing manufacturer =S . every 1 hour(s)
) RMS broad band - D... ¥ L
System temperature ! Reset alarms: Alarm limit overruns: Use learning mode:
Automatically 10 Mo
Main alarm: Pre-alarm:
700°C 525°C

Lower pre-alarm:
0.0°C

A& Actions Y )
& Measurement configuration
Create new measurement job
System temperature sensor Name:

& Areas . System temperature sensor
Vibration sensor - Acceleration 1 .
Input signal: Unit:
& Status Wibration sensor - Demodulation System temperature G (Temperature)
sensor
Vibration sensor - Velocity 1 kHz |
" Measurement data o ’ - Signal type: Input filter: Output filter:
Raw signal - 1Hz (Low-pass)
Al Live view Spectral lines: Window type:
1,600 Hann {Hanning)
lE Configuration Save settings for time
signals:
every 1 day(s)

a2 User management

L') Leg out

Complete

In the expanded overview on the left, you will find all measurement jobs for the SmartCheck or ProLink device. Click

on a measurement job to access the following information and functions in the main panel:

e Under Measurement jobs, you will see the name of the measurement job as well as any details such as triggers
or conditions used. You will also find a grey box with change details and the Edit, Duplicate, Delete and Create
buttons here.

¢ Under Characteristic value configuration you will see the individual characteristic values that belong to the
selected measurement job. If you click on one of the values, the details about it are displayed on the right. These
details partly correspond to your own settings, which you made when creating the measurement jobl77; the rest
are added automatically by the wizard from system templates.

¢ Under Measurement configuration you will see the measurements that belong to this measurement job. If you
click on one of the values, the details about it are displayed on the right. These details partly correspond to your
own settings, which you made when creating the measurement jobl 767; the rest are added automatically by the
wizard from system templates.

Under Characteristic value configuration, the characteristic values that belong to the selected measurement
are also automatically highlighted in bold.

e You can edit the selected measurement job[ 761,

e You can duplicate the selected measurement job. To do this, click Duplicate. The configuration wizard opens
with a copy of the selected measurement job. You must give this copy a new name. All other parameters that
have been transferred from the existing measurement job can be edited as usuall 76",

e You can add new measurement jobs 76"
e You can delete the selected measurement job. To do so, click Delete and confirm with OK.

« In the top right corner, click on B to open the Configuration overview [,
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¢ You can find the menu item Create new measurement job in most work areas of the
g SmartWeb software on the left under Actions, which means that you are always able to
access this main system task.
e If a characteristic value of a measurement job is used for the alarm status configuration of

a controller[118), you cannot edit or delete this measurement job. An exception is an input
with a fixed value.

8.3.2 Creating/editing new measurement jobs

The configuration wizard opens when you want to create, duplicate or edit a measurement job. This guides you
step by step through the creation process. Here you only need to specify a few details, as the complex calculations
of the characteristic values of a component are executed inside the system using the relevant templatesl so™.

To be able to use input signals for the monitoring, you must create the corresponding input
g configuration[ el before you start the wizard.

The configuration wizard consists of several steps, which are displayed in the left margin right from the start. How
many steps you need to go through depends on which component template you choose and whether you activate
the Expert settings:

Configuration wizard

Schaefiler SmartWeb

Steps Step: Select component

1: Select component
Component template :

2; Specify details for gear stage Gear stage (outdated) - 9
3: Apply expert settings Description :

Component template for gear stages
4: Apply learning mode settings

5. Save settings/measurement .
triggers and conditicns Confidential e
§: Additional signals

7: Set alarms

Description

Select a component template. The
next steps in the wizard will be
generated automatically depending
on the template selected.

« Expert seffings Mext Cance

The wizard queries additional information in the individual steps. Generally, the entries you
g need to or can make are already explained in the wizard. Simply move the mouse over the

question mark @ 1o read the explanation.
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In the following sections, you will find a summary of each individual step along with additional information that goes
beyond the basic Help.

Select component

Here you choose the component you want to monitor from the predefined list. The system template[ s that is
used to create the measurement configuration depends on your selection here.

If you turn on the Expert settings, you can select the Confidential option. This means that the measurement
job remains visible in the user interface and the measurements run as usual. However, the alarm limits and frequency
bands of confidential measurement jobs are only visble for users with special rights[is4l. No other users can view or
edit the details of the measurement job. This restriction applies not only to the measurement job area but also to
the display of frequency bands in the live view and measurement data areas.

In some measurement jobs, it is necessary to be able to edit the speed channel. Users
iy without special rights cannot do this for a confidential measurement job. In such a case,
E,# assign the Edit speed channell1sd) right. Users with this right cannot see the details of the
measurement job, but can edit the speed channel.

Specify details about the component

Here you make detailed specifications about the selected component. Make these specifications depending on the
component, e.g. the maximum speed, the type of installation, or the number of blades or vanes. This is also where
you determine the input signals on which the monitoring is to be based. If you are monitoring a machine on which
the rotational speed can fluctuate during a measurement, you can activate and set the order analysisl ss. This
reduces the influence of speed fluctuations during a measurement on the monitoring result. Order analysis is possible
in all measurement tasks with multiple frequency windows.

If the component is a bearing, you can select the bearing type straight from the system bearing database in this
step. If it is not in the database, you can create it using the wizard.

In this step, many templates require a Speed signal as well as the Maximum speed. For
Ly the speed signal, a characteristic value is automatically created. The alarm limits for this value
E,# depend on the specified Maximum speed. While the other characteristic values created by
the wizard are listed in the last step in an overview, this characteristic value remains in the
background. Consequently, you can neither change its alarm limit nor activate the Learning
mode[ s for it.

The system default alarm limit, which uses this characteristic value, is calculated as follows:
¢ Pre-alarm: 1% above the specified maximum speed
e Main alarm: 5% above the specified maximum speed

Apply expert settings/Apply expert settings for the Wellhausen counter

These steps only become visible if you activate the Expert settings option on the bottom left of the wizard.
Furthermore, the step Apply expert settings for the Wellhausen counter is only available for the default
configuration. In both steps, you have the option of adjusting some preset values of the template for your
specific measurement job, e.g. specifying the number of spectral lines or the high-pass for the demodulation.

You should only edit this step if you possess expert knowledge.

The value that you specify for Number of spectral lines affects the length of the recorded
Ly signals. All vibration measurements are based on this value. As such, the duration of the
l:i various measurements may vary. The duration of the longest vibration measurement
determines the measurement duration for all other additional measurements:

Measuring time for vibration time signals [s] = number of lines / low-pass

Additional channels record the number of values required for the longest vibration
measurement up to a maximum of 100,000 values. For an analogue input, for example, this
corresponds to a measuring period of approx. 78 s.

Apply learning mode settings

This step is only visible if you activate the Expert settings option on the bottom left of the wizard. Here you can
specify the algorithm used by the learning mode to calculate the alarm limits and the factors used to determine the
main alarm and pre-alarm.
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If you select the Learning mode type, you should note the following:

g o Standard deviation: This process takes into account when signals vary or are not very
stable, i.e. when the value for sigma, the signal variance, is high.

e Maximum values: This selection is preset and is the better method in most cases. You
can select this method when the vibration values are very stable, i.e. when the value for
sigma, the signal variance, is low.

You should only edit this step if you possess expert knowledge.

Save settings/triggers and conditions

Here you specify how often trends and time signals should be saved. In addition, you can determine whether the
measurements should depend on Measurement triggers[iol), Time triggers, Measurement conditionsl104 or Time
conditions.

If you have not yet created any measurement triggers or measurement conditions or the existing ones do not meet
your requirements, you can create them using the wizard. You can only create time triggers and time conditions
within the wizard. You can find information on this in the Triggers and conditions[s" section.

Additional signals

Here you can add additional input signals to the measurement configuration. This adds further trends to the
characteristic value trends, which are generated automatically by the template.

The automatically created characteristic values of the additional signals can be retrieved in
iy the characteristic value overview in the last step of the configuration wizard. There you can
E,# also change the alarm limits of these characteristic values.

Typically, it is not necessary to activate the Learning mode[s" for the additional signals; if
you do want to authorise it, you can do so in the last step of the wizard.

Resetting/setting alarms

In this step, you specify:

o Whether alarms are to be reset automatically or manually, i.e. via the Context menulao", for example.

¢ Whether and for which characteristic values the learning mode should always be authorised.

o Whether the learning mode calculates alarm limits contingent on measured machine parameters (alarm map/leso™).

e Where the limits for the main alarm and pre-alarm lie: You can specify this for all characteristic values together or
for each individual characteristic value.

e For symmetrical signals with a negative value range: where the thresholds for the lower main alarm and pre-alarm
lie; these options are only used for additional signals.

e How the alarms are reset: You can specify this for all characteristic values together or for each individual
characteristic value.

If Expert settings are activated, you can also set the number of times an alarm limit must be exceeded or
undershot before it changes the alarm status.
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If you activate the option Change alarm limits in line with other signals, you also must
authorise the learning mode; otherwise, the option has no effect.

You should not use the learning mode when the measurement range is known, e.g. for
temperature, pressure or load.

For characteristic values based on ISO, the limits of machine class II are preset for the alarm
limits. Learning mode is activated by default and can therefore overwrite the alarm limits
based on ISO, if applicable:

Alarm settings

The same alarm settings for all characteristic values with the same unit 0
# Alamm setfings for each individual characteristic value
1. Alarm settings for "15010816-1 (2Hz - 1kHz) - Velocity" ~
Machine class (150 10818) (7]
Main alarm : | 7.1 mmy's Pre-alarm : | 2.8 mm's
Lower pre-alarm ;| 0.0 mm's 9
«" Use learning mode

2. Alarm settings for "RMS broad band - Acceleration (Overall status)”
Main alarm ;| 1.0 g Pre-alarm ;| 0.7 g
Lower pre-alarm ;| 0.0 g 9

«" Use learning mode

Here you have the following options:

¢ Click Machine class (ISO 10816). A context menu is displayed, from which you can
select the required alarm limits.

e You can manually set alarm limits that deviate from the ISO recommendations.
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8.3.3 Available templates for measurement configurations

In the first step of the configuration wizard, you need to choose a template that will be used to create the
measurement job for monitoring your machine. The following list gives a rough overview of which template is most
suitable for which machine/monitoring scenario:

Basic configuration:Use the template for broad-band measurement. It can be used for all machines, but only
offers a very general monitoring.

User-defined frequency bands: Use this template to define user-defined frequency bands, where a separate
characteristic value is created for each one. You should only use this template if you possess expert knowledge.

Gear stage (optimized): Use this template for continuous monitoring of two gears. This template is an
improved version of the previous Gear stage template (now Gear stage (obsolete)). In contrast to the
obsolete version, it enables better alarms for the various damage types (distributed damage or local damage). It
also triggers alarms on gears whose sidebands increase in the case of damage, while the gear meshes decrease.
Gear stage (obsolete): Use this template for the monitoring of two gears. This template is only still available
for use with existing measurements for compatibility reasons. For new gear monitoring tasks, we recommend
that you use the Gear stage (optimized) template.

Journal bearing: Use this template for the monitoring of a bearing with oil film.

Channel monitoring: This template lets you continuously monitor up to three channels (similar to the
condition guard), resulting in a faster response to changes.

Coupling: Use this template for the monitoring of a jaw coupling.
Fan: Use this template for the monitoring of fan blades.

Managed frequency bands: Use this template to define managed frequency bands, where a separate
characteristic value is created for each one. Speed-coupled frequency bands are shifted depending on a speed
signal. The frequencies are not entered in Hz, but instead are standardised according to the speed.

You should only use this template if you have the relevant expert knowledge.

Example:
You use the rotational frequency to identify an imbalance. To do this, create a window of 0.95 and 1.05.
At a speed of 50 Hz, the device dynamically adapts the frequency band:
(50 Hz * 0.95 =) 47.5 Hz to (50 Hz * 1.05 =) 52.5 Hz
Process signal monitoring: This template allows you to monitor process signals from up to eight input
channels simultaneously.
With the exception of vibration inputs, you can select all channels for monitoring: channels physically present in
the system, external channels and channels transmitted via OPC/UA or SLMP.
You cannot monitor vibration signals with this template.
Pump: Use this template for the monitoring of pump vanes.
Belt drive: Use this template for the monitoring of a belt level.

Default configuration: Use this template for broad-band measurement with several fiters. It can be used for
all machines, but only offers a very general monitoring.

Shaft: Use this template for the monitoring of a shaft.
Roller bearing: Use this template for the monitoring of a roller bearing.

Condition guard: Use this special template for the constant monitoring of a machine pursuant to the standard
ISO 10816-1.

Some of the measurement templates listed here can only be used with an additional licence.
li# For an overview of your current licences, select Open licence manager{1s" from the Help
menu.

8.3.4 Triggers and conditions

The SmartCheck or ProLink device generally works through the measurement jobs in a fixed order. You can use
triggers and conditions to interrupt this order. In the Memory settings/measurement triggers and conditions
step, you can create or edit triggers and conditions:
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Edit configuration

Schaeffler SmartWeb

Steps Step: Save settings/measzurement triggers and conditions

1. Select component .
Save settings for trends :

2: Specify detaills for base
configuration 1 hour(s) - 9
3; Apply expert settings

Save settings for time signals :

1 day(s) v 9

4: Apply learning mode settings

5: Save settings/measurement
triggers and conditions

6. Additiznal signals Measurement triggers and conditions :
7. Set alarms + Time trigger + Meas. trigger 0

Time condition + Meas. conditions

Description

This is where you specify the
frequency at which trend values
and time signals are saved. You
can also determine conditions that
must be met for this measurement
and friggers that launch this
measurament.

+" Expert seffings Back MNext Cance

You can create the following triggers and conditions here:
o Time trigger/ s

 Meas. trigger(s"

« Time condition[ s

o Measurement condition[ss"

Relevant details can be found in the following sections.

e You can also create and edit measurement triggers and measurement conditions without
g the wizard in the Measurement trigger(1ol) and Measurement conditions[o) areas.
You can then select the triggers and conditions created there from a list in the wizard.

e You cannot use measurement triggers and measurement conditions for output
configurations.

e For each measurement trigger and each measurement condition, a characteristic value is
created. This characteristic value can be found in the overview under the measurement
job Measurement triggers and conditions.

The corresponding characteristic values are also saved only if a trigger or condition is used
by at least one measurement task. When creating the trigger or the condition, determine
the saving interval. In addition, characteristic values are always stored if the status
changes, for example, if the condition changes from valid to invalid or a trigger is initiated.
You can use the trends for these characteristic values to check whether measurement
triggers and measurement conditions on the real machine behave as you expect. You can
therefore check whether a measurement trigger is also actually triggered, or whether a
measurement condition is correctly enabled or disabled.

The diagram below provides an overview of the interaction and prioritisation of conditions and triggers:
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Measurement pending. Trigger executes.

Different triggers are:
- independent of one anather
- equal in priority

Verification
Verification

Are all measurement conditions met?
Is at least one time condition met?

- =

Under the following circumstances, a measurement initiated by triggers is not started:
B/ o If the conditions are not fulfiled at the time of the trigger.
¢ A measurement initiated by a trigger is already running.

8.3.4.1 Time trigger
A time trigger allows you to specify that the measurement will take place regularly at an interval defined by you,

e.g. every 5 minutes. You can only create one time trigger for each measurement job.
How to create a time trigger

1. Click the * Time trigger button.
2. Enter the desired specifications under Time trigger:
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Step: Save settings/measzurement triggers and conditions

Save settings for trends :

1 hour(s) v 9
Save settings for time signals :

1 day(s) - 9
Measurement triggers and conditions :

+ Meas. trigger 9
+ Time condifien + Meas. conditions
Time trigger :
Measurement interval: every 1 minute(s) « Actions: 9
Start of measuring: Dec || 11 - 2019 -
22:30

You have the following options:

Measurement interval:  Use this specification to determine the measurement interval, i.e. the time after
every which the measurement is to be repeated. You can specify an interval in Minutes,
Hours or Days.

Start of measuring Here you specify the day and time when the measurements are to start. Here you
have the following options:
e You can either select the start date from the list boxes or set it directly via the
calendar .
e Enter the start time in the field next to HH:MM.

— Click Delete to remove this time trigger.

9 Move the mouse over the question mark @ to read additional information.

Time triggers ignore the shift that results from the change from summer to winter time.

g Example:

e In winter, you create a time trigger with Start of measuring 14:00. In summer, the
start of measuring will not be until 15:00.

e In summer, you create a time trigger with Start of measuring 14:00. In winter, the
start of measuring will be at 13:00.

8.3.4.2 Measurement trigger

You can use a measurement trigger to interrupt the order of measurements. If the trigger condition you have
defined is fulfiled, the current measurement is cancelled and the measurement controlled by the measurement
trigger is started.

How to create a measurement trigger

1. Click the ™ Measurement trigger button.
2. Enter the desired specifications under Measurement trigger:
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Step: Save settings/imeasurement triggers and conditions

Save settings for trends :

1 hour(s)

Save settings for time signals :

1 day(s)

Measurement triggers and conditions :

Time trigger

Time condifien

- @
- @
Meas. trigger 9

Meas. conditions

Measurement trigger :

Measurement trigger 1: Actions:
Measurement trigger 1 - } 9

You have the following
options:

Measurement trigger
(list box)

4

W

8.3.4.3 Time condition

This list contains the measurement triggers that you have previously created in the
Measurement trigger( ) area. Select the required measurement trigger from
here.

If you cannot find a suitable measurement trigger in the list box, click ™ to create
a new measurement trigger. The Add measurement trigger dialogue opens and
you can enter the desired specifications here. You can find details on this in the
Adding/editing measurement trigger(:2) section.

Click Delete to remove this measurement trigger.

Move the mouse over the question mark @ to read additional information.

You can use a time condition to ensure that measurements are only performed at a certain time.

How to create a time condition

1. Click the ™ Time condition button.
2. Enter the desired specifications under Time condition:



Edit configuration

Schaeffler SmartWeb

Steps

1: Select component

2: Specify detaills for base
configuration

3: Apply expert settings
4: Apply learning mode settings

5: Save settings/measurement
triggers and conditions

§. Additional signals

7: Set alarms

Description

This is where you specify the
frequency at which trend values
and time signals are saved. You

can also determine conditions that
must be met for this measurement

and friggers that launch this
measurament.

+" Expert seffings

Configuration

Step: Save settings/measzurement triggers and conditions

Save settings for trends :

1 hour(s) - 9

Save settings for time signals :

1 day(s) v 9

Measurement triggers and conditions :

Time trigger

Meas. trigger 0

+ Time condition Meas. conditions

Time condition :
Mon.  Tue. Wed. Thur. Fri Sat. sun. Actions:
v v v v v 9
From:| #:00 To:| 17:0
Back Next Cance

You have the following options:

Mon.-Sun.

From ... To ...

Activate here the days on which measurements are to start.

Enter here the times between which the measurements are to take place.

The time range that you specify here can also run from one day into the next.
Example: You have activated Mon and Tues and enter the following as the time range:
From: 17:00 To: 8:00
The time range for measurements then begins on Monday at 17:00 and ends Tuesday morning

at 8:00. After a break, measurements will resume at Tuesday 17:00 and continue until
Wednesday at 8:00.

Click Delete to remove this time condition.

Move the mouse over the question mark @ to read additional information.

e If multiple time conditions are defined for a single measurement job, only one condition
g needs to be met for the measurement to be performed.

e Time conditions ignore the shift that results from the change from summer to winter time.
Example:

o In winter, you create a time condition for the period from 14:00 to 16:00. In

summer, the time period shifts to 15:00 to 17:00.

o In summer, you create a time condition for the period from 14:00 to 16:00. In

winter, the time period shifts to 13:00 to 15:00.
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8.3.4.4 Measurement condition

In a similar way to the time condition, the condition you define here must be met in order for a pending
measurement to take place. If a measurement is pending but the measurement condition you defined is not met,
the device skips this measurement and goes straight to the next one.

How to create a measurement condition

1. Click the ™ Measurement condition button.
2. Enter the desired specifications under Measurement condition:

Step: Save settings/measurement triggers and conditions

Save settings for trends :

1 hour(s) - 9
Save settings for time signals :
1 day(s) - 9
Measurement triggers and conditions :
+ Time trigger + Meas. trigger 0
+ Time condificn + Meas. conditions

Measurement condition :

Measurement condition 1 : Actions:
Machine is running - 3 9

You have the following options:

Measurement condition This list contains the measurement conditions that you have previously created in

(list box) the Measurement conditions[i4) area. The default selection is the Machine is
running measurement condition as preconfigured on the device. This can be
deleted on a ProLink device, but not on a SmartCheck or ProLink device.

Select the required measurement condition from here.

-+ If you cannot find a suitable measurement condition in the list box, clck ™ to
create a new measurement condition. The Add measurement condition
dialogue opens and you can enter the desired specifications here. You can find
details on this in the Adding/editing measurement conditions[03) section.

- Click Delete to remove this measurement condition.

9 Move the mouse over the question mark © to read additional information.

If multiple measurement conditions are defined for a single measurement job, all conditions
g must be met for the measurement to be performed.

8.3.5 Setting order analysis

In many measurement configuration templates, step 2 of the wizard determines the input signals on which
monitoring is based. If the monitoring is based on a measured speed signal and the speed is measured from the
digital input of a vibration module, you can activate and set an order analysis. This reduces the influence of speed
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fluctuations on the monitoring result. The order analysis converts the vibration signal into a signal where the
influence of speed fluctuations during the measurement is reduced. You can activate this option on machines that
have a very dynamic rotational speed, such as wind energy plants or lifts.

Proceed as follows to use and set the function:

1. In step 2 of the wizard, under Speed signal, select the desired speed input.

Order analysis requires a high-resolution speed signal. For this reason, you must select a digital speed input of a
vibration module so that you can activate and edit the Order analysis option.

2. Activate the Order analysis option. The Pulses per revolution list box appears:

Edit configuration

Steps

1: Select component

2: Specify details for roller
bearing

3 Apply expert seftings
4: Apply leaming mode seitings

5: Save settings/measurement
triggers and condificns

6: Additional signals

T: Set alarms

Description

Enter information on the roller
bearing and measurement signals.

+"  Expert seftings

3. From the list, select how many Pulses per revolution you want to evaluate.

Step: Specify details for roller bearing

Mame of roller bearing :
Bearing 6202

Bearing type :

6202 (FAG) Q,

Standing bearing race :
(®) Quter race
() Inner race

Vibration signal :
& Vibration sensor 1 (F4:3D:80:12:01:61)

Speed signal :
& Speedinput 1 (F4:3D:80:12:01:61) v

Maximum speed [0.1 - 100 Hz] :
40

+" Maximum speed deviation (+/-) 5 %

+" Order analysis Pulses per revelution : | 1

Back

® ®

Mext Cancel

For this setting, you need to know how the pulses are distributed across the rotation, i.e. evenly or unevenly.
The order analysis depends on the pulses per revolution being as regular as possible. If the pulses are irregular—
i.e. the angle between two pulses is not always the same—it may be useful to ignore some of the pulses per
revolution. The Pulses per revolution setting allows you to reduce the pulse count used for the calculation.
This does not change the rotational speed value.

The Pulses per revolution list box only appears if the Pulses per revolution value is set

Ej to between 2 and 32 in the digital input configuration.

If the value is higher than 32, the vibration module reduces the pulses per revolution. This
is done for performance limitation reasons. In this case, the Pulses per revolution list
box is not present in step 2 of the wizard.

4. Click Next, make additional settings in the other steps, if necessary, and exit the wizard with OK.

8.3.6 Learning mode and alarm maps

When you create a measurement job, the relevant characteristic values are automatically generated. The default
alarm limits of the SmartCheck or ProLink device initially apply to these characteristic values. If you activate the
learning mode in the Set alarms step of the configuration wizard and then start learning mode, the SmartCheck or
ProLink device starts to evaluate the measurement values of the relevant characteristic values for alarm limits, which
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are adapted to your machine. When the learning mode is completed, the default alarm limits are replaced by the
newly calculated alarm limits.

Essentially, the learning mode can be run in two different scenarios, in the simple Default settinglss™ or with an
Alarm mapl&", i.e. dependent on one or two other signals (machine parameters). These scenarios are described in
detail in the following sections. In further sections, you will be given important information on using the learning
mode[ 27 and how to proceed during the initial setupl e of the SmartCheck or ProLink device.

Scenario 1: Learning mode in default setting

When you create a measurement job - in this example, the pre-configured Base configuration - the learning mode
is already activated in the Set alarms step for all vibration characteristic values:

Edit configuration

Schaeffler SmartWeb

Steps Step: Set alarms

1. 3elect component . -
Variable alarm limits :

2: Specify details for base Change alarm limits in line with other signals

configuration 9
3: Save settings/measurement
triggers and conditicns

4: Additional signals Reset alarms :

& Automatically Manually
5: Set alarms o ! ’ 9

Alarm settings @
The same alarm settings for all characteristic values with the same unit 9

® Alarm seffings for each individual characteristic valus

1. Alarm zettings for "1S010816-1 (2Hz - 1kHz) - Velocity" ~
Description Machine class (IS0 10818) 9
This is where you specify alarm Main alarm ;| 7.1 mmv's Pre-alarm ; | 2.8 mmv's
limits and determine whether they N ) ’
depend on other signals. You can Lower pre-alarm : | 0.0 mn's 9
dlso determine how alarms are .
reset +* Use learning mode
2, Alarm settings for "RMS broad band - Acceleration {Overall status)"
Main alarm ;| 1.0 g Pre-alarm ;| 0.7 g
Lower pre-alarm ;| 0.0 g 9
+" Use learning mode
w
Expert settings Back oK Cance

When you complete the wizard with OK, you can then start learning mode for all characteristic values for which the

learning mode was activated. You have the following options:

e Press the TEACH key on the SmartCheck or ProLink device to start learning mode for all characteristic values for
which the learning mode was activated.

e In the SmartWeb software, open the context menu for a characteristic value. Use the Start learning mode
command to start learning mode for the selected characteristic value.

e In the SmartWeb software, open the context menu for a measurement job. Use the Start learning mode for
all command to start learning mode for all characteristic values for the selected measurement job.

The learning process then looks like this:

e The Schaeffler SmartCheck or ProLink device records 1000 measurement values; here each measurement
performed is saved in the trend - independently of the memory cycle of the trend that you specified in the Save

settings/triggers and conditions step. The speed of this process can depend on your triggers and
conditions[ sd.
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e The default of 1000 measured values can be changed in the configuration wizard. To do
g so, activate the Expert settings option. The Apply learning mode settings step
appears, in which you can change the number of values.

e Learning mode is deactivated by default for characteristic values 1IS010816-1 (2 Hzto 1
kHz) - velocity and 1IS010816-1 (10 Hz to 1 kHz) - velocity.

As soon as the SmartCheck or ProLink device has saved 1000 measurement values in the trend, a new alarm limit
for the relevant characteristic value is calculated on this basis; here the SmartCheck or ProLink device uses the
Maximum values as an algorithm. In the Apply learning mode settings[-7" step of the wizard, you can
change/adapt this procedure.

When the learning mode for a characteristic value is completed, a corresponding message appears in the
logbook[ 22, which also contains the newly calculated alarm limits. You can view the alarm limits in the trend in the
Measurement datal 4 area as well.

Once learning is complete, learning mode for this characteristic value is automatically deactivated in the
measurement job. If you wish to restart learning mode at a later point, you must tick the appropriate box again in
order to activate. You can do this in either the configuration wizard[ 71 or the Edit alarm settings[4s dialogue.
During this process, the learning mode only determines main and pre-alarm limits. The value you specified for
Signal always larger than in the Set alarms step is automatically adjusted if the new alarm limits overlap.

Scenario 2: Learning mode and alarm map

Alarm maps are used in connection with the learning mode if your machine is operated in different operating states
each having its own alarm limits. In this case, you can run the learning mode dependent on one or two further
signals (machine parameters). To do this, the SmartCheck or ProLink device must be able to measure the
corresponding signals via the analogue or digital input. The following example shows which specifications you must
make additionally in the configuration wizard:

Your machine, which is operated at different speeds, has a speed range of between 2000 rpm and 3000 rpm. In
order to calculate alarm limits contingent on this speed range with the learning mode, make the following entries in
the Set alarms step of the configuration wizard:

Step: Set alarms

Variable alarm limits :

+ Change alarm limits in line with other signals

First input signal : Min [RPM] : Max [RPM] :
# Digital input (speed) - 2,000.0 3,000.0
Second input signal
b
Reset alarms :
# Automatically Manually 9
Alarm settings :
The same alarm settings for all characteristic values with the same unit 9
# Alarm seffings for each individual characteristic value
1. Alarm settings for "1S010816-1 (2Hz - 1kHz) - Velocity" A
Machine class (150 10818) 9
Main alarm | 7.1 mm/s Pre-alarm : | 2.5 mmy's
Lower pre-alarm ;| 0.0 mm/'s 9
" Use learning mode
2. Alarm settings for "RMS broad band - Acceleration (Overall status)”
Main alarm ;| 1.0 g Pre-alarm ;| 0.7 g ~

Activate the Change alarm limits in line with other signals option.
For the input, select the speed input — in this example the digital input.
For Min [RPM], specify the value 2000.
For Max [RPM], specify the value 3000.
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e Activate the learning mode for the corresponding characteristic values.

As soon as you complete the wizard with OK, you can start learning mode in the same way as with the Default
settingl ss"; learning process deviations from the default setting are as follows:

e The reference speed range of 2000 to 3000 is broken down into an alarm map with 10 fixed alarm fields:

Alarm settings:

Schaeffler SmartWeb

Standard values :

Main alarm : 1.0 g @ |
Pre-alarm: 0.7 g
Lower pre-alarm : 0.0 g <« < Date: - Value: - » ¥

Use leaming mode : yes

0.8

Digital input (speed) - Alarm map [RPM]

£,000.0| 12,000 | 13,000| 24,000| 30,000 | 36,000 | 42,000 | 48,000 | 54,000 | 60,000
0.0 |6,000.0|12,000|15,000|24,000| 30,000 35,000 | 42,000 | 45,000 | 54,000

i
it
i
i
it
i L
i
it
i
i

2018-12-12 2018-12-12 2018-12-12

05:24:00 05:22:00 05:32:00
Main alarm : | 1.0 g Pre-alarm: | 0.7 g 9
Lower pre-alarm : | 0.0 g +' Use learning mode
Reset changes Reset values OK Cancel

e For each of these alarm fields, the SmartCheck or ProLink device takes in 1000 measurement values in order to
calculate from them an alarm limit of its own for the corresponding alarm field.

e For as long as an alarm field does not yet have a new alarm limit, the default alarm limit applies for the field.

e Each alarm field is processed[ 41 individually, which means it is possible for the learning mode to be completed in
one alarm field already, while the default alarm limits still apply in the other alarm fields.

o When the learning mode for an alarm field is completed, a corresponding message appears in the logbook[ 4%,
which also contains the newly calculated alarm limits.

e While the learning mode is running, the status LED of the SmartCheck or ProLink device flashes. When running
through the alarm fields in an alarm map, the LED may stop flashing briefly because the device has reached a field

that is already completed. However, it will start flashing again as soon as it reaches a field for which the learning
mode is not completed.

You can also use the learning mode contingent on two machine parameters. In this case, you must specify a second
signal in the Set alarms step of the configuration wizard:
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Step: Set alarms

Variable alarm limits :

|1/ Change alarm limits in line with other signals

First input signal : Min [RPM] : Max [RPM] :
» Digital input (speed) - - 2,000.0 3,000.0
Second input signal Max [%] :
# Load - — 20.0] &0.0

Reset alarms :

® Automatically () Manually

Alarm gettings :
() The same alarm settings for all characteristic values with the same unit

(® Alarm seffings for each individual characteristic value

1. Alarm settings for "IS010816-1 (2Hz - 1kHz) - Velocity"
Machine class (130 10&18)

Main alarm | 7.1 mm/'s Pre-alarm ;| 2.8 mmv's

Lower pre-alarm ;| 0.0 mm/'s

" Use learning mede

2. Alarm settings for "RMS broad band - Acceleration (Overall status)"

Main alarm ;| 1.0 g Pre-alarm ;| 0.7 g

As soon as you complete the wizard with OK, you can start the learning mode process as described above.
However, the alarm map is significantly expanded, as a matrix with 100 alarm fields is now generated, with an alarm
limit calculated for each field.

Alarm settings: 15010816-1 (2Hz - 1kHz)

Schaeffler SmartWeb

Standard values :
Main alarm : 7.1 mmis & ) Q
Pre-alarm : 2.8 mmi/s
Lower pre-alarm : 0.0 mmi/s £44 4 Date: - Value: - > ¥
Use learning mode : yes
8.0
Digital input (speed) - Alarm map [RPM]
6.000.0| 12,000 | 18,000 | 24,000 | 30,000 | 35,000 | 42,000 | 48,000 | 54,000 | 60,000 7.0
0.0 |5.000.0(12,000(18,000| 24,000 30,000 | 36,000 | 42,000 | 48,000 | 54,000
100.0 ] ] ] ] ] ] ] ] ] ] 6.0
0.0 1 1 1 1 1 1 1 1 1 1
yes| yes| yesi yes| yes| yesi yes| yes| yesi yes|
90.0 ] ] ] ] ] ] ] ] ] ]
30.0 ] ] ] ] ] ] ] ] ] ] 50
yes yes| yes yes yes yes| yes| yes  yes  yes
_.| 80.0 1 1 1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 1 w
#| 700 yes yes| yes yes| yes yes yes yes yes yes| g*0
E
700 ] ] ] ] ] ] ] ] ] ]
60.0 1 1 1 1 1 1 1 1 1 1
yes| yes| yesi yes| yes| yesi yes| yes| yesi yes| 3.0
60.0 ] ] ] ] ] ] ] ] ] ]
500 1 1 1 1 1 1 1 1 1 1
yes yes| yes yes yes yes| yes| yes  yes  yes .
50.0 1 1 1 1 1 1 1 1 1 1
400 1 1 1 1 1 1 1 1 1 1
yes yes| yes yes yes yes| yes| yes  yes  yes
400 ] ] ] ] ] ] ] ] ] ] 0
300 1 1 1 1 1 1 1 1 1 1
yes| yes| yesi yes| yes| yesi yes| yes| yesi yes|
300 ] ] ] ] ] ] ] ] ] ] 0.0
200 7 7 7 7 7 7 7 7 7 7 2019-12-14 2019-12-15 2019-12-16
ves| yes| yes yes yesi yes yes yes yes yes| 01:00:00 09:00:00 17:00:00
200 1 1 1 1 1 1 1 1 1 1
100 1 1 1 1 1 1 1 1 1 1 e
yes|  yes| ye§s yes| yes ye§ yes ye§  yes  ye§ Main alarm : | 7.1 mmis Pre-alarm:| 2.8 mm/s
10,0 ] ] ] ] ] ] ] ] ] ] .
0.0 9 ! ! ! ! ! ! ! ! < | Lower pre-alarm:| 0.0 mm/s +" Use learning mode
- yes| yes| yesi yes| yes| yesi yes| yes| yesi yes|
Reset changes Reset values OK Cancel
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e The SmartCheck or ProLink device creates the characteristic value for the machine
g parameter(s) in the background; you cannot change their alarm limits manually: they
depend on your entry for the value range.

e If a measured value lies outside the value range you have specified, the SmartCheck or
ProLink device uses the alarm limit of the nearest alarm field.

e After a firmware update, the checkbox for Use learning mode is activated for all alarm
maps — regardless of whether or not the learning mode has already been completed for
this map. Learning mode is not activated after the update, the control maps therefore
initially remain unchanged. As soon as you activate learning mode, all control maps are
learned again. In this process, they lose all previously learned values. To prevent this,
proceed as follows:

In the SmartWeb software, set learning mode for each individual field by selecting one or
more fields and deactivating/activating the checkbox for Use learning mode.

General information on the learning mode

In this section, you will find useful pointers on working with the learning mode.

When is it useful/possible to use the learning mode, and when not?

For the learning mode, the machine must be in good condition, i.e. not damaged in any way. For monitoring
vibrations in accordance with ISO 10816-1, an additional requirement is that the machine vibrations should lie
within the range of the ISO characteristic value. This is true of machines "that are normally considered acceptable
for long-term operation" (ISO definition for the good condition of a machine).

The learning mode can only determine optimal values if the machine is in its normal state/operation. You should
not start the learning mode if your machine is currently idle or being started or stopped.

If you are not sure how to find out the normal operating state of your machine, ask your
g customer support representative.

In general, it makes sense to use the learning mode in connection with vibration signals.

You should not use the learning mode when the measurement range is known, e.g. for temperature, pressure or
load.

For additional signals, which you specify in the Additional signals step (configuration wizard), the learning mode
is generally not necessary.

No alarm is output during the learning phase. An alarm is output only if learning mode is

g complete and the machine exhibits high vibrations. The status LED of your SmartCheck or
ProLink device then lights up permanently in yellow or red. This could be an indication of
excessive vibrations. In this case, inspect the machine and the settings in the SmartWeb
software. If necessary, contact a vibration expert or your customer support representative
(see Support).

How do changes to the system affect the learning mode?

In changing the value range of the signal that is used for the alarm map in the Set alarms step (configuration
wizard), you also change the dimension of the alarm map. Therefore, upon completion of the wizard, all alarm
limits that the learning mode has determined up to that point are discarded. As for a newly created measurement
job, the default alarm limits are now in all alarm fields again.

When you work with the learning mode, the SmartCheck or ProLink device takes over the default alarm limits of
the characteristic values at the start of the process. As soon as the learning mode has been completed once, the
system will then only use the new alarm limits. If you change the default alarm limits of the characteristic value,
the changes take effect immediately on the system. As such, you can also adjust the alarm limits during the
learning phase.

If you switch off the SmartCheck or ProLink device, the learning mode will only be interrupted; the measurement
results to date are not lost.
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If you turn off the machine while the learning mode is active, the learning mode will be

g executed on an idle machine, which will result in incorrect measurement values and thus
incorrectly calculated alarm limits too. You should therefore restart the learning mode when
the machine is running again.

When should the learning mode be restarted and what happens then?

e You should always restart the learning mode when the machine parameters or the vibration behaviour have
changed. This is likely in the following cases, for example:

= After repairs
= After structural changes to the machine
= After changes of mechanical parameters.

e If the learning mode was already completed, the previous alarm limits will be retained after a restart until the
calculation of the new alarm limits is finished.

¢ If the learning mode was not yet completed and is restarted, the values already measured will be discarded and all
set values will need to be measured again.

How is the learning mode activated/started?
Activation

e Schaeffler SmartWeb: Via the Create new measurement job or Edit measurement job wizard in the Set
alarms step, or via the Alarm settings button under Characteristic value configuration

Start/Restart
¢ Schaeffler SmartWeb: Via the context menu for measurement configurations and characteristic values, e.g. in the
Status area.

e Schaeffler SmartCheck or ProLink: via the TEACH key. This starts the learning mode for all characteristic values of
your system for which the learning mode is authorised.

Procedure for initial set-up
For the initial set-up of the Schaeffler SmartCheck or ProLink device, proceed as follows:

1. Install the SmartCheck or ProLink device and set up the connections. Details on this can be found in the
Schaeffler SmartCheck or ProLink user documentation.

2. Create the desired configuration with the SmartWeb software. You can find an initial overview of the necessary
steps on the start page of the Configuration|s71 area.

3. Only start the learning mode once your machine is in a defined normal state, i.e. temperature, pressure etc.

have reached normal values. Measurements outside the normal state can negatively affect the measurement
result.

8.4 Output configurations

Depending on the system, you have the following options:

« Schaeffler SmartCheck device: For the Schaeffler SmartCheck device, you can configure[ss" a total of two
outputs, one analogue output and one digital output. In the Output configurations area, you will find an
overview of all outputs of the SmartCheck device currently configured. In the factory default setting of the
SmartCheck device, the analogue output is configured as Overall alarm status

o Schaeffler ProLink device: Once you have started the Schaeffler ProLink device, the outputs for the
connected vibration modules[ ss" are automatically created and assigned to the modules. Four digital outputs are
possible per vibration module. You can also create up to eight analogue or digital outputs for the connected 1/O
modules via the module configuration[e. In the Output configurations area, you will find an overview of all
outputs and you can also configure them here.
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In the expanded overview on the left, you will find all output configurations for the SmartCheck or ProLink device.
Click on an output configuration to access the following information and functions in the main panel:

e The Name and the details on the selected output configuration are displayed on the left.

¢ On the right, in the area highlighted in grey, you will find details on creating and changing the output
configuration.
e You can edit the output configuration[ esh.

e You can add a new output configuration[e". The maximum number possible is one digital and one analogue

output configuration for the SmartCheck device or four digital output configurations for each ProLink vibration
sensor.

e You can delete the selected output configuration. To do so, click Delete and confirm with OK.

For the I/O module of the ProLink device you must use the module configuration[eol to add
g or delete outputs.

e You can test the selected output configuration[ . To do this, click on €| Test | and define the type of test.
The display above the button indicates whether a test is currently active.

¢ In the top right corner, click on o open the Configuration overview[s".
If you reconfigure the outputs on the SmartCheck or ProLink device, you have the following basic options:
Digital alarm limit/[ "

You can use the digital output, a pure switching output, as a two-stage alarm limit for any characteristic value
configuration or for the overall alarm status. It can output whether an alarm exists or not, whereby you can
determine whether it should switch as soon as the pre-alarm is triggered or only when the main alarm is reached.
For this output to occur, the output must be connected to your controller.

Analogue alarm output/[ %) (SmartCheck and Schaeffler ProLink I/0 module)

You can use the analogue output as a three-stage alarm output for any characteristic value configuration or for the
overall alarm status. It can output whether a pre-alarm, a main alarm or no alarm exists. For this output to occur, the
output must be connected to your controller.

Analogue characteristic value output[ s (SmartCheck and Schaeffler ProLink I/O module)
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You can also use the analogue output to output the characteristic value for any characteristic value configuration or
for the overall alarm status. The selected characteristic value, e.g. temperature, is given to the output as a voltage
signal proportional to the size of the characteristic value and passed on to your controller, where the value can be
interpreted.

e You cannot use triggers or measurement conditions for an output configuration

g e Exact information on how to connect the outputs of the SmartCheck or ProLink device
with your controller can be found in the Schaeffler SmartCheck or ProLink user
documentation.

8.4.1 Adding/editing output configurations

You can configure the following outputs on the SmartCheck or ProLink device:

e Analogue characteristic value output[e" (SmartCheck and Schaeffler ProLink I/O module)
e Analogue alarm output[ee (SmartCheck and Schaeffler ProLink I/O module)

« Digital alarm output[ee)

You can edit[ 9" existing output configurations at any time.

For the I/O module of the ProLink device, you must use the module configurationle to add

g outputs. To configure the added outputs for your system, select the output in the
expanded overview and click Edit under Output configurations # . For information on
the configuration options, refer to the following sections on the analogue characteristic value
output[es), the analogue alarm output[ e and the digital alarm output/se).

How to create an analogue characteristic value output (SmartCheck and Schaeffler ProLink I/0 module)

1. Under Output configurations click on Add ™ (SmartCheck only).
2. Set the required specifications in the Add output configuration window:

Add output configuration

Name :
Cumulative alarm
Output channel :
¢ Analogue output b
Characteristic value configuration :
Base measurement job - Peak2peak - Acceleration {... =
Output type :
Alam gutput

#) Characteristic value output

Currentivoltage output :
Voltage [0-10 V] -

Output range:
v

12.5

(5]
o

4 B B

(5]

Min : Scaling factor : Max :
0.0 1.0 1000

OK Cancel
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You have the following options:

Name Here, enter the name under which the output configuration is to appear in the
overview.

Output channel From here, select the Analogue output option.

Characteristic value In this list, you can find the overall alarm status, all measurement jobs and the

configuration corresponding individual characteristic values of your system. For the analogue

characteristic value output, you must select an individual characteristic value.
You can only select measurement jobs and overall alarm status for one alarm

output.
Output type Here, select the Characteristic value output option.
Current/voltage output Here, determine the range of the voltage or current that is to apply for the

analogue characteristic value output. SmartCheck or ProLink supports the
following ranges:

e 0-10V
e 0-20 MA
e 4-20 mA

Scaling factor, Min, Max Use these settings to determine the range within which the characteristic
value should lie. First enter a minimum value Min. Then enter a maximum value
Max or define the factor with which the outgoing signal should be scaled in
the Scaling field. Both the diagram and the values of the respective other field
are then adjusted automatically.

If the output value exceeds the maximum value Max, then the maximum
voltage is output.

3. Click on OK to save the new output configuration.

To create an analogue alarm output (SmartCheck and Schaeffler ProLink I/O module)

1. In the Actions area, click on Add ™ (SmartCheck only).
2. Set the required specifications in the Add output configuration window:



You have the following options:

Name
Output channel

Characteristic value
configuration

Output type

Current/voltage output

Alarm limit

Configuration

Edit output configuration

Name :
Owerall alarm status

Characteristic value configuration :
Device alarm status A

Currentivoltage cutput :

Current [4-20 mA] A
Alarm limit :

Pre and main alarm -
Alarm Output
Mo alarm 4 ma
Pre-alarm 12 m&
Main alarm 20 miA

OK Cancel

Here, enter the name under which the output configuration is to appear in the
overview.

From here, select the Analogue output option.

In this list you will find the overall alarm status and the individual characteristic
values of all measurement jobs of your system. You can choose whether the
alarm should be output for the entire system or for an individual characteristic
value.

From here, select the Alarm output option.

Here, determine the range of the voltage or current that should apply for the
analogue alarm output. SmartCheck or ProLink supports the following ranges:

e 0-10V
e 0-20 mA
e 4-20 mA

From here, you determine whether the alarm output is to output the pre-
alarm, the main alarm or the pre and main alarms. Below the drop-down
list, you can find information on how current/voltage are distributed to the
alarm statuses.

3. Click on OK to save the new output configuration.
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) The analogue outputs of the I/O module are configured as standard in such a way that you
E/ can connect and operate a Schaeffler SmartLampwithout any further settings:

-
il

" ProLink I/O |

/\ 0-10V
GND
-

TR
-

The SmartLamp visualises the ProLink alarm status. Refer to the user documentation for
further details SmartLamp.

How to create a digital alarm output
1. Under Actions, click on Add .

2. Set the required specifications in the Add output configuration window:

Add output configuration

Name :

Device alarm status
Output channel @

# Digital output

Characteristic value configuration :
Device alarm status

| Inverted
Alarm limit :
Iain alarm -
Alarm Cutput
Mo alarm Off {open/pull-up)
Pre-alarm Off (openipull-up)
Main alarm On {closedlearth)

OK Cancel

You have the following options:
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Name Here, enter the name under which the output configuration is to appear in the
overview.
Output channel e SmartCheck: Here, select the Digital output option.
e ProlLink: The Digital output is preset and cannot be changed.
Characteristic value In this list, you can find the overall alarm status, all measurement jobs and the
configuration corresponding individual characteristic values of your system. You can choose

whether the alarm should be output for the entire system, a measurement job
or an individual characteristic value.

Output type This is where the Alarm output option is specified.

Alarm limit From here, you determine whether the alarm output is to output the pre-
alarm, the main alarm or the pre and main alarms. In the list box, you can
find information on how the output reacts to the alarm statuses.

3. Click on OK to save the new output configuration.

How to edit an output configuration

1. Select the Output configuration in the expanded overview on the left.

2. Under Output configurations, click on Edit 7" and set the required specifications in the Edit output
configuration window.

For your SmartCheck device, you can also change an analogue alarm output to a characteristic value output and
vice versa here, among other possibilities.

3. Click on OK to accept your changes.

8.4.2 Test output configuration

You have the option of activating a test for your output configuration and thus verifying whether your output
configuration is working correctly. You can then determine whether the cabling and the connection to a controller
or display are correct. If a test is already active, it is cancelled as soon as another alarm output is tested.

In the following sections, you will find details on how to test your configured alarm output[ ™. You can also test
your configured characteristic value output[100) for your SmartCheck device.

How to test a configured alarm output

1. Under Output configurations, click €= Test |
2. In the Test output configuration window, enter the desired specifications:

Test output configuration

Test duration :
30 seconds -

Tested alarm type :

Me alarm -
DK Cance
You have the following options:
Test duration This is where you define the test duration.
Tested alarm type Here you can select what the test is to simulate:

¢ No alarm: the test simulates a status without an alarm.
¢ Pre-alarm: the test simulates a pre-alarm.
e Main alarm: the test simulates a main alarm.

3. Click OK to confirm your settings and start the test. You will then be informed that the test is active and told
what is being tested. This appears as follows for the SmartCheck device, for example:
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Output configurations

Mame : Overall alarm status

Output channel ; Analogue output
Characterisfic value configuration : Device alarm status

Cutput type : Alarm cutput | Test
Current/voltage oufput | Voltage output

Alarm : Pre-alarm
Mo alarm : 0V

Pre-alarm : 10V
Main alarm : 10V

# Edit Delete +  Add

4. To cancel the test, click 1 Test again.

How to test a configured characteristic value output (SmartCheck only)

1. Under Output configurations, click €| Test
2. In the Test output configuration window, enter the desired specifications:

Test cutput configuration

Test duration :

30 seconds -
Voltage [0-10V] :
0.0
OK Cance
You have the following options:
Test duration This is where you define the test duration.
Voltage Here, enter the value for voltage or current that is to be tested.

3. Click OK to confirm your settings and start the test. You wil then be informed that the test is active and
informed on what is being tested:

100



Output configurations

Name :

Output channel :

Characteristic value configuration :

Characteristic value output

Analogue output
Base measurament job - PeakZpeak - Acceleration (high vibration values)

4. To cancel the test, click 1 Test again.

8.5 Measurement trigger

The SmartCheck or ProLink device generally works through the measurement jobs in a fixed order. However, you
can interrupt this order using a measurement trigger. As soon as the trigger condition is fulfiled, the measurement
controlled by the measurement trigger is started (after completion of the current measurement).

In the Measurement trigger area, you will find an overview of all measurement triggers. In the factory default
setting, no measurement trigger is configured for the SmartCheck or ProLink device. As soon as you have defined
your own measurement triggers, they are available to you when creating measurement jobs[ 7.

File w

Schaeffler SmartWeb

Configuration

Hame

— |& Ceonfiguration

4 =31 Input cenfigurations
+ (8 Measurement jobs
4 4= Qutput configurations

= & Measurement trigger

& Measurement trig...

& Rotational speed

+ «& Measurement conditi...

=, Communication chan..

+ [ Device
(©) Bearings

wa| Bearing manufacturer

Edit ¥ Measurementdata ¥ Goto v

Measurement trigger

Name :

Input channel :

Unit :

Calculation type :
Measurement values :
Thresheld :

Edge :

Lead time of measurement :
Storage period :

Rotational speed

Digital input (speed)

RPM

RMS

1000
2,500.0 RPM
Falling

0 ms

10 minute(s)

Measurement job : -

# Edit

Deleie

+ Add

Cutput type © Characteristic value output

Currentfvoltage output : Voltage output

Scaling : 1.0V /g
Valugrange : 0.0g-100¢g

Output range : 0to 10V

| Charactzristic value cutput

2 4 ] g 10
g
# Edit Delete

Configuration

Test active:
55V

| Test

Connected fo | SmartCheck 38
Logged in as : admin

Help wv
=)

Changed : 2019-12-11 22:31:55
Created : 2019-12-11 22:31:55
Changed by : admin

In the expanded overview on the left, you will find all measurement triggers of the SmartCheck or ProLink device.
Click on a measurement trigger to access the following information and functions in the main panel:

The Name and the details on the selected measurement trigger are displayed on the left.
The entry for Input channel is a link that takes you straight to the corresponding input configuration.

The entry for Measurement job is a link that takes you straight to the overview of the measurement job in
which this measurement trigger is used.

On the right, in the area highlighted in grey, you will find details on creating and changing the measurement

trigger.

You can edit the measurement trigger/i0d).
You can add a new measurement trigger| 0.

You can delete the selected measurement trigger. To do so, click Delete

and confirm with OK.

101



102

« In the top right corner, click on B to open the Configuration overview [,

o

e When the condition for a measurement trigger is met, the measurement is started
immediately, even if this means that an ongoing measurement is interrupted.
Measurements that themselves have been started by a measurement trigger are not
interrupted.

¢ If a measurement trigger is used in multiple measurement jobs, these jobs are executed
sequentially when the trigger condition is met.

8.5.1 Adding/editing measurement trigger

You can add[102 as many measurement triggers and edit[103) as many existing measurement triggers as you like on
the SmartCheck or ProLink device.

How to create a measurement trigger

1. Under Measurement trigger, click on Add
2. In the Add measurement trigger window, make the desired specifications:

Add measurement trigger

Schaeffler SmartWeb

Name :
Retational speed

Input channel :
# Digital input (speed) o

Unit :
RPM (Frequency/speed)
Calculation type :
RMS -

Threshold [0.0-60,000] :
2,500.0
Measurement values[1-38400] :
1000
Edge :
Falling -

Lead time of measurement [ms] :
0

LI

Storage period :
10 minute(s) -

0] 4 Cance

You have the following options:

Name

Input channel

Unit

Calculation type

Threshold

Here, enter the name under which the measurement trigger is to appear in the
overview. This name will also appear in the corresponding list box if you want to use
the measurement trigger in a measurement job.

Here, select the input whose signal you want to use for the measurement trigger.
You will find in the list box all inputs and scaling factors[eo™ of your system.

This value is automatically filled for the input channel you have selected.

This is where you select the characteristic value most suitable for your signal. The
Offset option is available for many application types.

Specify here the value from which the measurement trigger should take effect: If
the threshold value is exceeded or falen below—according to the Edge-the
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SmartCheck or ProLink device interrupts the current measurement and starts the
measurement linked to the measurement trigger.

Measurement values A trigger calculates its current value using the last measured number of values;

Edge

Lead time

Save interval

enter this number here. This value is therefore used to define the number of
measurement values that the calculation type configured above should calculate,
and the time range over which this value is calculated. You therefore influence the
speed at which a trigger reacts to changes in the input signal and the sensitivity of
the trigger's reaction to signal disruptions:

e A smaller number causes a faster reaction.

e A larger number makes the trigger less sensitive to disruptions.
Example: The sample rate is 1280 values/second (e.g. for an analogue input) and you set

Measurement values to 1280. If you have selected Offset as the calculation type, the
calculated value corresponds to the average over one second via the input channel.

Determine here whether the threshold has to be exceeded or fallen below for
the measurement trigger to take effect:

Falling: The measurement trigger takes effect when the threshold is fallen below.
Rising: the measurement trigger takes effect when the threshold is exceeded.

Here you define the time prior to initiation of the trigger at which you want the
trends to start recording. This enables you to analyse why the trigger has been
initiated.

Determine here whether you wish to store values regularly in order to monitor the

measurement trigger. If values are stored regularly, you can view the trend of the

measurement trigger in the Measurement data area and verify, for example, that

the device is actually taking measurements.

You have the following options:

e Never: Select this option if no values are to be stored for a trend.

¢ n minutes/hours/days: Enter here the frequency at which values are to be
stored for the trend in minutes, hours or days.

A status change - i.e. the execution of the trigger - is always stored, regardless of
the setting selected here.

3. Click on OK to save the new measurement trigger.

How to edit a measurement trigger
1. Select the measurement trigger in the expanded overview on the left.

2. Click on Edit #  and make the desired specifications in the Edit measurement trigger window.
3. Click on OK to accept your changes.

4

You can determine the number of Measurement values according to the following rough
guidelines:

e A small number of measurement values allows the trigger to switch more quickly.
¢ A small number of measurement values reacts sensitively to short pulses.
¢ A large number of measurement values is preferable for restless, inconstant signals.

SmartCheck device:

The save interval determines how frequently the trend values of the measurement trigger
are saved. However, if the trigger relates to an analogue input in 4-20 mA mode, the
following restriction applies:

If the value at the analogue input falls below 4 mA, this channel becomes invalid. The values
of the trigger are then no longer measured or saved until the channel is valid again (i.e. the
value at the input rises above 4 mA). This period is displayed with a grey background in the
trend.
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8.6 Measurement conditions

Usually the Schaeffler SmartCheck or ProLink device executes the measurement tasks in a fixed sequence. Using a
measurement condition, you can ensure that measurements are skipped: if a measurement is pending but the
measurement condition you defined is not met, the device skips this measurement and goes straight to the next
one.

If a measurement is pending and the measurement condition is met, the measurement is performed. However,
even during a measurement, the system continually monitors whether the measurement condition is still being met.
As soon as the measurement condition is no longer being met, the measurement is cancelled.

An hour meter| 501 is automatically created for each measurement condition. This indicates the active operating
time of a measurement condition and thus the time of the machine or component. You can see the hour meter in
the Measurement data below the associated measurement condition. There you can edit the hour meter and
view the trend of the hour meter.

In the Measurement conditions area, you will find an overview of all measurement conditions. In the factory
default setting for the SmartCheck or ProLink device, the Machine is runninglﬁ-ﬁ measurement condition is
preconfigured.

As soon as you have defined your own measurement conditions, they will be available to you when creating
measurement jobs[ 7.

Connected to : SmartCheck 36
g g FWi
Schaeffler SmartWeb Logged in as : admin ® .

File v Edit ¥ Measurementdata v Goto v Help »
Configuration Measurement conditions B

Name Name : Rotational speed Changed

— |& Configuration Created ”
Input channel : Digital input {speed) Changed by : admin
+ =31 Input configurations Unit © RPM

+ (2 Measurement jobs Calculation type | RMS
Measurement values : 1,000
Upper threshold ;| 58 RPM
& Measurement trigger Lower threshold : 50 RPM
— & Measurement condit Storage peried . 1 minute(s)

+ <= Output configurations

¥ Machine is running Measurement job -

& Rotational speed
+ = Communication chan..

* Edit Delete + Add
+ [®] Device ’ -

(©) Bearings

wsl Bearing manufacturer

In the expanded overview on the left, you will find all measurement conditions for the SmartCheck or ProLink
device. Click on a measurement condition to access the following information and functions in the main panel:

e The Name and the details on the selected measurement condition are displayed on the left.
e The entry for Input channel is a link that takes you straight to the corresponding input configuration.

e The entry for Measurement job is a link that takes you straight to the overview of the measurement job in
which this measurement condition is used.

e On the right, in the area highlighted in grey, you will find details on creating and changing the measurement
condition.

e You can edit the measurement condition 108\
e You can add a new measurement condition[103).

e You can delete the selected measurement condition. To do so, click Delete and confirm with OK.

e In the top right corner, click on o open the Configuration overview[s.
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The preconfigured Machine is running measurement condition is set in the base
configuration and ensures that the measuring job is only executed when the relevant
machine is actually running. You cannot delete this measurement condition. You can rename
this measurement condition (ProLink only).

However, you should adapt this measurement condition to your machine immediately after
commissioning the Schaeffler SmartCheck or ProLink device: The fulflment of the
measurement condition Machine is running is based, in the factory default setting, on
vibration signals. Edit the measurement condition[1051 so that it meets the requirements of
your machine. For example, the engine speed is usually a better criterion for determining
whether the machine is running.

The Machine is running measurement condition is usually added to each newly created
configuration by default. However, you can also delete it manually (SmartCheck only).

8.6.1 Adding/editing measurement conditions

On your SmartCheck or ProLink device, you can add[109) as many measurement conditions and edit[100 as many
existing measurement conditions as you like.

How to create a measurement condition

1.
2.

Under Measurement conditions, click on Add
In the Add measurement condition window, make the desired specifications:

Add measurement condition

Schaeffler SmarfWeb

Name :
Temperature

Input channel :
& System temperature sensor

Unit :

*C (Temperature)

Calculation type :
RMS

Measurement values[1-6666] :
1000

Lower threshold [0.0-59.9] @
40.0

Upper threshold [40.1-85.0] :
§0.0

Storage period :

1 minute(s)

Ok Cance

You have the following options:

Name

Input channel

Unit

Calculation type

Here, enter the name under which the measurement condition is to appear in
the overview. This name will also appear in the corresponding list box, if you
want to use the measurement condition in @ measurement job.

Here, select the input channel whose signal you want to use for the
measurement condition. You will find in the list box all inputs and scaling
factors[eo™ of your system.

This value is automatically filled for the input channel you have selected.

This is where you select the characteristic value most suitable for your signal.
The Offset option is available for many application types.
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Measurement values A condition calculates its current value using the last measured number of

values; enter this number here. This value is therefore used to define the
number of measurement values that the calculation type configured above
should calculate, and the time range over which this value is calculated. You
therefore influence the speed at which a condition reacts to changes in the
input signal and the sensitivity of the condition's reaction to signal disruptions:

e A smaller number causes a faster reaction.

e A larger number makes the condition less sensitive to disruptions.
Example: The sample rate is 1280 values/second (e.g. for an analogue input) and you
set Measurement values to 1280. If you have selected Offset as the calculation

type, the calculated value corresponds to the average over one second via the input
channel.

Lower threshold / With these two thresholds, you determine the range within which the

Upper threshold

Save interval

measurement condition counts as met; the measurement associated with this

condition is then performed.

In our example, this range is between 40 and 60°C; with a value of e.g. 65°C,
the measurement condition would not be met and the measurement would be
skipped or cancelled.

Determine here whether you wish to store values regularly in order to monitor
the measurement condition. If values are stored regularly, you can view the
trend of the measurement condition in the Measurement data area and
verify, for example, that the device is actually taking measurements.

You have the following options:
e Never: Select this option if no values are to be stored for a trend.

¢ n minutes/hours/days: Enter the frequency at which values are to be
stored for the trend in minutes, hours or days here.

A status change - i.e. the fulfiment of the condition - is always stored,
regardless of the setting selected here.

3. Click on OK to save the new measurement condition.

How to edit a measurement condition
1. Select the measurement condition in the expanded overview on the left

2. Click on Edit # and enter the desired specifications in the Edit measurement condition window.
3. Click on OK to accept your changes.

4

You can determine the number of Measurement values according to the following rough
guidelines:

¢ A small number of measurement values allows the measurement condition to switch more
quickly.

¢ A small number of measurement values reacts sensitively to short pulses.

e A large number of measurement values is preferable for restless, inconstant signals.

SmartCheck device:

The Save interval determines how frequently the trend values of the measurement
condition are saved. However, if the measurement condition refers to an analogue input in
4-20 mA mode, the following restriction applies:

If the value at the analogue input falls below 4 mA, this channel becomes invalid. The values
of the measurement condition are then no longer measured or saved until the channel is
valid again (i.e. the value at the input rises above 4 mA). This period is displayed with a grey
background in the trend.

8.7 Communication channels

In the Communication channels area, the expanded overview on the left shows the communication channels
that you have created for the SmartCheck or ProLink device. You can create the following communication channels:
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o An ™ e-mail communication channell w07, to send e-mails with data attachments from the SmartCheck or
ProLink device.

e Multiple channels for A controllers[18), to integrate these into the monitoring with the SmartCheck or ProLink
device and to provide you with data from the SmartCheck or ProLink device.

o An “* OPC UA server communication channell14)to set up the SmartCheck or ProLink device as an OPC UA
server.

o A PROFINET communication channell 153 to connect the ProLink device to your controller via the PROFINET
module.

A ©5Schaeffler Cloud communications channell1sd), to exchange data with the Schaeffler Cloud.

In the right-hand main panel, you will find basic details about the currently selected communication channel as well
as information on its inputs and outputs, if these can be created or have been created:

N Connected to : SmartCheck 36
Schaeffler Smartweb =d {0 Smar N
Logged in as : admin
File W Edit ¥ Measurementdala ¥ Goto W Help v
Configuration Communication channels =]
Name Name : PLC_018 Changed : 2019-12-17 12:23:04
— \B Configuration Created : 2019-12-17 10:27:19
; ~ : Device type : Mitsubishi controller Metwork number : - () Changed by : admin
*+ =1 Input configurations IP address | 172.26.205.122 Station number : -
+ (@ Measurement jobs Port: 1230 Register with version number : D1200
+ 1 Output configurations Protocol TF:P Configuration version : 5 ‘
Transfer mode : Binary il

& Measurement trigger
+ & Measurement conditi...

— =% Communication chan...

2 Email # Edil Delets + Add
ePe OPC UA server
..‘ PLC_018 Inputs for communication channel : PLC_018
+ [ Device
(@) Bearings Name Start register Reg. t... Polling interval Min. signal Max. signal Unit Min. reg. value Max. reg. val...
wal Bearing manufacturer ) Velocity from PLC_018 D1000 WORD 1.0s 0.0 163,837 [RPM] 0.0 10,000
& Actions 7 Edit Delete + Add
Create new measurement job
& Areas Outputs for communication channel : PLC_013
‘% Stalus Register Register name Measurement job Characteristic value Type Update interval
" Measurement data D1201 5_communication_status Communication status Status 60.0 5 )
W Live view D1202 a_device_status Device alarm status Device alarm status Alarm 60.0 s I
D1203 a_crest_factor_acceleration_imp Default configuration Crest factor - Acceleration (Impul... Alarm 60.0 s
@ Configuration D1204 c_crest_factor_acceleration_imp Default configuration Crest factor - Acceleration {(Impul... Value 600 s
'.; User management D206 A izn10B1A 1 10hz 1khz wvelocity  Default confinuration 1S01NE16E-1 (10Hz - 1kH=1 - \Veln Alarm CIIEVES v
L') Log aut /' Edil Delete
Complete

Click on a communication channel in the main panel to access the information and functions relating to the
respective channel. Information and functions are different for each type of communication channel. Relevant details
can be found in the following sections.

8.7.1 Communication channel for email

In the ™ communication channel (e-mail)[ 108 area, you can extend the possibilities of condition monitoring using
the SmartCheck or ProLink device, by creating an e-mail communication channel and sending e-mails via the
SmartCheck or ProLink device. Emails from the SmartCheck or ProLink device are sent to any receiver group via the
SMTP server defined by you. You can include characteristic values and time signals of the selected
measurement tasks as attachments, and the sending of emails is controlled according to timing or alarms.

In order to use the email function, the following steps are necessary:
e First, create the email communication channell109. Enter the settings for connection to the email server.

« Next, create one or more outputs for the email communication channell11\. You can define the structure,
content and triggers of the emails.
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e After you have created everything, you wil find an overview of the email communication channel and its outputs
in the communication channel (email)l 8] area.

8.7.1.1 Communication channel for email area

In the Communication channels area, the expanded overview on the left shows the email communication
channel that you have created for the SmartCheck or ProLink device. On the right of the main panel, you will find
basic details about the selected email communication channel, as well as information about its outputs:

Schaeffler SmartWeb

File w Edit v Measurementdata ¥ Goto W

Configuration

Name

— |8 Configuration
+ =3l Input configurations
+ (& Measurement jobs
+ &1 Output configurations

& Measurement frigger

+ « Measurement conditi...

— «, Communication chan
Email
erc OPC UA server
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+ [ Device
(E) Bearings
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& Actions
Create new measurement job
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" Measurement data
A Live view

@ Configuration
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Communication channels

Name : Email

SMTP server :

Proxy server:

Connected to : SmartCheck 38 ®
Logged in as : admin
Help =
=
Changed : 2019-12-18 19:58:59

Created : 2019-12-18 19:58:59
() Changed by : admin

Server name : 10.160.0.201 Server name : -
Server port : 25 Server port : -
Encryption protecol : None Authenfication type : -
Email sender address : name@email. com User name : -
Username : -
Maximum message size (MB): 5
Maximum number of attachments : 100
# Edil Delete + Add
Outputs for communication channel : Email
Name Recipients Subject Data type Alarm... Start time point Repetition <&
4 Condition ... ConditionMonitoring@e... CM News: S{idevice_name} w... Current values Yes 2019-12-18 08:00:00 1 day(s)
Measurement jobs Characteristic values Time signals Classification data
Base measurement job o W
Default configuration S o
Device alarm status S
# Edil Delete ¥r Creale

Click on an email communication channel to access the following information and functions in the main panel:
Communication channels
Here you can find the basic information and functions for the selected email communication channel:
¢ Alongside the name you will find details of the SMTP server with which the emails should be sent.
You can also see the details of the proxy server used, if one is configured.

. N you select the email communication channel, this symbol is updated to show whether email
communication is working or not:
Green symbol: Indicates problem-free communication.
Red symbol: Indicates a problem with the communication. In this case you will see an error
message[118] if you hover the mouse over the symbol.

To update the symbol again, click on <.

e Click on “* to test the email communication channel.

e Click on Add

Adding/editing an email communication channell3).

to add an email communication channel. For more details, please refer to

e Click on Edit 7 to edit the email communication channel. For more details, please refer to
Adding/editing an email communication channell:2).

e You can also delete the email communication channel. To do so, click Delete

and confirm with OK.

e In the top right corner, click on H o open the Configuration overview[s™.
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The SmartCheck or ProLink device supports a maximum of one email communication channel.

If you have already configured an email communication channel, the Add button ™ now
only enables you to add controllers[ 113\

Outputs for communication channel: email

With an email output, you define when and how the email is triggered, the recipient(s) of the email, the
text of the email, and which data is included in the attachment.

If you have already created outputs for the email communication channel, the Outputs for
communication channel area contains the following information:

The table below shows the most important details of the email output. These include the name of the
email, its recipients, the subject, and information about the attachment (data type, alarm) and the
triggers (start time, repetitions).

Click 4 at the beginning of the line to display the attachments that are defined for the selected email
output.

Click on Edit # to edit the selected output using the wizard. More details are available in
Creating/editing outputs for an email communication channellu:.

Click on Create 7 to create a new output with the assistance of the wizard. More details are available
in Creating/editing outputs for an email communication channell .2\

You can also delete the outputs. To do so, click Delete and confirm with OK.

8.7.1.2 Adding/editing an email communication channel

To enable the emails to be sent via the SmartCheck or ProLink device, you must create an email communication
channel and tell the SmartCheck or ProLink device the details of the SMTP server to use for sending emails and, if
applicable, the details of the proxy server used.

How to create an email communication channel

1. Under Communication channels, click on Add ™ to open the wizard. This guides you through the creation of
the email communication channel in three steps.

2. In the first step, select the email communication channel type.

4

The SmartCheck or ProLink device supports a maximum of one email communication channel.
If you have already configured an email communication channel, you can only select
controllers[ 113 here.

3. In the second step, enter the necessary information about the SMTP server used to send the emails:
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Add communication channel

Schaeffler SmartWeb

Steps Step: Configure the email server

1: Select communication channel
type

2: Configure the email server

3: Configure proxy server

Description

Configure the SMTP server settings
for email dispatch here. Please
enter the server name and port, the
security seftings and authentication
data

Expert seifings

You have the following options:

Server name

Server port and encryption
protocol

Email sender address

Activate authentication

Maximum message size (MB)

Maximum number of
attachments

Maximum number of attachments : | 100

Servername | 10.160.0.201 (7]
Server port: | 25

Encryption protocol : | Mone -
Email sender address : | name@email.com

Activate authentication

Maximum message size (MB}): 5

LR

Connection test I:I 9

Back Mext Finish Cancel

Enter the name of the SMTP server:

e Full network name of the SMTP server, e.g. smtp.company.com
or

e IP address of the SMTP server

You can enter both internal as well as external SMTP servers.

Enter the port and encryption protocol of the SMTP server.

The server port automatically adjusts to the default port for the respective
encryption protocol:

e 25 for encryption protocol None
e 587 for encryption protocol StartTLS
e 465 for encryption protocol SSL

You can manually change the server port. If you change the encryption
protocol following a manual change of the server port, the server port no
longer switches automatically to the default port.

Enter the email address that you want to appear as the sender of the
SmartCheck or ProLink email. Replies to the email will be sent to this address.

Activate this option if your SMTP server requires authentication. You will then
have to enter the user name and password.

The Show password option is provided to facilitate the input. Once you have
confirmed the password, it is no longer visible.

Determine the maximum size of the email in MB.
Emails that exceed this size are split into multiple emails.

Determine the maximum number of email attachments.
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Connection test

Configuration

If this number is exceeded, the attachments are distributed between multiple
emails.

Click on this button to check the connection to the SMTP server. Depending
on the result, a red or green symbol appears:

¢ Green symbol: Indicates problem-free communication.

¢ Red symbol: Indicates a problem with the communication. In this case will
you see an error message[118) if you hover the mouse over the symbol.

e If you enter a name instead of an IP address under server name, and if in the network
g settings/ 152 for DHCP mode the option No DHCP is selected, you must also enter a
DNS server in the network settings. This is necessary so that the specified server name
can be resolved.

e Some SMTP servers automatically create their own sender address. The recipient then

sees the sender address set by the SMTP server, and not the email sender address
entered here. Replies to the email still reach the original email sender address.

In the third step, you can enter details for the proxy server, if applicable:

Add communication channel

Schaeffler SmartWeb

Steps Step: Configure proxy server

1: Select communication channel
type
2: Configure the email server

3: Configure proxy server

Description

If your server can only be reached
via a proxy server, you can enter
the commesponding details here.

Expert seftings

You have the following options:

Use proxy server

Server name

Use proxy server 0

Connection test I:l 9

Back Finish Cancel

Select this option if you need to specify a proxy server in order to leave the
company network.

Enter the name of the proxy server here:

e Full network name of the proxy server, e.g. proxy.company.com

or

e IP address of the proxy server
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Server port Enter the TCP port of the proxy server here.

Authentication type Determine the type of authentication of the proxy server. For the options
Basic and NTLM, you must also specify the user name and password.

The Show password option is provided to facilitate the input. Once you have
confirmed the password, it is no longer visible.

Connection test Click on this button to test the connection to the proxy server. Depending on
the result, a red or green symbol appears:

¢ Green symbol: Indicates problem-free communication.

¢ Red symbol: Indicates a problem with the communication. In this case wil
you see an error message[118) if you hover the mouse over the symbol.

5. Click Finish to save the communication channel for the controller.

¢ If you enter a name instead of an IP address under server name, and if in the network
l:'# settings/ s for DHCP mode the option No DHCP is selected, you must also enter a
DNS server in the network settings. This is necessary so that the specified server name
can be resolved.

e For detailed information about the configuration data for the proxy server, contact your IT
department or system administrator.

How to edit the email communication channel

1. Select the email communication channel in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit 7" Make the required entries in the
respective steps of the wizard.

3. Click on Finish to apply your changes.

8.7.1.3 Adding/editing outputs for the email communication channel

For an email output, configure the email that is sent. You define when and how the email is triggered, the
recipient(s) of the email, the text of the email and which data is provided in the attachment. You can create
multiple email outputs.

How to create the outputs for the email communication channel
1. In the expanded overview on the left, click on the email communication channel.

2. Under Outputs for communication channel: email, click on Create o open the wizard. The wizard will
guide you through the three steps of the creation process.

3. The first step is to configure the e-mail settings, including the name, recipients and the text of the e-mail:
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Edit outputs

Schaeffler SmartWeb

Steps Step: Configure email setfings

1: Configure email settings

2 Select email data Name : | Condition Menitoring Department e
3. Configure email frigger
Recipients : | ConditionMonitoring@email com e
Subject : | CM Mews: S{device_name} with ${alarm_siaie} .- 9
This is an automatically generated email frem the vibration monitoring system e
S{device_name}.
Description
Cenfigure email settings here. Confent : ...
Specify the name, email recipients
subject and content of the email
Language : | |3 English (Great Britain) - e
Expert seftings MNext Finish Cancel

You have the following options:

Name Enter the name under which the email output is to appear in the system.

The name can be up to 50 characters long and must be different from all
names already in use.

Recipients Enter the email addresses to which the email should be sent. You can enter up
to 200 characters. Use commas to separate multiple email addresses:
namel@company.com, hame2@company.com

Subject Enter the text of your choice as the subject of the email. You can enter up to

200 characters.

To the right of the input field, you will see a selection list with text
variables. You can use these variables, for example, to automatically include
the device name or serial number in the subject line.

Content Enter the text of your choice with @ maximum of 5000 characters as the
content of the email.

To the right of the input field, you will see a selection list with text
variables. You can use these variables, for example, to automatically include
the device name or serial number in the subject line.

Language Here you can select the language in which the text variables in the email sent
are to be displayed.

This setting only affects the text variables. The subject and content appear
in the email exactly as you have entered them.

4. Click on Next to move to the second step. Here you select the email data to be included as an attachment:
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Edit outputs

Schaeffler SmartWeb

Steps

1: Configure email settings
2: Select email data

3. Configure email frigger

Description

Select the data to be sent with the
email as an attachment. If you do
nof select any email data, the email
serves only as nofificafion that the
device and email connection remain
achive.

« Expert setfings

Step: Select email data

Data transfer mode : | Transmit most recently computed values - e

Measurement job

Base measurement

s - Characteristic values Time signals Classification data - e

job v v

Configuration par défaut

Default configuration vl v

Device alarm status

Measurement triggers and conditions

You have the following options:

List of measurement jobs

Expert settings:
Data transfer mode

Back MNext Finish Cancel

Here you can define for each measurement job whether characteristic

values, time signals, or classification data (special version) are to be sent

as

an attachment.

Select this option at the bottom left to display the data transfer mode

se

lection list above the measurement jobs. You have the following options:

Transmit most recently computed values: only the current values are
transferred.

Select this option if you have a permanent connection to the Internet and
always want to be informed about the current situation.

Mass transfer of saved values: the data saved in the device (trends, time
signals, classification data) is sent.

Select this option if you want to transfer data in larger blocks, for example,
because the SmartCheck or ProLink device only has intermittent access to
the Internet.

If you do not select any data, the email will be sent anyway. In this case, the email provides
g information that the SmartCheck or ProLink device and the email connection are intact.

5. Click on Next to proceed to the third step. Here you configure the email initiator. You can use a time-

controlled trigger and/or an alarm-based trigger:



Edit outputs

Schaeffler SmartWeb

Steps

1: Configure email settings
2: Select email data

3: Configure email trigger

Description

Cenfigure when to send your email
here. Sending can be triggered
either at regular intervals, on
lternation of the alarm status or
both. You must configure at least
one friggering variant

« Expert setfings

Configuration

Step: Configure email frigger

Minimum time between two alarm emails : | 1

You have the following options:

Send email at intervals

Send email if system event

occurs

Send email if there is a
change in alarm status

+ Send email at intervals e

Start date :| Dec v || 18 || 2018

v
Start time : | §:00
Repetition interval : | 1

day(s) -

Minimal alarm status : | Pre-alarm A

®®

' Send email if alarm status changes

- |
- || hour(s) A

Back Finish Cancel

Select this option to send the email based on regular time intervals. You have

the following options:

Start date and start time: Enter the time at which the email should be
sent for the first time.
Repetition interval: Define the regularity with which the email is to be

sent. You can enter the interval in minutes, hours, days, weeks and
months.

Select this option to send the email when a system event is triggered. You

have the following option:

Minimum time interval between two event emails: Use this option to
set the minimum time between two alarm emails. This enables you to
prevent too many emails from being sent if there are frequent events.

If you select the option As often as possible, an email is sent with every
system event.

Select this option to send the email when the alarm status changes in one of
the selected measurement jobs. You have the following option:

Minimum time interval between two alarm emails: This option lets you
specify the minimum time that elapses between two alarm emails. This
enables you to prevent too many emails from being sent if the alarm status is
subject to frequent changes.

If you select the option As often as possible, an email is sent with every
change of alarm.

6. Click on Finish to close the wizard and confirm the email output.

If you set the start date to the 31st of a month, in shorter months the email will still be sent
l; on the last day of the month.
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How to edit the outputs of the email communication channel

1.

In the expanded overview on the left, click on the email communication channel.

2. Under Outputs for communication channel: email, click on Edit 7to open the wizard.

3.

Make the desired changes with the assistance of the wizard and confirm them by clicking on Finish.

8.7.1.4 Error messages during connection test

The Communication channels area and the wizard for adding the email communication channel feature buttons
to test the connection to the SMTP server or proxy server. If the test was unsuccessful, move the mouse over the
red symbol to learn more about the error and receive recommendations for action.

The following messages may appear: Click on a link to jump to the corresponding location in the manual:

The server name of the SMTP server cannot be resolved. Please check the server name[ud\.

The connection to the SMTP server has failed. Please check the port or the encryption protocoll11d).
The SMTP server is responding with an incorrect protocol. Please check the encryption protocoll 0.
The authentication on the SMTP server has failed. Please check your user name and password[110).
The SMTP server is unavailable.

The proxy server name cannot be resolved. Please check the server name[wu1).

The connection to the proxy server has failed. Please check the port or the encryption protocoll1i2).
The authentication on the proxy server has failed. Please check your user name and password 112\,

8.7.2 Communication channel for controllers

Industrial plants use controllers that contain data such as process parameters; this data is extremely useful for

vibration monitoring purposes. In the #» Communication channels (controllers)[1:7) area, you can integrate this
data into the monitoring using the Schaeffler SmartCheck or ProLink device, and render controller data from the
Schaeffler SmartCheck or ProLink device accessible. In order to avail of this potential, the following steps must be
taken:

The controller that you would like to integrate must first be added as a communication channell1:9). In doing so
you essentially define the name of the controller and how the Schaeffler SmartCheck or ProLink device can
connect with the controller via your network.

It is also possible to configure station forwarding in the Schaeffler SmartWeb software for accessing the remote
controller in the internal controller network.

For problem-free communication between the controller and the Schaeffler SmartCheck or ProLink device, there
must be an Ethernet connection between the two. You must also configure the correct settings for the IP
address, net mask and the gateway, if applicable.

If multiple Schaeffler SmartCheck or ProLink devices are to communicate with one controller, an individual port
must be reserved in the controller for each device.

If you would like to read data from the controller, you must create one or more inputs for the controller[120). For
this type of input, you can determine how often and from which controller registers the data is read, as well as
the value range. You also specify the signal unit and signal value range to which the register data is to be
converted.

For each controller, you can set up as many inputs as you wish and use them in the SmartWeb software in
exactly the same way as you use the inputs found in the Input configuration[e area; inputs are available for
the controller in relation to measurement jobs[ 74", measurement conditions10d) and measurement triggers[iof in
particular.

If you would like to make controller data from the SmartCheck or ProLink device accessible, you must create a
configuration file with outputs for the controller[123). Here, you define the update frequency and the
characteristic values for which the alarm status and/or a value is relayed, as well as the controller register to which
the information is written.
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At the present time, the only communication channels that you can integrate are Mitsubishi
g controller families that support the SLMP (3E-Frame) protocol and which are connected to
the Schaeffler SmartCheck or ProLink device via Ethernet. These are the following controller

families:

e System Q

e L series

e System Q and L series via SLMP gateway

There are plans to offer support for additional controllers; for more information, contact your

customer support representative.

8.7.2.1 Communication channel for controllers area

In the Communication channels area, the expanded overview on the left shows the controllers that you have
created for the SmartCheck or ProLink device. In the right-hand main panel, you will find basic details about the
currently selected controller as well as information on its inputs and outputs, if these have been created:

Schaeffler SmartWeb

File w Edit ¥ Measurementdata v Goto ¥

Configuration Communication channels

Name Name : PLC_013
— |8 Configuration

Device type : Mitsubishi controller Metwork number : -

Connected to : SmartCheck 386 ®
Logged in as : admin
Help w
=]

Changed : 2019-12-17 12:23.04
Created : 2019-12-17 10:27:19

+ =31 Input configurations - D Changed by : admin
put configurations IP address - 172.28 205.122 Station number : -
+ (& Measurement jobs Port 1280 Register with version number : D1200
+ ¢ Output configurations Transf:[ror;z;oel ;ﬁ:w Configuration version : 5 i
& Measurement trigger
+ & Measurement conditi...
— =, Communication chan...
Email / Edil Delete t+ Add
ore OPC UA server
_‘_ PLC_013 Inputs for communication channel : PLC_018
+ [®] Device
(@ Bearings Name Start register Reg. t... Polling interval Min, signal Max. signal  Unit Min. reg. value Max. reg. val...
wa| Bearing manufacturer Velocity from PLC_018 D1000 WORD 1.0s 0.0 163,837 [RPM] 0.0 10,000
& Actions 7 Edit Delete b Add
Create new measurement job
& Areas Outputs for communication channel : PLC_018
& Staius Register Register name Measurement job Characteristic value Type Update interval
" Measurement data D1201 s_communication_status Communication status Status 600 s ~
’\N‘ Live view D1202 a_device_status Device alarm status Device alarm status Alarm 600 s I
01203 a_crest_factor_acceleration_imp Default configuration Crest factor - Acceleration (Impul...  Alarm 600 s
@ Configuration 01204 ¢_crest_factor_acceleration_imp Default configuration Crest factor - Acceleration (Impul... Value 60.0 s
‘.; User management 1206 a i=n1DA1A 1 10h7 1khz velocity  Default confinuration IS0INE16-1 (10H7 - 1kH71 - Veln Alarm IEVES v
) Logout 7/ Edil Delete

Complete

Click on a controller in order to access the following information and functions in the main panel:

Communication channels

Here you can find the basic information and functions for the selected controller:

¢ In addition to Name, Device type and IP address, basic settings for addressing the device can be
found here. You can find the change details for the controller in the grey box at the top right.

¢ Network number and Station number are details required for station forwarding, if this is defined for

the controller.

¢ Register with version number relates to the configuration file with outputs that you have created
for the controller: here you can find the register into which the version of the configuration file
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4

(Configuration version) is written. This number functions as a safeguard[128) against unintentional
overwriting of the register.

. you select a controller, this icon is updated; it indicates whether communication with the
controller is functioning or not: a green icon indicates problem-free communication. If the icon is red,
there is a communication problem. In this case you see an error message if you hover the mouse over
the icon.

To update the icon again you must click on e
Click on 2 to test the connection to the controller.

Click on ¥ to download the configuration file. When you have created outputs for the controller[123),
you need this file in order to prepare the controller for the data transfer.

Click on Edit # to edit the controller. For details, please refer to Adding/editing a controller[:21.

Click on Add ™ to add further controllers. For details, please refer to Adding/editing a
controller1:3.

You can also delete the selected controller. To do so, click Delete and confirm with OK.

In the top right corner, click on H o open the Configuration overview[s.

A controller that you have integrated into a measurement job[ 741 cannot be deleted. In this

case, the Delete button is deactivated. To delete this controller, you must first delete
the measurement job in which it is used.

Inputs for communication channel

This table provides an overview of the inputs that you have created for the selected controller. When
you select a controller, the following information and options are displayed here:

e The table contains information on the relevant inputs, in addition to the Name e.g. also the register in

which the controller starts reading the data (Start register), the signal value range into which the
data is translated (Min. signal to Max. signal) and the register value range it covers (Min. reg. value
to Max. reg. value).

« Click on Edit #" to edit the input. For details, please refer to Adding/editing a controller input[22.

e Click on Add ™ to add further inputs. For details, please refer to Adding/editing a controller

input[h.

e You can also delete the selected input. To do so, click Delete and confirm with OK.

o

An input that you have linked to a measurement job[74" cannot be deleted. In this case, the

Delete button is deactivated. To delete this external device, you must first delete the
measuring job in which it is used.

Outputs for communication channel

You can use characteristic values that are calculated in the SmartCheck or ProLink device to transfer their
alarm status and/or values to a controller. To do this, create a configuration file with outputs and transfer
the alarm status and/or value of selected characteristic values via this file to the controller.

If you have already created outputs for the controller, the following information can be found in the
Outputs for communication channel area:

The table indicates the characteristic values for which the alarm status and/or value (Type) is
transferred to the controller, how often this happens (Update interval) and the register into which
the information is written.

Click on Edit # to edit the outputs with the assistance of the wizard. For more details, please refer to
Creating/editing controller outputs/s\.

Click on Create 7 to create the outputs with the assistance of the wizard. For more details, please
refer to Creating/editing controller outputs/ 23

You can also delete the outputs. To do so, click Delete and confirm with OK.
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e After you have created or edited the controller outputs in the SmartWeb software, you
g must transfer the corresponding information to your controller. For details, please refer to
the section Integrating a controller into the system[i:s).

¢ If you want to use the Schaeffler SmartUtility software (optional) to download a
configuration from the SmartCheck or ProLink device and send this to other devices, the
outputs for the controller are not included in the transfer. This prevents multiple
Schaeffler SmartCheck or ProLink devices from writing to the same controller register. In
this case, please import the configuration file with the outputs manually, as described in
the section Integrating a controller into the systemlw:s).

8.7.2.2 Adding/editing a controller

In order to be able to receive the data from a controller as an input signal, you will need to set up the relevant
controller as a communication channel and communicate the network data of the controller to the SmartCheck or
ProLink device.

How to create a communication channel for a controller

1. Under Communication channels, click on Add ™ to open the wizard. The wizard will guide you through the
process of creating the communication channel in two steps.

2. In the first step, under Communication channel type, select the controller for which you are creating the
communication channel. Currently, you can only integrate Mitsubishi controller families/ 117 that support the SLMP
(3E-Frame) protocol.

3. Click on Next to move to the second step. Here you must enter the required details for the controller:

Edit communication channel

Schaeffler SmartWeb

Steps Step: Configure Mitsubishi Controller (SLMP)

1: Select communication channel
type Name:| PLC_013 (7]
2: Configure Mitsubishi Controller
[SLMP)
IP address : | 172.25.205.122
Port:| 1230

Stafion forwarding

Protocol : | TCP -

Transfer mode : | Binary hd

Connection test I:l 9

Description

Configure the settings for the
Mitsubishi Confroller here. Please
enter the server name and port, and
the protocol details

Expert zettings Back Finish Cancel

You have the following options:

Name Enter the name with which the controller is to appear in the SmartWeb
software.
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IP address

Port

Station forwarding

Protocol
Transfer mode

Connection test

Enter the IP address under which the controller can be accessed in your
network.

Enter the port via which the connection to the controller is established.

Activate this field if you would like to forward the communication to another
controller via the IP address specified above. In this case you must also specify
the following:

Network number: specify the network number of the remote controller here.
Station number: specify the station number of the remote controller here.

Example:

In order to access the PLC 3 controller, specify the following:

- the IP address of PLC 1

- the network number and station number of PLC 3:
[Realtima) network between controllers

PLC 1 PLC 2 PLC 3

Marmal nelwork
with TGP/IP

SmartCheck

The data from the Schaeffler SmartCheck or ProLink device is then forwarded by PLC 1 to
PLC 3 via the realtime network.

Enter the Network protocol and the Transfer mode for transferring data
between the Schaeffler SmartCheck or ProLink device and the controller.

Make sure that your selection here matches the settings in the controller.

Click on this button to check the input connection data. If the test is
successful, the box next to the button turns green; otherwise it appears in
red.

If you hover the mouse above the red box you will also receive a message
explaining why the connection is not working.

4. Click Finish to save the communication channel for the controller.
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e For the connection between Schaeffler SmartCheck or ProLink and the controller to work,
Eﬂ the IP addresses of both devices must be in the same range. That means that - depending
on the net mask - the first three numbers of the four-digit IP address must be identical.
You can also access the controller with the Schaeffler SmartCheck or ProLink device via a
gateway. If you have any questions regarding this, contact your network administrator.

o If the IP address of the controller is outside the IP range of the Schaeffler SmartCheck or
ProLink device, but is accessible via a gateway, proceed as follows:

1. Open the Schaeffler SmartUtility Light or Schaeffler SmartUtility software (optionally
available).

2. Click on Configure sensor(s).
3. In the first step in the wizard, select the Schaeffler SmartCheck or ProLink device.

4. In the second step in the wizard, specify the gateway for the Schaeffler SmartCheck or
ProLink device.

5. Close the Wizard with Send.

You can obtain more detailed information about creating a gateway from your system
administrator. For details on working with the Schaeffler SmartUtility software, refer to the
relevant manual.

e The combination of IP address and port must be unique. If you need more combinations —
for station forwarding, for example — you must enable more ports in the controller as
appropriate.

How to edit the communication channel for a controller
1. Select the controller in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit 7" Make the required entries in the
respective steps of the wizard.

3. Click on Finish to apply your changes.

8.7.2.3 Adding/editing inputs for controllers

The Schaeffler SmartCheck or ProLink device receives information about process parameters in the controller via
controller inputs.

How to create inputs for the controller
1. In the expanded overview on the left, select the controller for which you would like to add an input.

2. Under Inputs for communication channel: [Name of the controller], click on Add
3. In the Add input window, make the desired entries:
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Edit input

Schaeffler SmartWeb

Name:| Velocity from PLC_013
Start register: | D1000 (7]
Register type : | WORD - Q
Unit group : | Frequency/speed * | Unit:| RPM - e
Polling interval : | 15 - e
Signal value : RPM
Max. [RPM] : 200ss
163,837
150E3
Scaling :
16.38 he3
Min. [RPM] :
0.0 502
2E3 4E3 E3 8E3 E
Min. register Max. register
e value : value :
0.0 10,000
OK Cancel

You have the following options:

Name

Start register

Register type

Unit group and
Unit

Polling interval

Here, specify the name that the input is to appear under in the SmartWeb
software.

Specify the register here that is to be read out. If you choose a data type
under Register type for which two registers must be read out, Start
register refers to the lower of the two registers. This is where the readout
starts.

This is where you specify the data format to be used in the Start register or
in the register closest to the start register. This specification defines:

e whether one register (16 bits) or two registers (32 bits) are read out and
e how large the maximum register value range can be.
The selection options available have the following formats or register value

ranges:

INT 16 bit -32,768 to 32,767

WORD 16 bit 0 to 65,535

DINT 32 bit -2,147,483,648 to 2,147,483,647
DWORD 32 bit 0 to 4,294,967,295

REAL 32 bit +1.5 * 10% to +3.4 * 1038

This is where you specify the physical value and measurement unit into which
the value from the controller is to be converted.

This is where you specify how often the value is to be queried from the
controller.

A long poliing interval is sufficient for values that only change slowly e.g. the
temperature. This can reduce the amount of data and the load on the
controller.
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The logbook message "Connection refused" indicates
that the Schaeffler SmartCheck or ProLink device is

E,# attempting to connect to the controller again, although
the last connection is not yet complete. You can
prevent this from occurring by increasing the polling
interval.

Register value Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Signal value Use these settings to determine the range within which the measurement
values should lie. First enter a minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

4. Click on OK to save the new input.

Example:

The register R100 is defined as WORD in the controller. The entire numerical range from 0 to 65,535 is
limited to the range from 0 to 10,000. This range corresponds to a speed of between 0 and 3000 RPM.
Your settings are then the following:

Start register R100

Register type WORD

Unit group Frequency/speed
Unit RPM

Min. register value 0
This value is set automatically.
Max. register value 10,000
The number 65,535 is set automatically and you will need to adjust it manually.
Max. signal value 3000 (RPM)
Min. signal value 0 (RPM)

How to add a scaling factor to the input

You can add scaling factors to the input, which you can access e.g. when creating a measurement job[7". Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:

1. Speed in front of the gear

2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, select the required input under Inputs for communication channel: [Name].
2. Click on P to expand the list of scaling factors.

3. Clck on ™ to open the Add scaling factor window:
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Add scaling factor

Input channel :
21G830 - Rotational speed before gear

Name :
Speed before gear

Scaling factor :

02
Unit :
RPM v
QK Cancel

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the

unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.

To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

Inputs for communication channel : 21G830

Name Start register Reg.t... Polling interval Min. signal Max. signal Unit Min. reg. value Max. reg. val...

4 Rotational speed bef... RO INT 1.0s -32,768 32,767 [Hz] -32,768 32,767

Additional scaling factors
Speed before gear 0.2x RPM

/  Edit

Delete

4 Live view

/' Edil — + Add

You can also switch to the live view[s" area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
g you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

How to edit the input of a controller

1.
2.

In the expanded overview on the left, select the controller whose input you would like to edit.

In the table, under Inputs for communication channel: [Name of the controller], selected the desired
input.

Click on Edit #  and make the desired entries in the Edit input window.

Click on OK to accept your changes.
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8.7.2.4 Adding/editing outputs for controllers

CAUTION Only create a configuration file with outputs for the controller if you are certain that the
register area to be written to is free, and that it is not used in the controller program.
Otherwise, it is possible that the Schaeffler SmartCheck or ProLink device may overwrite
important data in your controller.

You can use the outputs to define the characteristic values whose alarm status, value, and/or alarm limit is
transferred to the controller. Here, you can also determine the registers of the controller that will be written to in
this process. In addition, you require certain information from the outputs to prepare your controller for the writing
process. For more details, refer to the relevant section of the chapter Integrating a controller into the
system[ 23\,

If you have created the configuration file with outputs successfully and have also prepared the controller
appropriately, the Schaeffler SmartCheck or ProLink device can write the following values for each characteristic
value into the relevant controller register:

Value Abbreviation Meaning
0 unknown The characteristic value has not yet been measured.
1 no_alarm Alarm status: No alarm — marked in green in the Schaeffler

SmartWeb software.

2 pre_alarm Alarm status: Pre-alarm — marked in yellow in the Schaeffler
SmartWeb software.

3 main_alarm Alarm status: Main alarm — marked in red in the Schaeffler
SmartWeb software.

4 charval_error An error occurred when calculating the characteristic value; it is
possible for example that no rotational speed was determined,
even though this is necessary for the characteristic value.

How to create the outputs for the controller
1. In the expanded overview on the left, select the controller for which you would like to create the outputs.

2. Under Outputs for communication channel: [name of the controller], click on Create W to open the
wizard. It will guide you through the creation process in two steps.

3. In the first step, you must select registers and characteristic values:
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Edit outputs

Schaeffler SmartWeb

Steps

1: Select registers and
characteristic values

2: Specify register names

Description

Here you can determine the from
which registry in the controller
information is written. *You can also
select the characteristic values
whaose alarm status, value andior
alarm limits are to be fransferred

Expert seftings

Step: Select registers and characteristic values

Start register : End register :
01200 01207

Update interval :
60 = -

Characteristic value selection :

Available characteristic values Alarm status Value
— & Default configurafion

& system temperature sensor

@& RMS broad band - Demodulation (Overall status)

@& RMS broad band - Accelerafion (Overall status) i

& Crest factor - Acceleration (Impulses) v v

& 1S010816-1 (10Hz - 1kHz) - Velocity o

@& Peak2peak - Acceleration (High vibration values)

& Periodic value - Demodulation {recurring anomalies)

& Periodic value - Acceleration (recurring anomalies)

@& Temperature

MNext

You have the following options:

Start register

Update interval

Characteristic value

selection

Alarm status/alarm limits

Alarm limits

®

Cancel

This is the point where you specify the first register of the register block in

which the alarm status is to be stored.

The version number of the configuration file is stored in this first register with
the outputs; the alarm statuses and/or values of the selected characteristic

values are written into all subsequent registers.

This is where you specify how often the alarm statuses and/or values are to be

transferred to the controller.

This is where you select the characteristic values whose alarm statuses and/or

values are to be transferred to the controller. The characteristic values available

here depend on the measurement jobs[74" that you have created.

Select here if you want to transfer the alarm status, value, and/or the alarm

limit of the characteristic value to the controller for every characteristic value.
You can only transfer the communication status, the device status and the
overriding alarm characteristic value ("basic configuration" here, for example) as

alarm statuses. You can then only select the device status if at least one other

characteristic value transfers an alarm status.

The alarm limits cannot be selected until the value

g' and/or alarm status has been selected.

Measurement triggers and measurement conditions cannot be selected as a configuration for

g' an output.

4. Click on Next to move to the second step. This is where you specify the register name:
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Schaeffler SmartWeb

Steps Step: Specify register names

1: Select registers and characteristic

values Register names :

2: Specify register names
Measureme...

Default confi...
Default confi...
Default confi...
Default confi...

Description

This iz where you specify the

names that should be used in the

controller. Cnly the characters A-Z

a-z, 0-9 and '_" are permitted. The
first character must be a letter.

Expert seftings

Characteristic value
Communication stafus

Device stafus

Crest factor - Acceleration (Impul...
Crest factor - Acceleration (Impul...
13010816-1 (10Hz - 1kHz) - Velo...

RMS broad band - Acceleration |...

Configuration

Register with version number : D1200 e

Type Va Register Va Register name

Status D1201 s_communication_siatus

Alarm  D1202 a_device_status

Alarm D203 a_crest_factor_acceleration_imp

Value D204 c_crest_factor_acceleration_imp

Alarm D206 a_iso10816_1_10hz_1khz_velocity ~

Alam  D1207 a_rms_broad_band_acceleration_o ~
w
r

Back Finish Cancel

Under Register names, you can use the relevant register as a variable in the GX Works2 software.

As far as possible, the register names in the table are generated automatically from the characteristic value names.
The sequence of the entries can be edited by selecting one or more entries and moving them up or down with

the arrow keys. You can update the register with update ¥2. The characteristic values are sorted alphabetically
by measuring task name and characteristic value name. You can edit any name by double-clicking on the relevant
ine. The following naming conventions apply:

e The name must be input in ASCII format.

e A-Z, a-z, 0-9 and _ are allowed characters

e The first character must be a letter.

e The number of characters must be between 1 and 32 at most.
5. Click on Fnish to close the wizard and confirm the configuration with outputs.

6. To guarantee problem-free communication, you must also transfer the configuration file with outputs to your
controller. In the controller's programming environment, the registers into which the Schaeffler SmartCheck or
ProLink device will write the alarm status, values, and/or alarm limits is marked as 'reserved'. For details, please
refer to the section Integrating a controller into the system[:24\.
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e The Register with version nhumber contains the current version number of the
g configuration file with outputs. This information functions as a safeguard against

unintentional overwriting of registers: when the configuration file has changed in such a
way as to affect the configuration of the controller, the version number for the controller
in question is immediately incremented. This means that the version number in the
controller no longer agrees with the version number on the Schaeffler SmartCheck or
ProLink device. Alarm statuses and/or values can no longer be written into the controller,
and you will receive an error message.

The alarm statuses and/or values are not written into the controller again until you have
transferred the new configuration file to the controller (see section Integrating a
controller into the system/[123)).

e The characteristic value Communication status writes values into the controller that
provide information about communication problems between the Schaeffler SmartCheck or
ProLink device and the controller.

Value Abbreviation and meaning
0 communication_ok: No problems
1 error_configuration_inconsistent: The characteristic value structure on

the Schaeffler SmartCheck or ProLink device has changed; the data can no
longer be written into the controller at this time. In order to do this again,
the configuration file from the Schaeffler SmartCheck or ProLink device
must be downloaded again and read into the controller[ 25\

2 error_reading_values:The Schaeffler SmartCheck or ProLink device
cannot read one or more values from the controller, or the values are
incorrect. For more information, refer to the Logbook[ 42"

3 error_alarm_state_not_updated: The Schaeffler SmartCheck or ProLink
device cannot write one or more values to the controller. For more
information, refer to the Logbook[ 2.

How to edit the outputs of a controller

1. In the expanded overview on the left, select the controller for which you want to edit the outputs.

2. Under Outputs for communication channel: [name of the controller], click on Edit 7 to open the
wizard.

3. Make the desired changes with the assistance of the wizard and confirm them by clicking on Finish.

4, To guarantee problem-free communication, you must also transfer the changed configuration file to your
controller. For details, please refer to the section Integrating a controller into the system/[\.

8.7.2.5 Integrating a controller into the system

In the following sections you will find a detailed example of how to integrate specific controllers into the Schaeffler
SmartCheck or ProLink device as communication channels, and the steps required in order to initiate communication
between your controller and the Schaeffler SmartCheck or ProLink device. The following example is currently
available:

e Mitsubishi - GX Works2 software[ 123

In this section, you will find detailed information regarding how to prepare your controller for communication with
the Schaeffler SmartCheck or ProLink device and the settings in the Schaeffler SmartWeb software that are
required for this. Here is an overview of the necessary steps:

Set up communication settings in the controller

Create the controller in the SmartWeb software

Create inputs for the controller in the SmartWeb software

Create outputs for the controller in the SmartWeb software

Save the configuration file with outputs in the SmartWeb software

Import configuration file into GX Works2

Compile program and transfer it to the controller

These steps are aligned with the sample specifications you wil find in the Initial situation[129) section.
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Initial situation
The following communications parameters apply to your Mitsubishi controller:

IP address of the controller 172.28.205.122

Port (Host Station Port No.) Decimal: 1280 or hexadecimal: 0500
Network protocol TCP (MC protocol)

Transfer mode (Communication Binary

Data Code)

Station forwarding None

You would like to use the connection between the controller and the Schaeffler SmartCheck or ProLink device as
follows:

e You would like to read the rotational speed information from register D1000 of the controller. This register has

the WORD register type, and a possible value range 0-10,000, which should in turn be transformed to the 0-3000
RPM signal range.

¢ In addition, the Schaeffler SmartCheck or ProLink device must write the alarm status of the basic configuration

and the alarm status and value of the ISO characteristic value into the Mitsubishi controller registers. This writing
process must begin in register D1200.

8.7.2.5.1 Mitsubishi GX Works2 softw are

Step 1: create communication settings in the controller
First set all the parameters required for communication with the Schaeffler SmartCheck or ProLink device:
1. Start the GX Works2 software.
2. Click on Project > Open.
3. Open the project that contains the program for your controller.
4. In the navigation window, double-click on Parameter > PLC Parameter.
Q Parameter Setting

PLC Mame |PLC System |PLC File |PLCRAS |Boot File |Program |SFC | Device |10 assignment |Mulkiple CPU Setting  Builk-in Ethermet Port Setting |

~ IP &ddress Setting Open Sett
pen Setting

Input Format IDEC 'I
FTF Settirng |
P tiddrese | |

172]  zs] z05izz

Tirme Settifg

Subnet Mask Pattem | [ | [ |

Default Router IP Address | [ | [ |

Set ifitiz needed] Default / Changed |

5. In the Built-in Ethernet Port Setting tab, click on Open Setting.
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Built-in Ethernet Port Open Setting E

IP Address/Port Mo, Input Format  |DEC -

Pratacal Open Syatem TCP Connection HT:,S;[? :j'g.on II:)F'e;tldnd?ggg Dgztrltrﬁtfn
1 |UDF * |MELSOFT Connection = -
2 |TCP ¥ |MELSOFT Connection = -
3 |TCP ¥ |MELSOFT Connection = -
4 |TCP * [MELSOFT Connection = hd
5 |TCP ¥ |MELSOFT Connection  w A
6 |TCP ¥ |MELSOFT Connection  w hd
7 |TCP ¥ |MELSOFT Connection w hd
a |TCP ¥ |MELSOFT Connection = hd
9 |TCP » |MELSOFT Connection = hd
10 |TCF » |MELSOFT Connection = hd
11 |TCF * |MELSOFT Connection = -
12 |TCF ¥ |MELSOFT Connection = -
13 |TCF ¥ |MELSOFT Connection = -
14 |TCP * [MELSOFT Connection = hd
15 _|TCP > IMELSOFT Connection hd

|l 15 [TcP = [MCProtocol - - 1280 |

{*) IP Address and Port No. will be displayed by the selected format.
Flease enter the value according to the selected number.,

End Cancel |

6. Enter the following settings:
Protocol TCP

Open System MC Protocol

Host Station Port decimal: 1280 (corresponds to hexadecimal: 0500)
No.

7. Click on End to accept the settings.
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0 Paramekter Sekting E

PLC Hame |FLC System |PLC File |PLCRAS |Boot File |Frooram |SFC | Deviee |10 Assignment | Muliple CPU Setting  Buil-in Ethernst Port Setting |

— P Address Setting .
Open Setting |
Input Format IDEC 'I
FTF Setting |
P Asddress [ 172] 28] ewsfizz |
Time Setting |

Subnet Mask Pattern | [ [ [ |

Default Router IP Address | [ [ [ |

Setifitiz needed] Default /' Changed |

r— Communication D ata Code

' Binary Code

 ASCH Code

¥ Enable online change [FTP. MC Protocol)

[” Disable direct connection ko MELSOFT

[~ Do not respond o zearch for CPU [Built-in Ethemet port] on netwark

Print Window, .. | Print Window Preview | Acknowledge 2Y Assignment | Default | Check | End Cancel |

8. Under Communication Data Code, set the Binary Code transfer mode.

9. Activate Enable online change (FTP, MC Protocol) so that the Schaeffler SmartCheck or ProLink data can be
written into the controller.

10. Click on End.
11. Integrate the program into the Task.
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E.r'_.: MELSOFT Series GX Works2 E:\_a\lm\_"m\!FAG_SLMP_Test\neuw.gxw - [Task Setting Task_01 ] i [ m] 4|

! Project Edit Find/Replace  Compile  View Onlne Debug Disgnostics  Tool  Window  Help -9 X
NEASL e PiEmDe s RER SaRAS S e A S B
=S = e e d e i AN OIT | ) (APiEE S g
| o
i Navigation 7 x 5| POU [PRG] Program [Slj/ g Task Setting Task 01 | % ] 4 b -
C Camr C
1 _[POU
CF o B 2 B 1
[#- Parameter K] ]
--{jad Inteligent Function Module 4
I_} Global Device Comment 5
=1{§5 Global Label 5
% Globall 7
% Global_vars g
[=I-fim Program Setting 9
uﬂﬂ Initial Program 10
Elh‘ﬂﬂ 5can Program 1
= MAIN 12
- Task_01 1
- {gd) PoU 14
|;ﬂﬂ Standby Program 15
-{ |} Fixed Scan Program 16
uﬂﬂ Mo Execution Type 17
" pou 18
E||E5 Program 15
=-{gd) POU 20
-t Program 7
-5 Local Label 2
g FB/FUN 73
@ Structured Data Types 24
. -H% smartCheck_172_28_205_46_T
1[";"' Local Device Comment 2%
[+ Device Memory 27
Device Initial Value 28
29
m -
L IR 4| | ]
Enaglish Structured QO3UD Ul

12. Compile the program by selecting Compile > Rebuild All in the menu.
13. Transfer the program to the controller.

14. Restart the controller.

Continue configuring the controller in the Schaeffler SmartWeb software.

Step 2: Create the controller in the Schaeffler SmartWeb software

Under Communication channels, click on Add to open the wizard. The wizard will guide you through the creation
of the communication channel in two steps:

¢ In the first step, select the controller for which you want to create the communication channel.
e In the second step, enter the following details about the controller:
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Edit communication channel

Schaeffler SmartWeb

Steps Step: Configure Mitsubishi Controller (SLMP)

1: Select communication channel

type Name:| PLC_013 (7]
2: Configure Mitsubishi Controller
[SLMP)
IP address : | 172.25.205.122
Port:| 1250
Stafion forwarding
Protocol : | TCP -

Transfer mode : | Binary hd

Description

Connection test - 9

Configure the settings for the
Mitsubishi Confroller here. Please
enter the server name and port, and
the profocol details.

Expert setfings Back Finish Cancel
Name PLC_018

IP address 172.28.205.122

Port decimal: 1280 (corresponds to hexadecimal: 0500)

Protocol TCP

Transfer mode Binary

For further information on how to create a controller, please refer to the section Adding/editing a controller[:3.

You can click on the Connection test button to verify your entries: if the area next to it
g’ turns green your information is correct.

Step 3: Create inputs for the controller in the SmartWeb software

Under Inputs for communication channel: PLC_018, click on Add and enter the following settings in the Add
input window:
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Schaeffler SmartWeb

Name : | Velocity from PLC_018

Start register : | D1000 (7]
Register type:| WORD - 9
Unit group : | Frequency/speead * | Unit:| RPM = Q
Polling interval: | 1s - e
Signal value : RPM
Max. [RPM] : 20083
163,537 .
Scaling : -
16.38 100E3
Min. [RPM]
0.0 S0E
Min. register Max. register
e value : value :
0.0 10,000
OK Cancel
Name Speed from PLC_018
Start register D1000
Register type WORD
Unit group Frequency/speed
Unit RPM
Register value Change the value for Max to 10,000.
Signal value For Min, enter the value 0 and for Max, enter the value 3000.
For more information on how to create an input for the controller, refer to the section Adding/editing inputs for
controllers[1.
e If you have created inputs in the Schaeffler SmartWeb software, you can use the live
EJ view[s" to check whether data is being received by the Schaeffler SmartCheck or ProLink

device.
e This input can be used exactly like an internal input for measuring jobs

Step 4: Create outputs for the controller in the SmartWeb software

Under Outputs for communication channel: PLC_018, click on Create and enter the following settings in the
first step of the wizard:

134



Configuration

Edit outputs

Schaeffler SmartWeb

Steps Step: Select registers and characteristic values

1: Select registers and

characteristic values Start register : End register : 9
2: Specify register names 01200 D207
Update interval :
Gl s A e
Characteristic value selection : e
Available characteristic values Alarm status Value Alarm limits
— @& Default configuration A
Description @& sSystem temperature sensor
Here you can determine the from @& RMS broad band - Demodulation (Overall status)
};?c;cl'r':ln;?igollitirsf'.I"I:Irig?een.c?r'lg}ttzcc":r[l also @& RMS broad band - Acceleration (Overall status) v
\Sj_: zgteﬂ;Farcr':asr::;t‘tlesr.iS\}iacI'Lr:I::ds.’cr @& Crest factor - Acceleration (Impulses) v v
alarm limits are to be transferred @& 1S010816-1 (10Hz - 1kHz) - Velocity v
@& PeakZpeak - Acceleration (High vibration values)
& Periodic value - Demodulation {recurring anomalies)
@& Periodic value - Acceleration (recurring anomalies)
@& Temperature »
Expert setfings MNext Cancel
Start register D1200
Update interval This is where you specify how often the alarm statuses and/or values are to be
transferred to the controller.
Available characteristic Select the alarm status for the base configuration characteristic value and both
values the alarm status and value for the ISO 10816-1 characteristic value. To do this,

click on the box next to the characteristic value.

In the second step of the wizard, you can, if necessary, adjust the Register names that have been assigned
automatically. For more information about how to create a configuration with outputs for the controller, refer to the
section Adding/editing outputs for controllers[123).

Step 5: Save the configuration file with outputs for the controller in the SmartWeb software
1. In the =~ Communication channels area, click on the desired -‘-Controller (for example: PLC_018).

2. Click on ¥ Download to download the configuration file with outputs for the controller.
3. Open the configuration file:
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Schaeffler SmartWeb

File w Edit v Measurementdata ¥ Goto W

Configuration

Name
— |B Configuration
+ =31 Input configurafions
+ (& Measurement jobs
+ ¢ Output configurations
& Measurement trigger
+ & Measurement conditi
— o, Communication chan...
Email
orc OPC UA server
L PLC_ 018
+ [®] Device
(E) Bearings

wal Bearing manufacturer

& Actions
Create new measurement job

@ Areas

&% status

" Measurement data
A0 Live view

E Configuration

42 User management

U) Log out

Complete

Communication channels

Name : PLC_013

Device type : Mitsubishi controller
IP address : 172.28205.122
Port: 1280
Protocal - TGP
Transfer mode : Binary

Metwork number : -
Station number : -

Configuration version : 5

Connected to : SmartCheck 38
Logged in as : admin

N

Help =
B

Changed : 2019-12-17 12:23:04
Created : 2019-12-17 10:27:19
Changed by : admin

¢

Register with version number : 01200

# Edil — Delete + Add

Inputs for communication channel : PLC_018

Name Start register Reg. t... Polling interval Min. sig
Velocity from PLC_018  D1000 WORD 10s 0.0
# Edil — Delete + Add

Outputs for communication channel : PLC_018

Register Register name Measurement job Char|

D1201 s_communication_status Com

D1202 a_device_status Device alarm status Devi

01203 a_crest_factor_acceleration_imp Default configuration Crest

01204 ¢_crest_factor_acceleration_imp Default configuration Crest

D206 a isn10816 1 10hz 1khz wvelocity Default confinuration 1501
# Edil — Delets

3
(*SOFTCONTROL: ‘
VERSION:7.04.01%)
TYPE
SmartCheck 10_179_8_82 T:

STRUCT

config_version: INT:=1;
s_kommunikationsstatus: INT:=0;
a_peratestatus: INT:=0;
a_basiskonfiguration: INT:=0:
END_STRUCT:

END_TYPE

VAR_GLOBAL

SmartCheck _10_179_8_82 AT
@"%MW0.1000,2%MW0.1001,%eMW0.1002.2%MW0.1003
SmartCheck_10_179_8_82 T:
END_VAR

PROGRAM POU

)

(**)

VAR_EXTERNAL

SmartCheck_10_179_8_82: SmartCheck_10_179_8_82_T:
END_VAR

ST

BODY

MOVP( SM402, 1, SmartCheck_10_179_8_82.config_version };
END_BODY

END_PROGRAM

CONFIGITRATTION arCaonfionration -

4. Select the contents of the new window with CTRL+A, copy them to the clipboard with CTRL+C and insert
them into an editor (e.g. Microsoft Editor) with CTRL+V.

5. Save the file with any name and the extension .ASC (Example: SmartCheck or ProLink01. asc).

g

Step 6: Read the configuration file into GX Works2

¢

1. Click on Project > Open Other Data > Read ASC Format File.

2. Select the ASCII file (.ASC) you have just created and click on OK.

e If you use the Mozilla Firefox browser, you can save the file directly as an ASCII file with
the Save as function.

e Please make sure that the file has the extension .ASC so that it can be read by the GX
Works2 software.

Please create a backup copy of the existing project before importing the Schaeffler
SmartCheck or ProLink configuration file.

3. The Schaeffler SmartCheck or ProLink configuration file is imported and inserted into the tree as a new Global
Label with the designation Global_Vars.
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ﬁ MELSOFT Series GX WorksZ ...bishi'\Sonst Demosteuerung,FAGYFAG'\FAG_DEMO_Rack - [Global Label Setting Global_¥ars ]

i Project Edit  FindiReplace  Compile  Yiew Online  Debug  Diagnostics  Tool  Window  Help =0
WL AL L LY BRI TN Iy
EEEFEE T I I s Ry
i Navigation ax £ Local Label Setting POU_A1 [PRG] rﬁpou_m [PRE] Frogram [Structured./ &Lﬁlohal Label Setting Global... ] 40 -
M ] Class Label Mame Diata Type Constant Device ﬂ
; 1 |wAR_GLOBAL = |SmartCheck_172_26 205_46 |SmarCheck_172_26_205 467 | Detal Geting Detail 5
[P 2y (2 Gs 2| M z =
{3 Parameter 3 -
[} Inteligent Function Madule 4 -
Jl_} Global Device Camment 5 =
= Global Label g -
% Globalt 7 -
% Global_Vars 3 =
[#-fizg Program Setting q =
B4 ol 10 -
'_j Program 1 =
=4 POU_D1 12 -
4§ Program 13 -
: @ Local Label 14 =
{8 PoU 15 -
j FE/FLN 15 -
B Struckured Data Types 17 -
Local Device Comment 18 -
[+ Device Memary 19 -
----- Device Initial Yalue 20 =
A hd
......... o -
Jﬁ Project 23 A
24 hd -
L_..I User Library o | >|
= Systemn Label Operation *Tq reflect the cha
Connection Destination f
!i Change O Register Release system label databa
OEME Motification el | <]:' Dievice Mame Relation please save the pro
»
=« | |
Structured QOEUDEH Host Station Line 1 Cal. & L

The characteristic values along with the associated registers are displayed if you click in the Device column on
Detail Setting:

Structure Device Setting B

SmartCheck_172_2G_205_46
{SmartCheck_172_28_205_d46_T)

Label Mame Data Type Device Address 1=
conlig_wersion W ord[Signed] Rag Zhiw/2 98
device_status Word[Signed] F100 w2100
standardmeszaufgabe “Word[Signed] R101 Zhiw/2100
iz01 0816_1_10hz_1khz_g|'word[Signad) R102 b2 102
communication_status Word[Signed] Ra3 Zhiw/2.93

w
4| | »
¥ Automatic Filng ¥ Use Bit Designation Ol I Cancel |

Step 7: compile the program and transfer it to the controller
1. Compile the program by selecting Compile > Rebuild All in the menu.
2. Save the program and transfer it to the controller.

8.7.2.5.2 Mitsubishi GX IEC Developer softw are

Step 1: create communication settings in the controller

First set all the parameters required for communication with the Schaeffler SmartCheck or ProLink device:
1. Start the GX IEC Developer software.

2. Click on Project > Open.

3. Open the project into which the Schaeffler SmartCheck or ProLink configuration file is to be imported.
4. In the navigation window, double-click on Parameter > PLC Parameter.
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Q parameter setting

FLC narne |PLE zyzteni |PLE file |F'LI: RAS |Device |F'rc:gram |Boot file |SFE |I£D azzignment  Builtin Ethernet part

—IP address

|rpit Fiarmat I DEC j'

IP addrezs |

172 2g]

205]

127]

Subnet mask pattem [

Default router IP address |

5. In the Built-in Ethernet port tab, click on Open settings.

FTP zettings

I Open settings I

Time seftings

Setifitis needed] Default / Changed |

IP Address/Port No. Input Format  |DEC e

Protocol Open System TCP Connection H‘::rfﬁ:on ?:it; darzg: D;zf?;g?n
1 |UDP ¥ |MELSOFT Connection hd hd
2 |TCP ¥ |MELSOFT Connection hd hd
3 |TCP ¥ |MELSOFT Connection - -
4 |TCP ¥ |MELSOFT Connection - -
5 |TCP ¥ |MELSOFT Connection v v
6 |TCP ¥ |MELSOFT Connection i i
7 |TCP ¥ |MELSOFT Connection b b
a |TCP ¥ |MELSOFT Connection hd hd
g |TCP ¥ |MELSOFT Connection hd hd
10 (TCP ¥ |MELSOFT Connection - -
11 [TCP ¥ |MELSOFT Connection - -
12 [TCP ¥ |MELSOFT Connection - -
13 |TCP ¥ |MELSOFT Connection i i
14 |TCP ¥ |MELSOFT Connection i i
15 (TCP LIMFI SOFT Connection b -

I 16 |TCP v [MCProtocol - - 1280

(*) IP Address and Port Mo, will be displayed by the selected format.

Flease enter the value according to the selected number,

]

Cancel

6. Enter the following settings:

Protocol TCP
Open System MC Protocol
Host Station Port decimal: 1280

No.

7. Click on End to accept the settings.
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Q) parameter setting ll

FLC name IF'LC zpghem IF'LC file |F'LE RAS IDevice IProgram |Eoot file ISFC II.:’D azzignment  Built-in Ethernet port

—IP address

Open zettings |

|nput farmat I DEC ﬂ
FTF zettings

IP address [ 172 28] 2o8[ 122 —l
Time settings |
Subret mazk patterm [ [ [ [ |

Default router IP address | | | | |

Setif it is needed| Default / Changed |

r— Communication data code—

' Binary code

™ ASCI code

¥ Enable anline change [FTP, MC protacal)

[" Disable direct connection to MELSOFT

[ Do nat respond to search for CPU [Buill-in Ethernet port] on network

.&cknowledgeWassignmentl Fultiple CPL settingsl Default | Check | End | Cancel |

8. Under Communication Data Code, set the Binary Code transfer mode.

9. Activate Enable online change (FTP, MC Protocol) so that the Schaeffler SmartCheck or ProLink data can be
written in the controller.

10. Click on End.
11. Integrate the program into the Task.

EH smartCheck_IEC - GX IEC Developer - [MAIN_LD {Prio = 31, Event = TRUE)] o [m] 1
IE Project Object Edit Tools Onlne Debug View Extras Window Help ;lilll‘
zE SR & i -« 20| crnm |6 oo o||FE| FE|
SmartCheck IEC =)= POU name Comment =
Project [c\FAG\SmartCheck_IEC] 0jPoOU_01

Ifﬂ Library_Pool

Parameter
- PLC
- Netwark
Bl Module Configuration
-4 Task_Pool
. ey [MAIN_LD (Prio = 31, Event = TRUE)]
El-8§ DUT_Pool
w33 smart_Check_172_28_205_46_T
----- L@ Global_vars
- pou_rool
E-%@ POU_D1 [PRG]

& Project |a@, caltree | @2 Used by |

Ready

| €Ty 17:37 [TASKMAIN_LD: Event TRUE, In [Q20UDEH 4

12. Compile the program by selecting Compile > Rebuild All in the menu.
13. Transfer the program to the controller.
14, Restart the controller.

Continue configuring the controller in the Schaeffler SmartWeb software.
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Step 2: Create the controller in the Schaeffler SmartWeb software

Under Communication channels, click on Add to open the wizard. The wizard will guide you through the creation
of the communication channel in two steps:

¢ In the first step, select the controller for which you want to create the communication channel.

¢ In the second step, enter the following details about the controller:

Edit communication channel

Schaeffler SmartWeb

Steps

1: Select communication channel
type

2: Configure Mitsubishi Controller
[SLMP)

Description

Configure the settings for the
Mitsubishi Confroller here. Please
enter the server name and port, and
the protocol details

Step: Configure Mitsubishi Controller (SLMP)

Name :

IP address :

Port :

Protocol :

Transfer mode :

PLC_018

172.28.205.122
1280

Stafion forwarding

TP -

Binary hd

Connection test -

Expert settings Back Finish
Name PLC_018
IP address 172.28.205.122
Port decimal: 1280 (corresponds to hexadecimal: 0500)
Protocol TCP
Transfer mode Binary

Cancel

For further information on how to create a controller, please refer to the section Adding/editing a controller]:3.

You can click on the Connection test button to verify your entries: if the area next to it
g turns green your information is correct.

Step 3: Create inputs for the controller in the SmartWeb software
Under Inputs for communication channel: PLC_018, click on Add and enter the following settings in the Add

input window:



Configuration

Edit input

Schaeffler SmartWeb

Name : | Velocity from PLC_018

Start register : | D1000 (7]
Register type:| WORD - 9
Unit group : | Frequency/speead * | Unit:| RPM = Q
Polling interval: | 1s - e
Signal value : RPM
Max. [RPM] : 20083
163,837 .
Scaling : -
16.38 100E3
Min. [RPM] :
0.0 08
Min. register Max. register
e value : value :
0.0 10.000
Ok Cancel
Name Speed from PLC_018
Start register D1000
Register type WORD
Unit group Frequency/speed
Unit RPM
Register value Change the value for Max to 10,000.
Signal value For Min, enter the value 0 and for Max, enter the value 3000.

For more information on how to create an input for the controller, refer to the section Adding/editing inputs for
controllers[:21.

e If you have created inputs in the Schaeffler SmartWeb software, you can use the live
EJ view[s" to check whether data is being received by the Schaeffler SmartCheck or ProLink
device.

e This input can be used exactly like an internal input for measuring jobs

Step 4: Create outputs for the controller in the SmartWeb software

Under Outputs for communication channel: PLC_018, click on Create and enter the following settings in the
first step of the wizard:
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Edit outputs

Schaeffler SmartWeb

Steps Step: Select registers and characteristic values

1: Select registers and

characteristic values Start register : End register : 9
2: Specify register names 01200 D207
Update interval :
Gl s A e
Characteristic value selection : e
Available characteristic values Alarm status Value Alarm limits
— @& Default configuration A
Description @& sSystem temperature sensor
Here you can determine the from @& RMS broad band - Demodulation (Overall status)
};?c;cl'r':ln;?igollitirsf'.I"I:Irig?een.c?r'lg}ttzcc":r[l also @& RMS broad band - Acceleration (Overall status) v
\Sj_: zgteﬂ;Farcr':asr::;t‘tlesr.iS\}iacI'Lr:I::ds.’cr @& Crest factor - Acceleration (Impulses) v v
alarm limits are to be transferred @& 1S010816-1 (10Hz - 1kHz) - Velocity v
@& PeakZpeak - Acceleration (High vibration values)
& Periodic value - Demodulation {recurring anomalies)
@& Periodic value - Acceleration (recurring anomalies)
@& Temperature »
Expert setfings MNext Cancel
Start register D1200
Update interval This is where you specify how often the alarm statuses and/or values are to be
transferred to the controller.
Available characteristic Select the alarm status for the base configuration characteristic value and both
values the alarm status and value for the ISO 10816-1 characteristic value. To do this,

click on the box next to the characteristic value.

In the second step of the wizard, you can, if necessary, adjust the Register names that have been assigned
automatically. For more information about how to create a configuration with outputs for the controller, refer to the
section Adding/editing outputs for controllers[123).

Step 5: Save the configuration file with outputs for the controller in the SmartWeb software
1. In the =~ Communication channels area, click on the desired -‘-Controller (for example: PLC_018).

2. Click on ¥ Download to download the configuration file with outputs for the controller.
3. Open the configuration file:
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Connected to : SmartCheck 38
Schaeffler SmartWeb : ° ®
Logged in as : admin
File w Edit ¥ Measurementdata ¥ Goto v Help =
Configuration Communication channels E
Name Name: PLC_018 Changed : 2019-12-17 12:23:04
— B Configuration Created : 2019-12-17 10:27:19
: Device type : Mitsubishi controller Metwork number : - (_,_) Changed by : admin
+ = Input configurations 1P address : 172.28.205.122 Station number ; -
+ (3 Measurement jobs Port: 1280 Register with version number : 01200

Protocol : TCP Configuration version : 5

+ 4| Output configurations
. ¢ Transfer mode : Binary

& Measurement trigger

+ & Measurement conditi l

— o, Communication chan... o %
Ermal # Edil — Delete + Add
or OPG Uh server (*SOFTCONTROL:
' VERSION:7.04.01%)
o PLC_018 Inputs for communication channel : PLC_018 TYPE
+ [=] Device SmartCheck 10_179_8_82 T:
© Bearings Name Start register Reg. t... Polling interval Min. sigil STRUCT
config_version: INT:=1;
wal Bearing manufacturer . Velocity from PLC_018 01000 WORD 1.0s 0.0 s kommunikationsstatus: INT-=0:
i a_peratestatus: INT:=0;
a_basiskonfiguration: INT:=0:
END_STRUCT,;
END_TYPE
VAR_GLOBAL
& Actions SmartCheck _10_179_8_82 AT
7/ Edil — Delete + Add @"%MW0.1000.%MW0.1001.2%MW0.1002_%MW0.1003
Create new measurement job SmartCheck_10_179_8 82 T
& Areas Outputs for communication channel : PLC_018 E'\D—\AR‘
&3 stat PROGRAM POU
=talus Register Register name Measurement job Char| (**)
*w
" Measurement data D1201 s_communication_status Com E\Al)'\'. EXTERNAL
D1202 a_device_status Device alarm status Devi Sma_;chcck 10 179 8 82: SmartCheck 10 179 8 82 T-
AN Live view N " e AV LIF 8 821,
01203 a_crest_factor_acceleration_imp Default configuration Crest .ES_-I-.D_\AR
E Configuration D1204 ©_crest_factor_acceleration_imp  Default configuration  Grest| papyy
. n1206 a isn10&16 1 10hz 1kh7 velocite Nefault confiouration 15014 MOVP( SM402, 1, SmartCheck_10_179_8_82.config_version );
wam User management END BODY - - - '
Edit — Delet 3
U) Log out /" Edi slete END_PROGRAM
Complete CONFIGITRATION srConfiouration h

4. Select the contents of the new window with CTRL+A, copy them to the clipboard with CTRL+C and insert
them into an editor (e.g. Microsoft Editor) with CTRL+V.

5. Save the file with any name and the extension .ASC (Example: SmartCheck or ProLink01. asc).

e If you use the Mozilla Firefox browser, you can save the file directly as an ASCII file with
5’ the Save as function.

e Please make sure that the file has the extension .ASC so that it can be read by the GX
Works2 software.

Step 6: Read the configuration file into GX Works2

Please create a backup copy of the existing project before importing the Schaeffler
5/ SmartCheck or ProLink configuration file.

1. Click on Project > Open Other Data > Read ASC Format File.
2. Select the ASCII file (.ASC) you have just created and click on OK.

3. The Schaeffler SmartCheck or ProLink configuration file is imported and inserted into the tree as a new Global
Label with the designation Global_Vars.
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!"—ESmartCheck_IEC - GX IEC Developer - [Global Variable List]
Iﬁ Project Object Edit Tools Onlne Debug View Extras Window Help

R s mR|o |88 S ws

SmartCheck FC——————————————— a| x|

g [ 3]
===

CrErFPEEEE R

Class Identifier MIT-Addr. IEC-Addr.

Project [c:\FAG \SmartCheck_IEC] + 0 VAR_GLOBAL ~ |Smart_Check_172_28_205_46 |iconfig_version: R98 |config_version: %MWW2
Lff‘ Library_Pool
Parameter

I

Type
Smart_Check_172_28_205|

...l Module Configuration
-4y Task_pool

...y MAIN_LD (Prio = 31, Event = TRUE)
E-§§ DUT_Pool

-89 smart_Check_172_28_205_46_T
-Ig Global_Vars
¥z POU_Pool

-3 poU_01 [PRE]
: o Header

@ Project |°|*_—‘> Caltree | 92 Used byl | | =

[T 17:34 [GVL: 1 Dedarations |qzouDEn G

The characteristic values along with the associated registers are displayed if you click in the Device column on
Detail Setting:

Data unit variable addresses x|

Smart_Check_172_28_ 20546 [Smart_Check_172_28_205_46 T)

Name Type [ MIT - [ IEC-Addr. ]
1 |config wersion WWORD R98 Ehw2.98
2 |device_status WORD R100 Zhiw/2100
3 |standardmeszaufgabe WRD R101 Ehwi2 10
4 |izo10816_1_10hz_1khz_g ‘wORD R102 Ehdw2 102
5 |comunication_status WRD R99 EMw2.99
4| [ [

v Automatic filing v A&l Types Export Import | Ok I Cancel |

Step 7: compile the program and transfer it to the controller

1. Compile the program by selecting Compile > Rebuild All in the menu.
2. Save the program and transfer it to the controller.

8.7.3 Communication channel for OPC UA server

OPC UA is a standard that enables devices to communicate and exchange data. In the ®* Communication
channels (OPC UA server)[1:) area you can configure the Schaeffler SmartCheck or ProLink device as an OPC UA
server. The characteristic values of the device can then be read out by other controllers. You can also integrate

process parameters of other controllers into the SmartCheck or ProLink device via OPC UA server inputs. In order to
avalil of this potential, the following steps must be taken:

e You must first add the OPC UA server as a communication channell1s). In doing so you essentially define the
server port and any authentication data.
¢ If you want to read data from other controllers via the OPC UA server, you must create one or more inputs for

the OPC UA server[ 17 for this purpose. For this type of input, you can determine how often the data is read

from the controller registers, as well as the value range. You also specify the signal unit and signal value range to
which the register data is to be converted.
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e You can create as many inputs for the OPC UA server as you wish and use them in the SmartWeb software in
exactly the same way as you use the inputs found in the Input configuration[ e area. In particular, inputs are

available for the server in relation to measurement jobs[ 74", measurement conditions[ 104l and measurement
triggers| iof.

e Use an OPC UA client to check which data is available via the OPC UA server. You can then download the values
in a readable format from the OPC UA server.

8.7.3.1 Communication channel area for the OPC UA server

In the Communication channels area, the expanded overview on the left shows the OPC UA server that you
have created for the Schaeffler SmartCheck or ProLink device. In the right-hand main panel, you will find basic
details about the OPC UA server as well as information on its inputs, if these have been created:

N Connected to : SmartCheck 38
Schaeffler SmartWeb =e o = - ®
Logged in as : admin
File w Edit ¥ Measurementdata ¥ Goto Help w
Configuration Communication channels =]

Name Name : OPC UA server Changed : 2019-12-18 20:15:42

— |B Configuration Created : 2019-12-18 20:15:42
Server port | 4340 Changed by : admin

User name : -

+ (& Measurement jobs Password : -

+ =1 Input configurations

+ &1 Output configurations
& Measurement frigger

+ « Measurement conditi...

«, Gommunication chan...
& Email # Edil Delete + Add

orc OPC UA server
M PLC_018 Inputs for communication channel : OPC UA server
+ [ Device
(@) Bearings MName Min. signal Max. signal Unit Min. reg. value Max. reg. value Polling interval

wal Bearing manufacturer | Speed input -10.0 10.0 [kHz] -10.0 10.0 1.0

& Actions
Create new measurement job

& Areas

‘% Status

" Measurement data
A= Live view

@ Configuration

42 User management

# Edil Delete + Add
LI) Log out

Complete

Click on an OPC UA server to access the following information and functions in the main panel:
Communication channels

Here you can find the basic information and functions for the OPC UA server:
¢ Alongside the Name, you will see the Server port used.

¢ If authentication is activated for the OPC UA server, you will also see the User name and Password
details.

e Click on Add ™ to add an OPC UA server. For details, please refer to Adding/editing an OPC UA
server| 14\,

o Click on Edit # to edit the OPC UA server. For details, please refer to Adding/editing an OPC UA
server| 7.

e You can delete the OPC UA server communication channel. To do so, click Delete and confirm with
OK.

e In the top right corner, click on o open the Configuration overview[ s,
Inputs for communication channel
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This table provides an overview of the inputs that you have created for the OPC UA server. The following
information and functions are to be found here:

e The table contains information on the relevant inputs in addition to the Name, e.g. the signal value
range into which the data is translated (Min. Signal to Max. Signal), the register value range it
covers (Min. reg. value to Max. reg. value), and at which interval the value is queried.

o Click on Edit # to edit the input. For details, please refer to Adding/editing an OPC UA server
input[ s

e Click on Add ™ to add further inputs. For details, please refer to Adding/editing an OPC UA server
input[1,

e You can delete the selected input. To do so, click Delete and confirm with OK.

An input that you have linked to a measurement job[74" cannot be deleted. In this case, the

l; Delete button is deactivated. To delete this external device, you must first delete the
measuring job in which it is used.

8.7.3.2 Adding/editing an OPC UA server

To use the Schaeffler SmartCheck or ProLink device as an OPC UA server, you must create the corresponding
communication channel.

How to create the communication channel for the OPC UA server

1. Under Communication channels, click on Add ™ to open the wizard. The wizard will guide you through the
process of creating the communication channel in two steps.

2. In the first step, select the OPC UA server communication channel type.
3. Click on Next to move to the second step. You must enter the required details for the OPC UA server here:

Add communication channel

Schaeffler SmartWeb

Steps Step: Configure OPC UA server
1: Select communication channel

type Server port 1 | 4340 9
2: Configure OPC UA server

Activate authentication

Description

Configurs the settings for the OPC
UA server here. Please enter the
OPC UA server port and
authentication data.

+" Eupert seitings Back Finish Cancel

You have the following options:
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Server port Enter the TCP port of the server on the SmartCheck or ProLink device.

The OPC UA standard specifies the value 4840 for the server

Eﬂ port. Do not change this value unless you possess expert
knowledge.
Activate authentication Activate this option if you want to regulate the readout of the device data. If

this option is activated, you can specify the User name and Password that
must be entered for authentication before using the SmartCheck or ProLink
device for OPC UA communication. Select Show password to make the
password visible while you enter it.

Node IDs for Int32 data Visible only when Expert settings are activated:
type — Siemens S7- Activate this option for controllers that can only process node IDs of the Int32
compatible data type. This is the case for controllers in the Siemens S7 family, among

others. If this option is activated, the server generates node IDs up to a
maximum value of 2147483647.

If this option is deactivated, the server generates node IDs up to a maximum
value of 4294967295 — as permitted by the OPCUA specification.

If you change this option, all node IDs are recreated. You will
o then also have to update the node IDs in your controller.

4. Click Finish to save the communication channel for the OPC UA server.

How to edit the communication channel for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit 7" Make the required entries in the
respective steps of the wizard.

3. Click on Finish to apply your changes.

8.7.3.3 Adding/editing an OPC UA server input

The Schaeffler SmartCheck or ProLink device receives information about process parameters in other controllers via
OPC UA server inputs.

How to create an input for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.

2. Under Inputs for communication channel: OPC UA server, click on Add
3. In the Add input window, make the desired entries:
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You have the following options:

Name

Register type

Unit group and
Unit

Polling interval

Register value

Signal value

Speed input example:

Add input

Schaeffler SmartWeb

Name : | Speed input

Register type : | FLOAT ~ @
Unit group : | Frequency/spesd * | Unit:| kHz v 0
Polling interval : | 13 ~ @
Signal value : kHz
Max. [kHZ] :
10.0
Scaling 2 5
1.0 .
Min. [kHz] : -5
-10.0 .
15
5
Min. register Max. register
a value : value :
-10.0 1000
Ok Cancel

Here, specify the name that the input is to appear under in the SmartWeb
software.

This is where you specify the format in which the data is transferred. This
specifies how large the maximum register value range can be.

The following format is currently supported:
FLOAT 32 bit

This is where you specify the physical value and measurement unit into which
the value from the controller is to be converted.

This is where you specify how often the value is to be queried from the
controller.

A long poliing interval is sufficient for values that only change slowly e.g. the
temperature. This can reduce the amount of data and the load on the
controller.

Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Use these settings to determine the range within which the measurement
values should lie. First enter a minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

. Click on OK to save the new input.

The speed in your application is between 0 and 3000 RPM. In the register, this corresponds to the value
range 0 to 10,000. In order to use this speed as an external input, your settings need to be as follows:

Register type
Unit group

Frequency/speed
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Unit RPM

Min. register value 0

Max. register value 10,000
Max. signal value 3000 (RPM)
Min. signal value 0 (RPM)

How to add a scaling factor to the input

You can add scaling factors to the input, which you can access e.g. when creating a measurement job[7". Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:

1. Speed in front of the gear

2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, select the required input under Inputs for communication channel: [Name].
2. Click on P to expand the list of scaling factors.

3. Clck on ™ to open the Add scaling factor window:

Add scaling factor

Input channel :
215330 - Rotational speed before gear

Name :
Speed befare gear

Scaling factor :

0.2
Unit :
RPM v
Ok Cancel

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the

unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.

To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

Inputs for communication channel : 21G830

Name Start register Reg.t... Polling interval Min. signal Max. signal  Unit Min. reg. value Max. reg. val...

Rotational speed bef... RO INT 1.0s -32,768 32,767 [Hz] -32,768 32,767

Additional scaling factors

Speed before gear 0.2x RPM
#  Edit
Delete
4 Live view
# Edit e + Add
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You can also switch to the live view[s" area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
Ly you a warning message. If you delete the scaling factor, you also automatically delete the
l:i relevant measurement job.

How to edit an input for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.
. In the table, under Inputs for communication channel: OPC UA server, select the desired input.

2
3. Click on Edit # and make the desired entries in the Edit input window.
4. Click on OK to accept your changes.

8.7.4 Communication channel for PROFINET

If you have inserted a PROFINET module in the ProLink CPU, it appears automatically as a communication channel in
the Configuration area. With the aid of this communication channel and the correspondingly programmed
controller,?Eﬁ all alarm statuses of the characteristic values and theProLink device can be read via the cyclic data.
Process data can also be sent from the controller to the ProLink device via the cyclic data. To do this, you must
create the process data of the ProLink device as inputs in the SmartWeb software.[152) In addition, all characteristic
values and their alarm limits can be queried by the controller in the acyclic data.

The PROFINET module is not automatically detected until firmware version 2.0 or higher and
Ly is displayed as a communication channel. If it does not appear, update your firmware using
= the Help > Update firmware[ 13" function.

8.7.4.1 Communication channel for PROFINET area

In the communication channels area, you wil find the communication channel for the PROFINET module that was
detected on the ProLink device in the overview shown on the left. On the right of the main panel, you will find
basic details about the PROFINET communication channel, as well as information about its inputs:
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N Connected to : Schaeffler ProLink
Schaeffler SmartWeb Logged in as - admin .
File w Edit ¥ Measuremenidala ¥ Goto W Help v
Configuration Communication channels =]

Name Name : PROFINET Status : Idle ’ Changed : 2022-10-20 16:16:06

~ |8 configuration MAC : 00:30:11:51:C68:39 - Crealed - 2022-10-20 16:16:06

+ =1 Input configurations Firmwars : 2.03 Changed by : system
+ (@ Measurement jobs Station name Station name of controller
easurement] DHCP enabled : No IPv4 address of controller - 0.0.0.0
+ ¢ Output configurations \Pv4 address : 0.0.0.0
& Measurement trigger MNet mask : 0.0.0.0

+ # Measurement conditions Gateway : 0.0.0.0

— « Communication channels

mw PROFINET # Edi Delete + Add
+ (=) Device
© Bearings Inputs for communication channel : PROFINET

wl Bearing manufacturer
Name Min. signal Max. signal Unit Min. reg. value Max. reg. value Polling interval

4 Speed PN 0.0 100.0 Hz 0.0 100.0 1.0
Additional scaling factors

Scaling 02x Hz

& Actions
Create new measurement job

& Areas

& stalus

P Measurement data
AW Live view

B configuration

22 User management

* Edi Dekete + Add
(1) Logout s Ed i e

Complete

Click on the PROFINET communication channel to access the following information and functions in the main panel:
Communication channels

Here you can find the basic information and functions for the selected communication channel for
PROFINET:

¢ In addition to the name, MAC address and firmware version, you will find the station names of the
ProLink device and controller, as well as details on the network configuration.
e Status informs you about the current status of the communication channel:
= Connected:
The communication channel for PROFINET works without any problems.
* Deactivated:

The communication channel for PROFINET has been deactivated via the Edit function # .
» Inactive:

The ProLink device has not yet commissioned the PROFINET module.
= Idle:

The PROFINET module is not yet connected to a controller.
= Configuration error:

The controller is configured incorrectly.

o Ciick % to download a ZIP file containing information on programming the controller. It contains the
following:
* info.txt:

The PROFINET module of the ProLink device functions as a DAP (device access point) and has one or
two virtual sub-slots depending on the configuration. The info.txt file contains detailed information
on which modules must be programmed and how and which cyclic and acyclic data ProLinkis
exchanged between the device and the controller.

= gsd folder:

In this folder you will find a product image and the gsd.xml file which describes the ProLink
interface in detail.

= s7 folder:
This folder contains programming examples for reading cyclic and acyclic data.

¢ Click on Edit 7 to edit the PROFINET communication channel. You can then activate, deactivate or
reactivate PROFINET.

e Click on Add ™ to add further communication channels[108).
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« In the top right corner, click on B to open the Configuration overview 5.

Inputs for communication channel
Here you will find a tabular view of the inputs that you have created for the PROFINET communication
channel. The following information and functions can be found here:

e The table contains information on the relevant inputs in addition to the name, e.g. the signal value
range into which they are translated (Min. signal to Max. signal), the register value range it covers
(Min. reg. value to Max. reg. value) and the query interval.

« Click on Edit # to edit the input. For details, please refer to Adding/editing inputs for PROFINET
communication channell s,

e Click on Add ™ to add further inputs. For details, please refer to Adding/editing inputs for
PROFINET communication channell:s).

e You can also delete the selected input. To do so, click Delete and confirm with OK.

¢ If you change the measurement tasks, the info.txt file is updated. You must then
i4 download the ZIP file again and adapt the controller programming[1s1.
e The ProLink device can be restarted from the controller. In addition, the controller

automatically detects when the ProLink device is switched off or restarted, and it also
indicates this.

8.7.4.2 Adding/editing inputs for PROFINET communication channel

Process data can be transferred from the controller to the ProLink device via inputs for the PROFINET
communication channel.

How to create an input for the PROFINET communication channel
1. Select the PROFINET communication channel in the expanded overview on the left.

2. Under Inputs for communication channel: PROFINET, click on Add
3. In the Add input window, make the desired entries:

Add input

Name :

Speed
Register type :

FLOAT -9
Unit group : Unit =

Frequency/speed - Hz - ﬂ
Polling interval :

1s 'ﬂ

Signal value : Hz
125

Max. [Hz] : o
100

Sealing =
1

Min. [Hz] :
0

[
o

20.0 40.0 50.0 80.0

Min. register value : Max. register value :
9 0 100
oK Cancel

You have the following options:
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Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Register type Only the FLOAT register type is available.

Unit group and This is where you specify the physical value and measurement unit into which

Unit the value from the controller is to be converted.

Polling interval This is where you specify how often the value is to be queried from the
controller.

A long poliing interval is sufficient for values that only change slowly e.g. the
temperature. This enables you to reduce the amount of data.

Register value Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Signal value Use these settings to determine the range within which the measurement
values should lie. First enter @ minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

4. Click on OK to save the new input.

How to add a scaling factor to the input

You can add scaling factors to the input, which you can access e.g. when creating a measurement job[76". Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gearis 5
times smaller. You can create a scaling factor for this:

1. Speed in front of the gear

2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, select the required input under Inputs for communication channel: [Name].
2. Clickon P to expand the list of scaling factors.

3. Click on ™ to open the Add scaling factor window:

Add scaling factor

Input channel :
21G830 - Retational speed before gear

Name :
Speed before gear

Scaling factor :

02
Unit
RPM v
Ok Cancel

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the

unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.
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To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

Inputs for communication channel : 21G830

Name Start register Reg.t... Polling interval Min. signal Max. signal Unit Min. reg. value Max. reg. val...

Rotational speed bef... R( INT 1.0s -32, 768 32,767 [Hz] -32,768 32.767

Additional scaling factors

Speed before gear 0.2x RPM
#  Edit
Delete
A Live view
# Edil T + Add

You can also switch to the live view[s" area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
l:; you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

How to edit the input of the PROFINET communication channel

1. Select the PROFINET communication channel in the expanded overview on the left.

2. Select the required input under Inputs for communication channel: PROFINET in the table.
3. Click on Edit # and make the desired entries in the Edit input window.

4. Click on OK to accept your changes.

8.7.5 Communication channel for Schaeffler Cloud

You can use the > Communication channel (Schaeffler Cloud)[1si area to expand the possibilities of
monitoring the condition of the SmartCheck or ProLink device by connecting to the Schaeffler Cloud and
transferring data to the cloud using the SmartCheck or ProLink device.

In order to use the cloud functionality, the following steps are necessary:

e You must first connect the Schaeffler Cloud services| 16 (cloud onboarding). The communication channel for
the Schaeffler Cloud is created automatically and all necessary settings are made.

¢ If necessary, configure the proxy settings of the communication channel (Schaeffer Cloud) by clicking on Edit.

Further information on Schaeffler Cloud can be found in the Schaeffler Mediatheque.

4

8.8 Device

Under Device, you will find the Device settings[:sh and System time settings[s. Click on the desired area to
view the main settings of the SmartCheck or ProLink device. Some settings can also be changed here.

8.8.1 Device settings

Under Device Settings, details on the Schaeffler SmartCheck or ProLink device, the network, and the keys and
the status LED on the device are listed:


https://www.schaeffler.de/content.schaeffler.de/de/news_medien/mediathek/publikationen/downloadcenter-global-pages/downloadcenter-language-list-publications.jsp?pubid=87649857&ppubid=87649858&tab=mediathek-pub&subfilter=app:dc

Schaeffler SmartWeb

File ¥ Edit ¥ Measurementdata ¥ Gato W

Configuration

Hame
— |& Configuration
+ =31 Input cenfigurations
+ (& Measurement jobs
+ «1 Output configurations
& Measurement trigger
+ & Measurement condit
+ = Communication chan
— [¥] Device
# Device seftings
() System fime setti
(©) Bearings

wsl Bearing manufacturer

& Actions
Create new measurement job

A Areas

&3 Status

" Measurement data
Al Live view

lE Configuration

2 User management

LU Leg out

Complete

Device settings

Name : SmariCheck 36
Serial number : f4:3d.30.00:01:4b

Configuration

Connected to | SmariCheck 36 ®
Legged in as : admin

Help ¥

=)

MAC address : f4-3d-80-00-01-4b

Description :
Paosition : -

# Edit

Key/LED settings

Reset alarm(s} : Allowed
Restart learning mode : Allowed

Reboot device : Allowed
Restore factory default setting : Not allowed

Status LED : Enabled

' Edit

MNetwork settings

P address : 10.179.7.203
Metmask : 255.255.255.0
Gateway : 10.179.7 254

DHS server: 10.179.0. 248

DHCP mode : DHCP client mede (lead host name from server)

£ Edit

You can find the following information here:

Device settings

The name, serial number and MAC address (network address) of the SmartCheck or ProLink device
are listed here. If specified, you will also find the description and position of the device here.

Changes are possible for the entries under Name, Description and Position; to make changes, click on
Edit ¥ and enter the desired changes.

Key/LED settings

The Schaeffler SmartCheck device has two keys and one status LED. The Schaeffler ProLink device also
has two keys and three LEDs.

Under Key/LED settings, you can specify the actions permissible with the keys. In this way, you protect
the SmartCheck or ProLink device against inadvertent operation. You can also specify here whether the
status LED on the SmartCheck device or the alarm LED on the ProLink device is to display alarm statuses.
As a rule, the following settings are possible:

Reset alarm(s)

Restart learning mode

Reboot device

Restore factory default

setting

Enable status LED

This switches off all existing alarms.

This restarts the Learning mode 39" current measurement values and
alarm limits are retained; only the process for determining new alarm
limits is restarted.

This restarts the SmartCheck or ProLink device, i.e. the device is shut
down and booted up again.

This resets the SmartCheck or ProLink device to the factory default
setting. All the settings and configurations you made are lost.

This option is activated by default.

If you disable the option, it will affect your system in the following way:
e ProlLink device: The alarm LED signals are disabled.

e SmartCheck device: The alarm signals of the status LED are disabled.

It still flashes yellow and red for instance when the firmware is
updating.
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The SmartCheck or ProLink device then no longer indicates the alarm
status through a red, yellow or green light.

The key lock is enabled by default to prevent unintentional operation. You can find details on which key
or key combination you have to press in each case in the Schaeffler SmartCheck or ProLink user
documentation.

To change the key/LED settings, proceed as follows:
1. Click on Edit #
2. In the Edit key/LED settings window, define the permissible actions:

Edit key/LED setfings

Schaeffler SmartWeb

«" Reset alarmis)
«" Restart leamning mode
+ Reboot device
Restore factory defauli setiing

+ Enable status LED

oK Cance

¢ If you deactivate a key option, the corresponding key can no longer be used for this purpose. In our
example, this applies to Restore factory default setting.

¢ If you deactivate the Enable status LED option, the alarm status is no longer indicated on the
SmartCheck or ProLink device.

3. Click on OK to save your changes.

Network settings

The current settings for DHCP, Host name, IP address, Gateway and Netmask are listed here. To
change the network settings, proceed as follows:

1. Click on Edit #
2. In the Edit network settings window, enter the desired specifications:

Edit network settings

Schaeffler SmartWweb

DHCP mode | DHCP client moede (load host name from server) v

OK Cance

You have the following options:

No DHCP With this option, you can specify the IP address or continue to use the
SmartCheck or ProLink device's default IP address.



Configuration

If No DHCP is enabled, you must also change the other settings in this
step, such as IP address, Netmask, Gateway or DNS server.

The DNS server is required when you create an email communication
channell9 using either the SMTP server or the proxy server as a name
and not as an IP address. In this case, the specified server name is
resolved by the DNS server.

DHCP client mode With this option, the SmartCheck or ProLink device automatically

(send host name to server) receives an IP address within your network. The host name is
registered by the SmartCheck or ProLink device in the network's DNS
server.

DHCP client mode With this option, the SmartCheck or ProLink device automatically

(load host name from server) ~ receives an IP address within your network. The host name is specified
via the network's DNS server (reverse DNS).

3. Click on OK to save your changes.

e If you change the IP address of the SmartCheck or ProLink device, you no longer
g have access to the SmartWeb software at the previous address. You must then
enter the new address in the browser in order to load the software again.

o If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink
device can only be accessed via the automatically allocated IP address. You can
no longer use the default IP address.

8.8.2 System time settings

e Schaeffler SmartCheck or ProLink has an internal clock, which will be operational provided

g that the device is supplied with power. However, as it has no buffer battery, it becomes

inoperative as soon as the power supply is interrupted — unless you have connected an

external battery or power supply to the battery input.

If you restore the interrupted power supply and you have selected Set system time

manually, you should correct the system time, otherwise the internal clock will continue

to run from the time of the last successful measurement before the power failure.

For information on how to connect the internal clock to an external battery, refer to the

user documentation Schaeffler SmartCheck or ProLink.

¢ If a new SmartCheck or ProLink device does not have access to information on the
current time, the time information is taken from the firmware.

Under System time settings, various details on the system time of SmartCheck or ProLink are listed:

N Connected fo : SmartCheck 36
Schaeffler SmartWeb ! = ® .
Logged in as : admin
File ¥ Edit ¥ Measurementdata ¥ Goto w7 Help w
Configuration System time settings (=]
Hame
System time | 2019-12-11 21:24:10
= |B Cenfiguration MTP activated (system time automatically loaded from NTP server) | Mo
4 =31 Input cenfigurations NTP server : -
+ (8 Measurement jobs Time zone . GloballUTC
4 4= Qutput configurations
" Edi
& Measurement trigger ’
+ «& Measurement conditi...
+ =2 Communicaiion chan..
— [=] Device

# Device settings
System time setti
(©) Bearings

wa| Bearing manufacturer

The following information and functions can be found here:
System time
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Here the current date and current time of the SmartCheck or ProLink device are displayed.

NTP activated

Here you can see whether the SmartCheck or ProLink device loads the system time from an NTP server,
i.e. a time server in the network. If so, Yes will be displayed here.

NTP server

If the SmartCheck or ProLink device loads the system time from an NTP server, you will see the name of
the server here.

Time zone
You can see the time zone in which the SmartCheck or ProLink device is located here.

Edit button
To change the settings for system time and NTP server, proceed as follows:

1. Cick on Edit #
2. In the Edit system time window make the desired specifications:

Edit system time

Schaeffler SmartWeb

Iethod Date
Switch system time to PC

time

Set system time

manually

Use NTP server to
synchronise system time

-

MTP server
Time zone
Time zone of device : | UTC w
0] 4 Cance
Method Here you can specify what the system time of the SmartCheck or ProLink device

should be based on. The time setting can have the time of the connected PC or

that of an NTP server as its reference. You can also enter it manually.

If the system time is based on an NTP server, synchronization runs constantly. For
this method, therefore, the SmartCheck or ProLink device must have a permanent
connection to the network, and the NTP server must always be accessible.

Date Only in the case of Set system time manually: enter the current date and the
current time here. You can either select the date from the list boxes or set it

directly from the calendar .

NTP server Only for Use NTP server to synchronise system time: specify the name of the
NTP server here. using the IP address of the desired NTP server.

Time zone of Here you can select the time zone in which the SmartCheck or ProLink device is

device located.

3. Click on OK to save your changes.

8.9 Bearing

Schaeffler SmartCheck or ProLink contains a comprehensive bearing database, to which you can add further
bearings. These bearings are available when you create a new measurement configuration[ 7. In the Bearings
area, you wil find an overview with search function:
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Schaeffler SmartWeb

File ¥ Edit ¥ Measurementdata ¥ Gato W
Configuration Bearing overview

Hame Manufacturer
FAG -

Search criteria :
— |& Configuration
+ =5l Input configurations

Bearing search result
+ (& Measurement jobs

+ I Output configurations Name Manufacturer EPFI
& Measurement frigger 108-TVH FAG 60591

+ & Measurement condit 11204-TVH FAG 71332
=, Communication chan.. 11205-TVH FAG 71080

+ [#] Device 11208-TVH FAG 82134
@ Bearings 11207-TVH FAG 9.1394
wsl Bearing manufacturer 11208-TVH FAG 9.7208
11209-TVH FAG 91724

H210-TVH FAG 10.2244

) M211-TVH FAG 10.7513

i 11212 TvH FAG 10.7187

1200-TVH FAG 5727

1201-TVH FAG 6.0834

1202-TWH FAG 61097

& Actions 1203 TWH FAG 71784

Create new measurement job Bearing information

@ A
reas Name : 108-TVH

Manufacturer : FAG
&3 Status

Ball pass frequency inner race (BPFI) : 6.059
Ball pass frequency outer race (BPFO)
Ball spin frequency (BSF) : 2.203
Fundamental train frequency (FTF) standing outer race : 0.3941
Fundamental frain frequency (FTF) standing inner race :

" Measurement data

Al Live view
lE Configuration

oo w
3

2 User management

LU Leg out

Complete

0O copy + Add

The following information and functions can be found here:

BPFO
3.9409
45868
45920
5.7866
6.5108
7.2794
68278
7.7756
3.2457
8.2813
34273
3.9166
3.5903

4 721R

Configuration

Connected to | SmariCheck 36 ®
Legged in as : admin
Help v

=)

Page1of206 > 3|

BSF FTF (standing outer ... FTF {standing inner ...

0.3941 08059 (B ~
0.4058 05844 (3
0.4077 05923 (3
0.4133 05867 (3
0.4257 05743
0.4282 05718 (3
0.4267 05733 (3
0.4320 05680 (3
0.4341 05858 (3
0.4359 05641 (3
0.3308 08192 (3
0.3917 08083 (3
0.3380 06110 (3
nan1s nsaaz & Y

Changed : 2019-11-25 08:36:07
Created : 2019-11-25 08:36:07
Changed by : admin

)

e Searching for bearings by manufacturer is possible. You can expand the corresponding list box as much as you

like in the Bearing manufacturer| sl area.

e You can search for bearings by name in the database. To do so, enter the name in the Search criteria field.

Here you have the following options:

= The placeholder * stands for any character string.
= The placeholder ? stands for any single character.
= Upper/Lower case is irrelevant.

e The details on the bearing currently selected are displayed under Bearing information. In the example, you can
see the details for the first bearing in the list. In the grey box on the right, you will find the details on creating

and changing the selected bearing
e You can add a new bearing[1d
e You can copy and edit existing bearings/si)

e You can delete copies of bearings or newly created bearings. To do this, select the relevant bearing, click on

Delete ~, and choose OK to confirm.

Bearings that are used in a measurement job cannot be deleted.

¢ In the top right corner, click on M o open the Configuration overview [s7.

You can neither delete nor edit the bearings from the preset database. However, you can

g copy a bearing from the database and then edit the copy.

8.9.1 Adding/editing bearings

You can expand the Schaeffler SmartCheck or ProLink bearing database as much as you like. In doing so, you have

two options:
e You can add new bearings/sd.

« You can copy existing bearings[16l), edit the copy and then save it under a new name.
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How to add a new bearing

1. Under Bearing information, click on Add
2. In the Add bearing window, make the desired specifications:

You have the following options:

Name

Manufacturer

Normalised kinematic
frequencies

Calculate normalised
kinematic frequencies

Add bearing

Schaeffler SmartWeb

Name :
11207
Manufacturer :
FAG A

Normalised kinematic frequencies

Eall pass frequency inner race (BPFI) :
9.189

Eall pass frequency outer race (BPFO) :
6311

Eall gpin frequency {BSF) :

3.252

Fundamental train frequency (FTF) :
0.4235

Standing bearing race :
# Quter race

Inner race

Actions

Calculate normalised kinematic frequencies

Verify bearing

o] 4 Cance

Enter the name of the bearing here. You can also find the bearing under this
name if you want to select it for a measurement job.

Select the manufacturer for the new bearing here. What is in this list box is
determined by your selections in the Bearing manufacturer|is1) area.

These specifications are important for the correct calculation of bearing
damage frequencies and thus for the reliable monitoring of this component.
You can find the corresponding information on BPFI, BPFO, BSF and FTF in
the technical data of the bearing.

Alternatively, you can have the normalised kinematic frequencies calculated
with the help of the program, using the geometry of the bearing (see below).

Click here to calculate normalised kinematic frequencies with the aid of the
bearing geometry. In this case, you need the load angle, the diameter of
the pitch circle and of the roller element, and the number of roller
elements:



Configuration

Calculate normalised kinematic frequencies

Schaeffler SmartWeb

Geornetry__
. Load angle (alpha) :
EJW o 445
_____ Pitch circle diameter [mm)] (DT) :
s DT 50.0
Reller element diameter [mm) (DW)

9.0

Mumber of reller elements :
10]

Calculate Cance
If you want to add a double-row bearing, only enter the number of one row in
Number of roller elements.

Make the corresponding specifications and then click on Calculate. The
software calculates the values for the normalised kinematic frequencies from
the geometry and transfers them to the corresponding fields.

Verify bearing Click here to check your specifications for plausibility. This check reduces the
probability of you having made incorrect specifications for the normalised
kinematic frequencies. Otherwise, the bearing is accepted into the database
without a plausibility check.

3. Click on OK to add the new bearing to the database.

How to copy and edit a bearing

The bearing database, which is already available in the factory default setting of the Schaeffler SmartCheck or
ProLink device, is write-protected; the individual bearings can be neither edited nor deleted. However, you can copy
a bearing from the database and edit the copy, e.g. to create a new bearing with only minor deviations. To do this,
proceed as follows:

1. Select the bearing you want to copy and edit

2. Under Bearing information, click on Copy D

3. In the Copy bearing window, make the desired specifications. If you do not change the name here, Schaeffler
SmartCheck or ProLink creates by default a bearing with the name Copy of [name of the original bearing].

4. Click on OK to save your changes and transfer the bearing into the database.

Calculating normalised kinematic frequencies from the bearing geometry requires expert
g knowledge. Only with the correct specifications for angles and diameters can the values for
the bearing be determined correctly and lead to a correct measurement configuration.

8.10 Bearing manufacturer

If you add a new bearing in the Bearing[1s) area, you also have to specify the manufacturer of the bearing. You
manage the manufacturers available for selection in the Bearing manufacturer area:
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Connected fo ; SmariCheck 36
Schaeffler SmartWeb onnected to : SmariCheck 38 ® .

Legged in as : admin

File ¥ Edit ¥ Measurementdata ¥ Gato W Help w

Configuration Manage manufacturers

=)

Hame FAG

— |& Configuration M

+ =5l Input configurations
+ (& Measurement jobs
+ + Output configurations
& Measurement trigger
+ & Measurement condit
= Communication chan..
+ [®] Device
(©) Bearings

wal Bearing manufacturer + Add

& Actions
Create new measurement job

A Areas

&3 Status

" Measurement data
Al Live view

lE Configuration

2 User management

LU Leg out

Complete

Here you have the following options:

¢ Add manufacturer: Under Manage manufacturers, click on Add ™, enter the name of the manufacturer
and confirm with OK.

¢ Edit manufacturer: Under Manage manufacturers, click on Edit l""., change the name of the manufacturer
and confirm with OK.

¢ Delete manufacturer: Under Manage manufacturers, click on Delete and confirm with OK.

¢ In the top right corner, click on H o open the Configuration overview[s".

You cannot delete or edit the manufacturers FAG or INA or any other manufacturers you
g may have added that you have already used when specifying a bearing.
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User management

User management

Click on the User management ** button to open the corresponding area. Here you can change, add and delete
user groups and users in the SmartWeb software. You can also activate and deactivate the user management here.
On the left, you will find an overview of all user groups and users. The user currently logged in is displayed in the

top right in the title bar next to Logged in as.

In the factory default setting, the user groups Administrator, Remote and Guest are created with the users
admin, remote and guest. If you select a group or an individual user, you will see the corresponding details and

rights in the main panel:

Schaeffler SmartWeb

File ¥ Edit ¥ Measurementdata ¥ Goto w7
User management Users

User User ID : guest
— Zz User groups

User group : Guest
a= Administrator Last namea © Guast

22 Guest First name :

Email :

Telephone :

— & Users Comment :

== Remote

2 admin
guest

inactive_user

remote

2 system

& Actions

Activate user management
Deaclivate user management
Change password

* Edit
& Areas s Hd

& Status

" Measurement data
Al Live view

lE Configuration
a2 User management

L') Leg out

Complete

Here you have the following options:

User groups

Right :
Create configurations
Delete configurations
Edit configurafions
Delete measurement data
Download data
Edit confidential configurations
Configure inputs
Configure outputs
Edit oil status calculation
Reset alarm(s)
Edit hour meter
Edit speed channel
Edit system settings
Create users/user groups
Delete users/user groups
Edit usersiuser groups
View confidential configurations

View trendflive view data etc

Delete + Add

Connected to : SmartCheck 36 ®
Legged in as : admin
Help wv
Changed : 2019-11-25 08:35:48

Created : 2019-11-25 08:35:48
Changed by : admin

If, as in the example, you select a user group in the expanded overview, you will find the following in the

main panel:

e The name of the selected User group is displayed on the left.

Below the name, you wil find the list of Rights[ish for the selected user group. The rights activated
here — i.e. the ones that are ticked — are granted to every user you create for this user group. To

change the rights, click on Edit '

Beside the rights, you will find the list of Members of the user group. This gives you a quick
overview of the users who, for example, were affected by a change to the user group.

You can add or edit a user groupl169\. This excludes the system user groups Administrator and
Remote, which cannot be changed.

You can delete a user group provided that it is empty, i.e. it no longer contains any users. To do so,
click Delete and confirm with OK.
On the right, in the area highlighted in grey, you will find details on creating and changing the user

group. The & symbol indicates user groups that you can neither change nor delete. This includes the
system user groups Administrator and Remote.
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Users

Rights

If you select a user in the expanded overview, you will find the following in the main panel:
e The User ID and the details on the selected user are displayed on the left.

e Beside the details, you will find the list of the Rights[isd) for the selected user. The rights activated
here - i.e. the ones that are ticked - are granted to the user via membership of a user group. The
rights can only be changed for the whole user group.

e You can add or edit a userl 166\ This excludes the system users admin and remote, which cannot be
changed.

e You can delete a user. To do so, click Delete and confirm with OK.
¢ On the right, in the area highlighted in grey, you will find details on creating and changing the user.

The & symbol indicates users whom you can neither change nor delete. This includes the system
users admin and remote.

When you create a user group, you can grant rights that will then apply for every user in this user group.
The following rights are available:
¢ Edit system settings
This allows the settings found under Device settings[is:) and System time settings[is71 to be edited
by the user.
¢ Create configurations, Edit configurations and Delete configurations
With these rights, the user can create, edit and/or delete configurations accordingly. Excluded from
this right are the input and output configurations, which have their own rights (see below).
¢ Configure inputs and Configure outputs
With these rights, the user can configure inputs and/or outputs.

¢ Create users/user groups, Edit users/user groups and Delete users/user groups
If you grant these rights, the user can execute the corresponding functions of the user management.

e Download data
This right is necessary if the user wants to download and analyse data from the SmartCheck or ProLink
device.

¢ Reset alarm(s)
This right enables the user, using the SmartWeb software, to switch off the alarms of the SmartCheck
or ProLink device.

¢ View trend/real-time data etc.
This allows the user to open the Live view[s:) and Measurement datal 4" areas and use the
corresponding functions there.

¢ Delete measurement data
This right allows the user to delete measurement datal =2 that is on the SmartCheck or ProLink
device.

¢ View confidential configurations
This right allows the user to view alarm limits and frequency bands for sensitive measurement jobs[ 771,

¢ Edit confidential configurations
e This right allows the user to view and edit alarm limits and frequency bands for sensitive measurement
jobs[ 7.

¢ Edit speed channel
This right allows users to edit the speed channel, even if they otherwise have only limited
authorisations and/or are not allowed to process measurement jobs.

¢ Edit hour meter
This right allows users to edit the value of the hour meter.

Activate/Deactivate user management

By default, you can open the SmartWeb software without logging in with your user name and password.
So that the software and the SmartCheck or ProLink device can only be operated by authorised users,
you can Activate user management. With activated user management, each user has to log in with
user name and password. Users only have the rights granted to their user group.

To activate user management, click on the corresponding menu item, enter a new administrator
password twice and then click on OK. You must then refresh the Schaeffler SmartWeb software in your
browser, so that the user management is active.

To deactivate user management again, click on the corresponding menu item, enter the administrator
password and then click on OK. The administrator password is reset to the factory default setting. Now
everyone can log in without user name and password and everyone has administrator rights.



Change password

This function is only available if user management is activated.

User management

Click on Change password, enter your new password twice and then click on OK. Now you can use the

new password.

¢ If you are using the Schaeffler SmartUtility software, you can store your user name and
H password in the software settings. To do so, your details here must match the user name
and password stored in the user management of the SmartWeb software.

¢ In the factory default setting, system users have the following passwords:

e User ID admin: Password admin123
e User ID remote: Password remotel123
e User ID guest: Password guest123

9.1 Adding/editing user group

To be able to create a user, you first need a user group. A user group consists of a name and a selection of
rightsliedl. These rights pass automatically to every user in this group. Thus, the rights users have when using

Schaeffler SmartCheck or ProLink are defined by means of the group they belong to.

How to add a user group

1. In the overview on the left, select User groups.

2. In the main panel, click on Add

3. In the window Add user group, make the desired specifications:

You have the following options:

User group

Right

Add user group

Schaeffler SmartWeb

User group : | Service

Right

Edit system setitings
Create configurations
Edit configurations
Delete configurations
Configure inputs
Configure outputs
Create usarsfuser groups
Edit users/user groups
Delete usersiuser groups
Download data

Reset alarmis)

View trendflive view data etc

oK

4. Click on OK to save the new user group.

Here, enter the name under which the user group is to appear in the
overview.

Here, activate the rights that are to apply for users in this user group. You can
either select each right individually or activate them all at the same time via
Right.
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How to edit a user group

1. In the expanded overview, click on the desired user group.

2. Click on Edit# and enter the desired specifications in the Edit user group window.

3. Click on OK to adopt your changes.

9.2 Adding/editing users

You can only add users in connection with a user group. The user group is used to define the rightslie) that the

user has for Schaeffler SmartCheck or ProLink.

How to add a user
1. In the overview on the left, select User.

2. In the main panel, click on Add

3. In the Add user window, make the desired specifications:

Add user

Schaeffler SmartWeb

UserlD : | Service
Pazsword :
User group : | Guest v
Last name : | Mustermann
First name : | Max
Email : | max.mustermann@email com
Telephone :
Condition Monitoring Service Exper]
Comment :
oK Cance
You have the following options:
User ID Here enter the user ID with which the user wil log into SmartCheck or ProLink
in future.
Password Enter here the password that the user will use to log into SmartCheck or

ProLink in future.

User group Specify here the user group that the user is to belong to. Use the user group
to determine the rights that the user will have.

Surname, first name Specify here the contact data of the user. This information is optional.

email, phone

Comment Enter here any comment you may want to add about this user.

1. Click on OK to save the new user.

How to edit a user

1. In the expanded overview, click on the user.

2. Ciick on Edit# and enter the desired specifications in the Edit user window.

3. Click on OK to adopt your changes.
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Manufacturer/support

10 Manufacturer/support

Manufacturer
Schaeffler Monitoring Services GmbH
KaiserstraBe 100

52134 Herzogenrath
Germany

Tel.: +49 2407 9149-66
Fax: +49 2407 9149-59

Internet: www.schaeffler.com/en/services

Further information:

o www.schaeffler.de/en/condition-monitoring/smartcheck
o www.schaeffler.de/en/condition-monitoring/prolink
Contact: industrial-services@schaeffler.com

Please send all correspondence directly to Schaeffler Monitoring Services GmbH!

A subsidiary of

Schaeffler Technologies AG & Co. KG
PO Box 1260

97419 Schweinfurt

Germany

Georg-Schafer-StraBe 30
97421 Schweinfurt
Germany

Support
For information on technical support, go to www.schaeffler.de/en/technical-support.

We provide support services for the device and related software products. For a detailed description of the nature
and scope of our support services, go to:

o www.schaeffler.de/en/condition-monitoring/smartcheck
o www.schaeffler.de/en/condition-monitoring/prolink
You can find the support definition in the "Technical documents" > "Software, Licences, Manuals" section.
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